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REFHLED.

= QOracle By Example (http://www.oracle.com/technology/obe/start/index.html) D
Fa—hrUTILT, FIEIZH> TEIEZEKRT 2,

s B> 7 )= R (http://www.oracle.com/technology/sample code/index.html) %
Foa—R§ 5,
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ESCIR

&p-1 Ko RO

FRELILS

Bk

il

AaBbCc123

AaBbCc123

AaBbCcl23

ry

M

AR R Iy AIVAk. T4 LY
rU, EHEEOOE2—FH
F. A—RpIERLET,

A—HY—NANTBXF%E, HE kL
DAL Ea—FHNERHLTRL
£7,

ERERLUERT, EBRICHAT 55
EDHHTEZIIME THES A LT,

ZRT2EFEAZEZRLET,

ZRTHE, Hi, RF PR
Za—%, WY SHFEERLE
kR

BCHENZI—-RHIT, TFAb
MAR—=VTIRZEA DA, M
ZRLET,

JAogin 77 T IIVEREL ET,

ls-aZffHLTIXRTOT 71 IV %
FRLET,

system%s
systems su

password:

7 7 AIIVEHRIBRT HIZIE. rmfilename
EANILET,

Pa— K<Y %=y » It XA 1
ki #BEBLT 20,

o [FROEN) 22U TE
=,

ZDBIENTES0D
ix, [ ZA—/)N\—21—Y—] ZiIFTT,

sun% grep ‘“#define \

XV_VERSION_STRING’

Oracle Solaris OS ICEHEND L IV THEAT S, UNIXOT 74 )V hDT AT AT T
TREZA=N—2—F =702 T 2RITRLET, I RFIIREINDT
TNV EDI AT AT O T M. OracleSolaris DU U — 212k > THRAD ET,

= C>x)b

machine_name% command y|n [filename]

» CTINVDA—/N—I—H—

machine_name# command y|n [filename]

» Bash > Jl. Korn > ). BL N Bourne > )l

$ command y|n [filename]

®» Bash > )b, Korn >z )L, BLWNXBourne > )LD A —/N—1L—H—
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# command y|n [filename]

(1AM TRE/RIHE 2R L £ 9, LEdDFlE. filename BB L THIWI &EZ/RL
TWET,

| XG0T (2L —4) TY., ZOXFTHESNTWDEHEDOE1DET2%
fEEL X9,

F—HR—ROF—LIIHEL T, HLTFERLFTRLUET Bl shift F—Z2HL £
) 7272l F—FR—RIZX> Tlidenter T—MReturn F—DEHEZ L 7,

Foia(H)F2D20F—Z2REKFICHTIEEZRLET, ZE XL, ctrl-pld
Control F¥F—ZMLzFFpF—2HIT 2B KRLET,
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Trusted Extensions D2+ 1 U 771 —ET1H

Oracle Solaris Trusted Extensions D¥REIZ. U1 bOtEF a2 T4 —R) 2 —D—f %
VIR T7ICERELET, ZOETIE, BFa) T —ICBETHE, BXUZ
DYV T NI T OEREMICETAIMEZTHL T,

21 R—TD
BR—TD

[Trusted Extensions TOXF 2V 7 ¢ —&HH
& DN 5M 5 BL7= Trusted Extensions DA 3L DFE £ |

Trusted Extensions TOt 3+ 1 1) T 4 —5TH

Z DHITIE, Trusted Extensions ¥/ 7 N7 = 7 OF ML ERERR DO T AT /2 EHE 12D
WTHEREL 77

2 R—=TD
2 R—=TD
23 R—TD
23 R—TD
24 RXR—D
25 R—TD
26 R—TD
28 R—TD
28 R—TD
29 R—TD
29 R—TD
30 R—TD
32NXN—TD
32NXN—TD

[Trusted Extensions {2 D W T |

Y1 hOEFaUT 4 —HRY 2 —IZDNT]

[Trusted Extensions D&M A ~ T 52 DIERK ]
[NV A R TT 2 OIERR

[ 2T LD)N— R 7 & Trusted Extensions D7 & D F1{H |
[T AT w Ry T —27 OFHH

[Trusted Extensions T/ — > ] |
[RIVFLO)VT 7t ADEHH ]

[Trusted Extensions T@ LDAP *— At —E A D ZHH
[Trusted Extensions C D& £ D 518 |

[Trusted Extensions TOL—F—tF 2 F 1 —DF ]
[Trusted Extensions DL A N Z 52 DIERK

[Trusted Extensions 28 ZN129 D REIIZITR D EH D UEE |
[Trusted Extensions DA ZMERTICITD AT LDINY 7T 7|

Trusted Extensions DREKSY A7 OF v 7 U A MZDWTIE, 8 C [Trusted
Extensions DMERF w7 ) A K] Z2RBLTLEZI W, Y1 hoOo—hF1 XD
WTIE, 24 R—=2 D [HEELIA D 04— )L T Trusted Extensions 2 {#i 9 5 BE
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B 22U TLEZ3IWN, iMESNBROETICONTIE, 2X—=20 H¥1 |k
DtFa2)TF 4 —R)—IZDODNT] Z2BRLTLIEZEI N,

Trusted Extensions ([C D (VT

Solaris Trusted Extensions DA #N{b3 LOMERLIX. FEITRIRET 7 1 IV DFAHIA A, YA
FDFT—% DIEE. EREBDREREDY AVIZEEFTDER L, BERTFIHA
FAWFLTY, Trusted Extensions ¥/ 7 b7 = 713, ROEICHED W TRV &
REZFEBLEXT,

n FEAEDUNIXBETA—/N\—I1—F—IZE D 4 TE5NIH¥EEE. [ OEH
HEITERITTEET,

» UNIXDT 7Y AMEDIZNT, T—I\OT 7 AN stFa) T —47
Lo THIEESNET, ZOLDYTZE [NV EEVET, I)VE
dI—HY—, 7ot BEXORXTFT—HT771I)I°T4 L7 NI REODTTZ T b
CEID Y TENET,

s BEOI—Y—-BLOT7 TS —2 g i\t Fa)s s —RY I —% LEEXTE
H5EDICTEET,

YA bDEF2 YT 4 — KU —[CDNT

Trusted Extensions Tld. P+ hDtF 215 4 —R1 2 —% Solaris OS EXNRIITHE
BTEET, TOEDHIF. R —0#HH, BXOZTORY > —IZHIET 5
Trusted Extensions ¥/ 7 N7 = 7 OREREIC D W T, #YNCHEBET 2 40ENH D F

9, BWUNCEHE S NZMER T, Y1 hotFa )T =R —D—EHEELT X
FTLTBT LT —DIEEDOFIEEEDINT A ZTBLHICL T ES N,

Trusted Extensions (£, 7 7 4 )V M T, RORET O T 7 1 IWITK L TIHHREA &
F 2 U T —iHli D7z D DA HE (Common Criteria for Information Technology
Security Evaluation) (ISO/IEC 15408) DERFE L N)L EAL4 [ITHEHL T 5 K D ITHERL S 1%
@_‘0

n TN EEFAV T —RETOT A

 HEY 7 ARETOT 1)L

s BER—-ZAT7 7 AHERE T O T 71

INSOFEL NIVICHEET 572017, LDAP Z % — LAY —EAEL L TRET DN
MBHOET, ROWTNNEITIRo 785G, RN FTHmICHEN L 75 < 72 5 ATREMEDY
HDFET,

= /etc/system T 7 A IVDH—FIVAA v FDREDEHE,

s EEFFIEITNAABED L TOL T,

» ROWERTZT 7 ANDT 7))V T R DEH,
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/usr/openwin/server/etc/*
/usr/dt/app-defaults/C/Dt
/usr/dt/app-defaults/C/Dtwm
/usr/dt/app-defaults/C/SelectionManager
/usr/dt/bin/Xsession

/usr/dt/bin/Xtsolsession
/usr/dt/bin/Xtsolusersession
/usr/dt/config/sel config
/usr/X11/1ib/X11/xserver/TrustedExtensionsPolicy

FEHlE. Common Criteria @ Web B | (http://www.commoncriteriaportal.org/)%
ZHRLTL7ZE 0,

Trusted Extensions DEIE X 5T P DIERK

Trusted Extensions A3t T 2 HEIL, root T—F—F /213 AT L EHEREC

HOFET, BRENEZERTSHE, EEOWEDOHEB TEMH YL ZpEIT LI ENTE

ESC AN

n TFa T —EEHED EEINIORELEOYT, BEEORE. N
J— KRR —DREREDLF ) T4 —FEHOY X7 E2HY L FT,

n AT LAEHEZR vFaU T —LUAOKE. RF. BN REREAH
BLET,

 EEHEHE EFaU T —EHEOHN O T 7 A IVOER. BROEFaY
T4 —EHECT AT LERENT DI RO EEOBIEZHY L X
—§-0

n ISICHIEEZROREBZRETDIIEDTEET, HEXIE HEARL—FN
Ty AINDINY 7Ty TEHELT IR H D T,

EBHZANITOO-BELT, ROFHEEZRETDLENHD XTI,

n FOIA—YT—NEDOEHY XY EETT BN

s FEEINOEOI—F =N TATy R7 T r—2a L EETTESh, T
bbb, BREREZIICEDI—T—NFa)TF 4 —R)—% LEXZTEDHN

s PO -—NTF—YDOEDTIN—TIZT 7L ATEDMN

FINIVA NS T DER

TNV EFTET 5121E. EEIXIVDOEEEZED. AT A LOBEHRESET 2400
ERHVET, FNNLaA—T 4 2777 1IVE, A MIOWTOZ DD
TEMMN T £ F T, Trusted Extensions 1 > A b —IV AT 4 7 THREINTND

label_encodings 7 7 T IV OWT NN EFEHTEET, H2HWIE, TORET 71 ILD
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A\

WITNNELEE LD, JA MEA D 1abel_encodings 7 7 1T IV EH7ZITIER L 720D
TEEY., 207 7AI)VIZIE, Sun @A OO—H)LsdEiRMERE,. 72 < &5 coLor
NAMES 77 2 3 > & i AA AT IEE W,

JEE -label _encodings 7 7 1 )V Z 129 545513, Trusted Extensions " —E A &2 H
SMEL T AT L% T — MT 501, 2D T 7 A )V ORI 2 MK L T8 < B
MHOET, ZOT7AIBYL—=NTIVAT 4 TITEZET,

FRVOEHEICIE. T DTNV OFHE S 3 £ E 9, Trusted Extensions J— E
AEFMELTlzhE, PATLN1IDDITINIVTOAETTESLD, FRITERD
TNIVTEITTEDLINEZRETHDHENHVDET, EHEZTORVWTXRTO
A=Y =R CEF 2T =TI TERIETEZH/ITE. BTNV AT A
ERLET,

Fm, TININEFRRTEHENEDIN, BLXAREDTNNVAERERZRTEINHRET
=F 9, NI, TSolaris Trusted Extensions 7 NV DEH] 2R L T2

W, TaA2/X—hAFE—RT—TAT7—=2a3>DOIN)UMEM: T>a—RE
Xl BB T EI N,

KEELISLD O — )L T Trusted Extensions Z 5§ % H &k

HEELAN OO — )V 2 5 BEELD label encodings 7 7 )V a0 —H T A XG
LT ININAOARZEO—HTA XL TLIZEI W, EBH T N4 0 ADMIN HIGH
BEOAMIN LowZH—H T4 AL TIEWITERA, WITNOXRDY—HTh., #
BT D ITNIATERA NDLARNET T, label encodings 7 7 1 JVND T X))V 44 &
—HTHHENHDET,

Trusted Extensions TH iR — b 315 04 — )L Solaris OS & D 72\ T9 ', Trusted
Extensions THR— F IO — )L TEXET 225G, INVICBETS T
F—Awt—T78 &, Trusted Extensions [Z[EHA DT F A M, D07 — )VITHEIER
INEFH A, SolarisV 7 by =7k, AP OO —IVIZHERS xR, BT
5ZEEEHDEFA

AT AD/N— R 17 & Trusted Extensions D&
=D ETIE

SATFAIN—RI LTI, YATATOLDEZFTNICERGESNDTINA ANEG %
NEI., BERINDEZTNAT AL, T—FRIA147, X170 7 %>, CD-ROM R

T4 T, BEXOET A XN IRgENET, N—RIZT7OREICIE. AT A
AEY)—, ZYRT—=TO A Tx—A, BIXOT A ZAIVEENDHDET,
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= Solaris YU —A%ZA A M—ILTS5E,.  [Solaris 10 5/09 Installation Guide: Basic
Installations] @ [System Requirements and Recommendations| DHEREHEIHITHE > T
<IN, T ZITRINBIFMNIT, Trusted Extensions TIE S SITEM I 115 4
MHOXT,

ROV AT LTI, HRINLIBNBEIDOEZDAETY —PNBETT,
s PEASEMGUI THS Solaris B > — )V 2EITT DL AT A
s BEOWE IR TEFTIND AT A
n EMHEENCEND I —NEHT S AT A
" ROIATATIEEDE L OTF 4 AV RENNETT,
» BREOTRNWNTT 7y AINVEKRNT D AT A
. I NEREREICRND AT A

X7y Ry =0 DEE
oy b= N—=FT T OFtEDSE E LT, [System Administration Guide: IP
Services] D52 % [Planning Your TCP/IP Network (Tasks)| ZZHL T2 & W,

FNDOU AT 2 M —N—%y NT—=U D& LRI, Y—N—%kI37 F741
7 REVWIHEEIC L > THRA N ERXBIL, TNENEYNCY 7 NI =7 BRET
LZENHDFET, ZOFEDEZE E LT, [Solaris 10 5/09 Installation Guide: Custom
JumpStart and Advanced Installations] ZZHL T< 72\,

Trusted Extensions ¥/ 7 F U = 71&,. TINIVFERARNETNIN AR LRA D2 flifE%E
HHLET, EBE50MEOFRA NS, RI1-1IIRTT 74 OEF2 )
FTA—T T L= RHDET,

%£1-1 Trusted Extensions D7 7 4 )V kDA T > 7L — K

R bDiELE FoTL— 4% E]:g]
unlabeled admin_low IR ENRE, Kk — > & T X)AHTFLET,

MRS, SNNRLNNT Y FERETLHRA R
EREL T

cipso cipso CIPSO /X7y R EREEFETHRANERZITRY b
T—0 ZRELE T, CIPSO /N7 v MEITN)UAHT
INEd,

I NT—=212@300%y ST =7 X 5REEND 285G, 77 B AREE/R R A
A BIORANERETDHILEND D ET, £/=. ED Trusted Extensions D7 A
RN, A=A E L TOMEEZREZINDIFETDILENGDET, Y— K
A HDOTR)VORHFHE, FZNDRARDT —F ZRKRTE 5 TN
T, HHETHHENHDET,

%1 .« Trusted Extensions D+ 1 1 7 4 —5HH 25


http://docs.sun.com/doc/820-7011/webstart-83?a=view
http://docs.sun.com/doc/820-7011/webstart-83?a=view
http://docs.sun.com/doc/816-4554
http://docs.sun.com/doc/816-4554
http://docs.sun.com/doc/820-7014
http://docs.sun.com/doc/820-7014

Trusted Extensions T F 2 U F 1 —5HE

26

smtnrhtp(IM) DY Za 7 )L R—ITId, SFEEORA SO B0 H 0 £

o

Trusted Extensions T Y/ — > &5tiH

Trusted Extensions */ 7 ™7 = 7 1d. Solaris OS D K/ — iz BImEnNEd, TOH
ET, INIMFEDIERB) — 2R/ ELET., BEELBAVTRTOIN)INIZH L
TENENLI DD ITINIAE =V EERTEELETN, IXRTOITNJVIHLT
= EERT DHEILH D EE A,

= UHERRD— Ny N T — 7%1‘%}55“/'@3&'9“ K —> B %y k
J—27 EDIFNDY) — > EEET 57201213, TN E -2 2R LT,

n TAV YT TA AT VA ZETTBEXT ==L, K/ —> N5 DOHHHT
ZFEJ, Solaris1010/08 U U —AM5, )= NI A 2 H T —A o0 ZfEH L
TR = E@ETEDRLDICRVDELE, TORD. TATZ My TTF4 AT
L11E, oo BHTIEKRIRY —>MEFIHTEET,

» T3V RTIE JEREY — IR — /%ﬁmbTZJFW JICEEL
9, Solaris 10 10/08 U U — AWM 5, &IERE — T, K/ —2 2 /AL 20
BAEDT 7+ M — NEBRTEET,

Trusted Extensions v —> & Solaris ¥ —

FRIAFE — 13 %@Solans@‘/ CERERODET, INIfFE -
3. BT —F 525155720 @ﬁﬁéﬂi@" Trusted Extensions Tld, —fk

A—HF =3 TN E = CERN a7 1 >332 &3 TEERA, TRNIVA
=IO~ DREERIA S T —AF, == H D E
T, root DANY —> A —)VIZT VB ATEET,

Trusted Extensions TD Y/ — ERK

FRIATE — 2 ZERT 5121, SolarisOS &k Z IE—L, §XTHYJ/—>2T

Solaris OS DY —EZZKEHL 9. ZOFIEIRFHNANDET, 1 DD —2 %
B LT, 20 —2%23E—95N)—2ONBEDO/O— 2 &2ERTDHE. T
FEREMNNMN0 T/ e ROZFEIL. Trusted Extensions T — > Z1ER T 547

arERLET,

V= DR E DEIIEE ZDHEDHEE

TRMMEDE S~ & TNUHEOES =2 w ZOBERFE— R ERTONET, 1

M SERL £T. ZERGE. e, 1> DEFIT2ODEINY — > BERT S
AR BATRA gl ERTY, & T v TS
%, BEUEBLE L g

 ZOHIERREENNND T
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Trusted Extensions TDtF 2 1) 7 1 —&TE

V= DA E

WEIFER

CDHEDHE

BOID TN EDY — >
DIAE—D5EIMD TN
&= 2ERLET.

BAID TN AFE) =D
ZES ATy T aw Minbik
mo s XUffEy) — > %1k
[DAVE

10— %&E, )
Mk, 1> &

r—=Ib. BXUOH RS
RAALET, 2D
V= EBMO T X))
ftEy—>o7r>7
L —hELTHALE
9,

Solaris D1 > A ~—)b
RRICHERR L 7=

IN—T 4 a5 ZFS
T=NEHEELET.

1DV — 2 ZF%E. A
e, 1> 2

r—=Ib. BXUOH A
RAALET, 2D
=B IFS AT T
Taw hELT, B
DITR)fFE =0
HLUTHALET,

ZOHFEFYR—FINTHE

T, BN S Y — 2 EERT D55
FERFMRDN D R, %
T T TL—=RTEEY, V—2IC
RIS 2 A1 Sun DHIR— K 244
BWETHEHL. 2D/ —20Da
E—HiEEHEHLET,

ZDHFIZUFS #EH L £, UFS
121X, Solaris ZFS THEAL I 112 B MDD
V=2 DY 0EEUMREIZH D =1
Ao

Z D H{ETIE Solaris ZES Z i L £ 9
MW, TS o EBRRONN S 7R
WHETT, ZOHEIZ. TXTO
V= BENENT AV AT A
1295725, UFS &0 HEWHEEEZE
et L £9. ZFS Tl 13507
WT 4 A RBEEMHHALET,

Trusted Extensions 27 A h L. V' —
7y T L —RTIER<HEHAI A
IV TEZEHEITHEL TWD Gk
TY. YATLZHAARM—ILL
TR < HHTHE/IRREICTE S
DT, A>T YOI TR0
SATLTIE. ZOHEDMEFRIT
KD
ZOHFEFIR—FINTHER
ho TORETERSNDY — >
1%, Solaris OS DEHTD/N— 5 >
VY —=23NBEXITYTT
L—RT&EXHA,

Solaris /' — 1, Nw T —JDA A =By FORMAICEZEL £,

ML, RORZaTIR=U 2SR TS EI N,

= [System Administration Guide: Oracle Solaris Containers-Resource Management and
Oracle Solaris Zones] D525 % [ About Packages and Patches on a Solaris System With
Zones Installed (Overview) |

= Solaris DV —>EA T FHIIDWNTOLLFHFESNDEM (FAQ) (http://
hub.opensolaris.org/bin/view/Community+Group+zones/faq)
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NIVFLANIVT 2 RADETE

BE. FRMBIENESIE, YIVFLNINY—EZAELTERESNET, I FLAX
WY —EZICT7 72 AT 511, #UICHRINZS AT LT, IXRTOY =201
DPUEDORY FU—=0 7 RL AT 7B ATERITNIARD TR A, ROERIZH
WTRILF LR —EZANR[FETT,

m  Solaris OS E[AFRIC, K/ — > Z2ETXRTO =L TENENDIP T
RLUZARE DY TENTWS, V=2 T &L DRy hT—27E#®RT—R
(NIC) &0 4 THL, TN sIckEIND, ZOLDERIL. &
NIC IZBIEAFIT 5N TNWBHE—T )LDy 8T — 7 W EEdT 572912
FHXNS,

B all-zones D1 DDTY RLAME DY TENTWD, 1 DB EDY — 200 — [
BD7 RLAZEDIENTES,

RDO2DDFMIZED AT LEIINF LN —ERZTAEE o

m 1DDIPY RLANE DY TSN, K — 2 ETRNfES NG5 5,
s = EEDOTY RLAN1IDHED Y TS5N TR,

FRIWNE =2 DL—F—=RNaO—HINDIIF LRIV T T I8 ATEHT
LERELTEST, F—LT 4L 27 NUDNFS TV Ah— K HHERNE

B, Trusted Extensions Wi E SN AT LI LTI DDIP Y RL AZE D 4T
LHZEMTEET, ZOXDIRIATALTIE, XILFLIVEIRNZY R —Fah
T R—LAT4 LY N EHETEEZE L. ZOBKIZ, ELLTIy T vy 7O
a4 THHALET,

Trusted Extensions T LDAP r— AHY —E XMDiT
]|

TR ES AT LDFy bU—7 ORERZFTE L TWaWEE, ZOHIZEKT
EEXR

AT LDFy 8T —7 T Trusted Extensions & E179 5 FE DL EIL. LDAP %
F—LP—ERELTHEML EJ, Trusted Extensions T. AT LDF%y KT—7
ZHERR T 556, 7 —4 AJI S 17z Sun Java System Directory Server (LDAP J—/\—)
MNHETT, A MIEEFED LDAP Y —N—0NH 5 %A, Trusted Extensions T — %
N—=A%&ZDH—N—|JIETEET, TOY—/N—IZ7 7 A T 5IZId. Trusted
Extensions & AT A LDAP 7 OF L 2REL T

YA MTEEFE D LDAP B —/)\N— 72 W&, Trusted Extensions ¥ 7 7 = 7 #5179
52 AT L TLDAP U —N—ZER T 5L DICLET, FIHIZTDONWT
1%, %53 [Trusted Extensions D72 D LDAP O (FIE)] 2L T 7Z 3,
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Trusted Extensions TOESE D EHiE

7 7 4 ) N Tld. Trusted Extensions 231 > A b —)L 3115 & ZITEEENA U ITRE
INET, LENST, 74 Tlidroot 71 > BEWroot OF 77 ENEEE
INFET, PATLAEEBRLELD ET2A—TF—-2EET L2012, #R7OotA
DEA DB THEZERTE LT, FIEITOWTIE, 93 X—2D [Trusted
Extensions CTO&RE &L —F—DER] 2L T<EZI W,

Trusted Extensions TDEE D EFHEIL. Solaris OS DA ER U T, 7l

I&.  TSystem Administration Guide: Security Services] /%— k VII [OpenSolaris
Auditing] ZZHL T /ZE W, Trusted Extensions l&, 7 T A, A1 X2~ BLUE
TER—7 2 Z2BMLUETN, BEEOEHAEEZILEEINETAL. BERICHT S
Trusted Extensions |12 & 53BN DWTIL.  [Oracle Solaris Trusted Extensions & ¥ D T
gy D% 18 & [Trusted Extensions TOE AT (M) 2L T Z Iy,

Trusted Extensions CTD1—Y—t+a21 U714 —D
aTIE

Trusted Extensions »/ 7 h 7 = 7 Tld, I—H¥ -t TZ4tFa) T4 —TF
TN NEREERELTWET, ZO0LItFa)ss—T 74V REREEEK 12
WRLUET, 2DDMEMNRINTWDEE, RAOMENT 74V METT, £F2U
T4 —EHEZIZL Y1 hoF a4 —RU—IZE&DLETCT 74V MEZEEE
TEET, BFaUs 4 —EMHENT 74 NREETRoIZHE, AT LEH
ENTRTOL—Y—ZERTEET., TNSOI—PF—IRESNZT I+ k
EEMEALET, ZOXIRT 74 MEREDF—T— RPLHEICDONT

1. label encodings(4) BX W policy.conf(4) DY Za T IR—=J 2SR TLEZS
W,
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NIV TF—EDNEHEEINET,
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151 4-1

EE-#Hi179 HIT1d. 1abel encodings 7 ¥ T IVINT > OA—F 4 > T DRET A MC
G LRTIUIRD £ A,

77AINVDBEXEREL. ENET U T 1 775 1label encodings 7 7 A ILICLE T,
a2 RITEEHLET,

a. WAV« RUZEREET.

b. chk encodings AY¥ > RER{TLE T,
# /usr/sbin/chk_encodings /full-pathname-of-label-encodings-file

« HAZEHEH ROVNWTNHETVET,

s IS5—Z%MRUET,
AR RICE > TIZ I —NMESNELEE. FlTT 1. TDILT— &Mk
Lizidnidm o E8 A, &1L T, [Solaris Trusted Extensions & \JL D%
M) 0338 (ST a—FT 4 277 71 IVOER (FE)) 28R L T<
72N,

» FDT77AINET DT 4 775 label encodings 77 A ILICLET,

# cp /full-pathname-of-label-encodings-file \
/etc/security/tsol/label.encodings.site

# cd /etc/security/tsol

# cp label_encodings label_encodings.tx.orig

# cp label.encodings.site label_encodings

EE -7 51T, label encodings 7 7 fIIVINT > O—F 4 > 7 DA T A MZ
AR LR ndRn £ .

O > RITTO label encodings X DHRE

ZOBITIE, BEEHENI D RITZ2EHL TW< DN D label encodings 7 7 1 )L %
TARLET,

# /usr/sbin/chk_encodings /var/encodings/label_encodingsl
No errors found in /var/encodings/label encodingsl
# /usr/sbin/chk_encodings /var/encodings/label_encodings2
No errors found in /var/encodings/label encodings2

SESE T 1abel_encodings2 7 7 TIVEFHTAH I L2206, EEFILT 71
IV OES®MRT 23T LUET,

# /usr/sbin/chk_encodings -a /var/encodings/label_encodings2
No errors found in /var/encodings/label encodings2
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--> VERSION = MYCOMPANY LABEL ENCODINGS 2.0 10/10/2006
--> CLASSIFICATIONS <---

Classification 1: PUBLIC
Initial Compartment bits: 10
Initial Markings bits: NONE

--> COMPARTMENTS AND MARKINGS USAGE ANALYSIS <---

--> SENSITIVITY LABEL to COLOR MAPPING <---

EFHFIIEORREAICERFETOOE—2H NI LEDE, 20771V %E
/etc/security/tsol 74 L7 NUICKEIL £,

# cp /var/encodings/label_encodings2 /etc/security/tsol/label.encodings.10.10.06
# cd /etc/security/tsol

# cp label_encodings label_encodings.tx.orig

# cp label.encodings.10.10.06 label_encodings

BRiZIZ, B tabel encodings 7 7 1INV T 7 AV ThHhH I 2R L £
ED
# /usr/sbin/chk_encodings -a /etc/security/tsol/label_encodings | head -4

No errors found in /etc/security/tsol/label encodings

---> VERSION = MYCOMPANY LABEL ENCODINGS 2.0 10/10/2006

Trusted Extensions CTIPv6 v b —F 2 J ZHY)
295

CIPSO F 7' a &, /X7 @ IPv6 Option Type 7 « — )b R TR TR E JANA
(Internet Assigned Numbers Authority) &5 25 XA, COFIETHRET ST b
Jid, 2OFT2aOBFFEZIANANE DS THETO— ALy NT—U TEA
THEFERMELET, ZOBSNERINTN/RWE, Trusted Extensions | IPv6
Ty NI =0 2N L ET,

Trusted Extensions T IPv6 % N7 —727 ZHNTT 5121, /etc/system 7 7 1 VI LT
CRUZEEBMLTEZI N,

Jetc/system 7 7 A IVITKDIT S ZEANLET,
set ip:ip6opt_ls = 0x0a

w EHFITIPve DBENIEL KTBNWIEZRTITIT— Ay E—INERSI N

5. T hUZEIELXT.
» T2HMUDARIPIELNWT EZ2MHERLET,
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s /etc/system 7 7 A IVICIELWI > NU ZBIML72H EITT AT LADHEH S
N EZ2mR L £,

I TITIPv6 INENITE 5 T 5 Solaris 2 A T AT Trusted Extensions & > A
F—JIL LT, /etc/systemZIP T MU ZEBIMTERN>EES. ROT
FT— Ayt —UNERRINET, t optmgmt: System error: Cannot assign
requested address ftime-stamp

= [Pv6 ME XN TIE72 W Solaris & A 7 AT Trusted Extensions &1 > A b —JL L
T. /etc/systemZIP L MU ZBINTERN>5HE. KOoLSkhT
T Ay =TV NERINEKT,

m  WARNING: IPv6 not enabled via /etc/system

® Failed to configure IPv6 interface(s): hme0

®  rpchind: Unable to join IPv6 multicast group for rpc broadcast
broadcast-number

v BIRRAA > DigRk

Trusted Extensions TR S 3722 A7 L E DO DEEITTRT, HHH—D CIPSO
fEFR R A1 2 (DOI) D T N)VAHFRANCHE D BERH D FT, & AvE—HNTH
M &% DOId. CIPSOIP Option \v ¥ —DELEIC L > TEEBIENET, 7
7 # ) N T, Trusted Extensions @ DOILIE 112785 TWET,

il %2 DOIN 1 THRWHA. Jete/system 7 7 TIVICZ > MU ZEBML., T 7% )b
FOYFa) T4 =TT L —bFDdoifiZEETIHILENHD FT,

1 /etc/system 7 7 AJLIZRDDOIZY U ZEZAALET,
set default doi = n
ZoEOTHRWERIE, FHTS/ —FBRUIED /) —REBERBTLHIATLD
tnrhtp T— I R—ZAWEEN TS DOIBSIC—HTHILENHD T,

2 tnrhtp T —INRX—RXZELDAP Y —/N\—[TEBMT SEIIC. T7H)bIbUEO—H
W7 RLURICHTAZITRTDOI M DdoiBELZELET,

Trusted Extensions @ tnrhtp 7 —4 X— ZAWIZId. cipso & admin low D2 DD T >
L—hr2PHEBEINTVWES, O—HIIL7Y RLAOIZ > M) ZBMLAEEEITE. £
NGO M) BEFELET,

a. tnrhitp T —IN—RE S RATY RIT A ¥ THEXT,
# /usr/dt/bin/trusted_edit /etc/security/tsol/tnrhtp

Solaris Trusted Extensions (CDE) Tl3ftH DIz, 77U r—a Xt —Iv—D
Trusted_Extensions 7 # VY ND EMIT 44| 77 a z2FHALET,
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b. cipsoT T UL—hrI VM EROFTICIE-LET,
cipso:host type=cipso;doi=1;min s1=ADMIN LOW;max s1=ADMIN HIGH
cipso:host type=cipso;doi=1;min s1=ADMIN LOW;max s1=ADMIN HIGH

¢ WINMDcipsoI bUZEAANILET,
#cipso:host type=cipso;doi=1;min_s1=ADMIN_LOW;max_s1=ADMIN_ HIGH
cipso:host type=cipso;doi=1;min_s1=ADMIN_ LOW;max_s1=ADMIN_ HIGH

d JAVRMIENTWEWcipso T MU D doifEZEELET,
Z D%, setc/system 7 7 1 VN D default doi DEEFCICL £,
#cipso:host type=cipso;doi=1;min s1=ADMIN LOW;max s1=ADMIN HIGH
cipso:host type=cipso;doi=n;min s1=ADMIN LOW;max s1=ADMIN HIGH

e. admin low LY hUDdoiBEZEELET,

#admin low:host type=unlabeled;min s1=ADMIN LOW;max_ s1=ADMIN HIGH;doi=1;def label=ADMIN_ LOW
admin_ low:host type=unlabeled;min s1=ADMIN LOW;max s1=ADMIN HIGH;doi=n;def label=ADMIN LOW

58

o

k|

tnrhtp T—F R—=ZAHNDTRTOL> FJ DTRTOD doi fHMFE LI/ o 7= H1EHE
e T T,

/etc/system 7 71 )V T 1 U D default doi EDVRRESNLTWT, MDODIZDT AT
LDEFa) T4 —T > 7L —NTZDdefault doi fEIZ—F LR WEMNHRESINT
WSS, A2 72— ADOHRIFIC AT L2V =)V EITRO L 572
Ay =T NEREINEKT,

m NOTICE: erl@ failed: 10.17.1.12 has wrong DOI 4 instead of 1

®  Failed to configure IPv4 interface(s): erl0

A28 72— ADRRICKBLIZHE, ROX D207 1 2 NKKT 2 algeltEnd
DET,

®  Hostname: unknown
®  unknown console login: root
m QOct 10 10:10:20 unknown login: pam _unix cred: cannot load hostname Error 0

ZOMBEBIET S, AT LES )N A—F—FE—RTT—LL. ZOF
JETHH LA ETEF 2T —FT > T L —FEEBIELET,

DOI DFFEHIIC DWW TIE,  [Oracle Solaris Trusted Extensions B ¥ D FJEL) D [Trusted
Extensions D% v T =27t F 250 —@l 22RLTIZEEN,

BT 2 tFa2UT 4 —FT 7L —hDdoi fEZEFT T 5I2IE,.  [Oracle Solaris
Trusted Extensions HHE D FIE] @ NEBHEA T 7L — M 2ERT 5] 28R
TLE3 W,

I—Y—MNERL LT A Y EEETELILT Y ELTHEHATSITIE.  [Oracle
Solaris Trusted Extensions HHOFNE) O [F I ATV RIT 4 ¥ ELTEEDOT
TAHFEEDUTEH] 2BRLTLIEZEI N,
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RO BHEIIC

V=200 0— 2% ERRT B1=DIZZFS 7 — )L %
SolarisZFS A Fw 7> avw + & —>2F> 7L —MELTHATIHEAE, ZFS 7 71
JVEVXZES TINA AN S ZFS T— )V BT 2 ENH D T, ZDT—)LiC
., &Y —o 00— B ERT 5200 Fy T ay FMEREINET ., ZFS
T— VI Jzone TN AL £,

Solaris D > A M —)UIFIZ, ZES 7 7 A IV AT LHADT 4 AV BEBEEMHRL THE
F9, ML, 26 R— @ [Trusted Extensions TD Y/ — &t ] ZHBBL T /ZE
VY,

/zone/N\—T 43 ET RO EMLUET,
A A BN=IVRRZ, 5725 4 AV RE (8 2000M N1 R) D /zone /S—F 4 > a >
ZERRLTH D £7,

# umount /zone

/zone XD RiRA > NEHIBRLET,

# rmdir /zone

vistab 7 7 A I D /zone T ) EAA MIULET,

a. /zone LY MU ZHEAMONBENELDICLET,
IT5 44 Tvfstab 77 T IVEEET, /zone T2 MU DEIICO A > b B Z24f
TET,

#/dev/dsk/cntndnsn /dev/dsk/cntndnsn /zone ufs 2 yes

b. T4 ATV ATA Rentndnsn 2 )y JR—RKIZCaAE—LZET,
¢ 774N EREL. ITT 44 %RHALCET,

TARVATAREFERL T /zone B ZFS 7—IL E L TBERLET,

# zpool create -f zone cntndnsn

7=EZE /zone T NUMT 4 A7 AT A A cotodoss Z A L7=8546. a< > Rid
RKDEDITIZDET,

# zpool create -f zone c0t0d0s5
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BB HIIC

IFST—IIDEETHDIEEBRITLET,
KONWTNHADIAT Y REMHALET,

# zpool status -x zone
pool ’'zone’ is healthy

# zpool list

NAME SIZE USED AVAIL CAP HEALTH  ALTROOT

/zone 5.84G 80K  5.84G 7%  ONLINE

ZOFITIE, WIHIRETF— LT — 2 D)S—F 4 >3 >HIZ6000M N1 RZEHEL
F L7z, 5L, zpool(IM) DY Z a7 I R—=J2ZBLTLZE N,

Trusted Extensions Z B8 L COL A 9 5

FEAEDTA FTIE, PIRRETFT—LDEREZRZT, 2 NELEOEHENS AT
LOWRRZHSE L XT,

BAICO 2 A >3 SR, Trusted Extensions DT A7 b THIARNT )L DF T
TarEHIAMLTBNWTLSZI W, #illld.  TOracle Solaris Trusted Extensions
dI—HF—=ZXHA K] O 253 [Trusted Extensions NO T 71 > (FJE)] 22 TL
23,

AT LAEBREELET,
# /usr/sbin/reboot

SATACT T T4 IFERADOT 4 AT LA NIRWEEIE, #63 [Trusted
Extensions & \w RL AT AT LDOKERY (7 A7) | ITHEAET,

Solaris Trusted Extensions (CDE) & 7= | Solaris Trusted Extensions (JDS) 7 X & kv 7
R—=/)N—A1—H-—-,LLTAs/1LET,

a. OJAVO 4 RIT, WTNDPDRSRTY RFRO MY TEZERLET,
Trusted CDE 7 A2 bw 7I2lE,. AT LORERRKFICRINLD Y 7> a > INaEn
TWE T, Solaris 1010/08 U U —AM 5. txzonemgr A7 U 7 N AT A% Rk
THEDIEREIND T OV T LB DE LR,

b. A A VA T7ALTKRY I AT, root 5L root/SAT—REZADLET,

I—H—INAT = RZZNDANIZHSENZNWESICLTLZSW, ZDAN
A—Y—DTF =TIV vATHE, TIVRALEANZRETET., HEEZEXR
TERLBVET, NAT—RNENDOANIZHSND DL, I —F—NEHEICH
ATLES EOREENREEE, ESEDTBWENRAT—REZA SN

D, BETHRWNNAT—RERELLEZDTSRE, MEBEANREENH D E

g, Trusted Extensions ¥/ 7 b = 7 Tld, ZETHRWINAT — RINRE NN
EDCTEETH, I—HF—NNAT—RZ2HZAD, EZXEDEZDT 020
kg5 Z&IETEERA,

Oracle Solaris Trusted Extensions # 5 H 1 K « 201059 A


http://docs.sun.com/doc/816-5166/zpool-1m?a=view
http://docs.sun.com/doc/819-7605
http://docs.sun.com/doc/819-7605

Trusted Extensions TD X1 — > DERE

3

RO BHIIZ

REDQOTAY] A4T7ATRY IV ARDBEREHRAHET .

Last Login: Thu Oct 09 17308325 2008 on console

Message Of The Day

=

Sun Microsuystems Inc,  Sum0S 5,11 Oct, 10, 2008
Extensions

I

=

I Restrict Session To A Single Label

_* |

(7] 220y 27 LThRy 7 AZHUET.

INIVENSY —ZHAHET,
(T 22097 L TT 74 DI EZFANET,
a7+ > 70t AMMN5E 79 5 &, Trusted Extensions [FHH 2VE < RS 4, 4 DD

= AR—=AEHEDOTA by Ty a icikhEd, hIATY RARNIA
TIZ Trusted Path D VRN FERINE T,

E-VATLOHINGHENS LS, OV F T ITANELPFERZDY 7 L TLEE
W, INZERBSE, ENDDHENCRAEZITTICAT LAY V7 EZATETLE
W, P EALEANERETEY, BELZBERTERRDET,

Trusted Extensions T Solaris B2 1YV —)l
B —/N—Z#EHMET S

ZOFIET, 2—F—, &E., AL, V=2, BIXIRY NIV EZIDI AT
A FETEHTESLLDI ED&? BRI 2RO AT LA TIE, files AI—TD
HINEFAREETT,

A—/N—A1—F—ThiFTNE20 £8 A,

7547 > N TEET B Solaris HHL I > — )Ly 5 LDAP B —/N— LD LDAP VY —)l
Ry 7 Z2FHT A2, 132 =D [LDAP D729 D Solaris B 1 > — )L D&
FEWEETY ) OTRTOEELZZTLTLIEI N,
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=an—1
HE

Solaris B Y — )L EEELE T,

# /usr/sbin/smc &

F-Solaris BEE I >V — )V EIICO TR TS E XTI, BRI AV EETLE

o ZDYAVITEED NN ET,

4-1

Console Edit Action View Go Help

Solaris BEE O > — )L #I#A™ + > R

Bla|Ble|a @) 5

Nawvigation

E This Computer (127.0.0.1: Scope=Files, Policy=TSOL)
o i System Status
¢ Ja System Configuration

Welcome to the Solaris~
Management Console

@ Users

& Projects Click here to display an overview of the Solaris

Computers and Networks Management Console or select "Owverview" in the Solaris

& Patches Management Console Help menu to view the overview at =
o SENICES any time
o & Storage

Loolk in the Information pane below for the context
specific help

o E Devices and Hardware
0 Legacy Application

Information

Select an item in the left (Navigation) pane to display the result in the right (View) pane. To expand ||
a collapsed item in the Navigation pane, double-click the item or single-click the "turner” to the left
of the item.

General Infarmation

Click here to display an overview of the Solaris Management Console, which includes definitions of
console terminology and usage instructions, plus getting started instructions for the first user of the ||
Solaris Management Console. Select "Overview" in the Help menu to wiew the overview at any time.

I | i

2 SolarisBEE IV —JILTY—ILIRy I RADT A AV PREREINENEE., ROWNT
NhERTLETD,

» FET—-2aVREDPRRIENEVNSE

a. RRESNTWD Y=l Ry I R&M<] ¥A4T7ATRY IR
T, H=N—] OFICHBRATLDEZFIDED [FZHAL ] 20Uy oL
£,
SATLIZATY —BLUOAT y TOHREENZWEE, V—IbhRy 7 AN
FRINDETHLI DN DHEMNH D ET, HREITOWTIE, 42—
@ ITrusted Extensions [ SolarisOS D1 > A h—I)VEZEZT7 v 77 L — K] %
ZHRLTLZEE N,
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b. V=L Ry O RXD) R KPS, Policy=TSOL Th DY —ILiky U A& FEIRL&E
j_o
4-21%., 2D ¥ a—% (this-host: Scope=Files, Policy=TSOL) Y —)l
Rw 7 Z&mRm L TWET, Trusted Extensions T, [ AT ADHERR] /— RiC
HBHY—INEEFELET,

FE-RY =Y =Ry 7 LB LW TL/ZS W0, UZX ST
WEIRY =720y —)LiRw 7 A1, Trusted Extensions Z PR — s L FH
AJO

HEAEBZDAA—TIIRC T, V—Ibih w7 ZADORRNPFE D 9,

» O—HWI 774V ERETBITNE, Ty IV AI—TERIRLET,

» LDAP T — A R—AZHET HI121F. LDAP A —TZRINL £7,

132 R—2 D [LDAP D729 D Solaris BFE 1 > — IV DRTE (ME3
X OFTRTOMEEZTETTSHE, LDAP A d— 7 HMEFHA[FEIC/2 D
i—g_o

¢ (B ZHOYYOLET,

n FEST— 3 VXBEERRENBD,. VIR I RADT A AV PELEESRTH
Y =)
a. Solaris B Y —ILERTLET,

b. Solaris HIEIO Y — )L EZBEHLET.

# /usr/sbin/smc &

Policy=TSOL DY — )Ry I R& /B RL TOWEWEEL. TNEZERLE T,
ROV, 2D Ea—4H (this-host: Scope=Files, Policy=TSOL) YV —)Liw 7 X %
RLUTWET, Trusted Extensions T. [T AT LDHRK] /—RiZHd Y —)V &%
HLET,
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o

09

4-2 Solaris HHE 1 > — )LD Trusted Extensions * — I

Navigation
E This Computer (127.0.0.1: Scope| =~/
o il System Status
T é’e System Configuration

T @ Users
& User Accounts
fﬁ User Templates
<Z Rights
<> Administrative Roles |
i Groups F
5% Mailing Lists
@ Projects
T Computers and Metworks)
Security Templates
%Trusted Metwork Zone
Computers
8 10 —
&y 127
&y 129.146
?3-‘ Patches

4] i ] [¥]

[l

(BERAIRE) IREDY — IRy I RERTFLET.

Policy=TSOLY —J)Lihw 7 A& #FET S E. T 7 % )L kT Trusted Extensions *Y — )b
Ry 7 AMGERAENTT, BERFEEZE, SAMTEIREINET, FA K
13 Solaris HH¥. 1 > — )L —/N—"T7,

a. [A2V—Jb] AZa—D05 IFREDEF] Z22IRLET,
[R—L) VIR 7 ANBERINTNVET,
b. Policy=TSOLY —JLiRy O R%& [:R—AL) V—=IRyIRAELTEELET,

RIEDY —)ViRy 7 A& RY &7 w735 EI2Xk>T. BIED
W—)LiRw 7 A% T 74—V RICANLET,

« [T# 20Uy L TREEZRTFLET.

Solaris BV — L& TLET,

Solaris B EE I > — )LIZXF T B Trusted Extensions DB NEFIEDHEZIZ DN T

3. TOracle Solaris Trusted Extensions E ¥ DFNEI D [Solaris EEL I > — )l
V=)l EZRLTLEIWN, Solaris B I —IIVEFRHLTEFaU T —F
7L — RNEERT BI2IE.  TOracle Solaris Trusted Extensions B HEDTFJE] D [ K
AT B3y NI =0T = X—2ADR (E¥E~y 7)) 22RLTIZSI N,
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v Trusted Extensions T Kz — % LDAP Y 51 7

RO BHIC

2 N s

LDAP T, ZOFIETKREY — Nk — AT —EAZRTEEHEL £T, LDAP & 1f
AL TWaEWESE, ZOFEITEKTEET,

Solaris 105/08 1) 1) — A LAF%., Solaris Trusted Extensions (CDE) 7 —72 A RX— ZIZW1 %
I—H—Il3. txzonemgr A7 U 7 N E721d Trusted CDE 7 77 3 3 > %> T LDAP 7
T4 7 > hZEVERRTE £, Solaris Trusted Extensions (JDS) & 7z 13 Solaris Trusted
Extensions (GNOME) 7 — /%7 A R— 2125 1 —H —Id. txzonemgr A7 1) 7 K Z{diH
THLENRDHD LT,

F-HDA—TF—NETRNIANE =N THR— LT —N—ZRETHIEE5H L
TWBEE, BITNIES—2ANDLDAP 7 51 7 > Nk 2T 9 2 23T
DI—TF—=IchDFT,

Sun Java System Directory Server, D% O LDAP H—/N—7F1E L2 AUd72 0 £ 8
Mo Trusted Extensions 7 — % N—ZA DT —F N —N—ICANINTNT, AT
AN —=N—EHETERTNERDERL. TDED, BELTWE T AT A
T. LDAPH—/N— LD tnrhdb T—F X—ZAND LY MUMKETT, HDHWN
1Z. ZOFIEZEFEITT LI, TOVATLANTAIINEH—RI MJIZEENT
W20 £8 A

Trusted Extensions 23#%/E & 4172 LDAP B —/N—INFE L 72 WIEE, KRITRT FEZHE
7950, %53 [Trusted Extensions D72 D LDAP ORERL (FE) ] OFIEE5E T
L9,

DNS Z{ER L TL\B1HE. nsswitch.ldap 7 7 A I EEZBLET,

a. JTMnsswitch.ldap 7 7 MDD IE—ZREFELET.

LDAP  DEEER 2 — LAY —EZDAA v F 7 71 IVIRENTH 57
8. Trusted Extensions {ZI3fFfH T £ H A,

# cd /etc
# cp nsswitch.ldap nsswitch.ldap.orig

b. XDEHY—E XD nsswitch.ldap 77 AIINI VM) EEBELET,
ELWIZRJIERODEBD T,

hosts: files dns ldap
ipnodes: files dns ldap
networks: ldap files
protocols: 1ldap files
rpc: ldap files
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ethers: ldap files
netmasks: ldap files
bootparams: ldap files
publickey: 1ldap files

services: files

Trusted Extensions IZ2& > T, RKD2DDL > MUMNBEMENET,

tnrhtp: files ldap
tnrhdb: files ldap

¢ ZFE L7/ nsswitch.ldap 7 7 A JV%& nsswitch.conf[CAE—LE T,

# cp nsswitch.ldap nsswitch.conf

2 ROFIEONTNNERITLUTCIDAP Y AT bEERLET,

" txzonemgr A7 ) S NERITL. LDAPICRET 27O MIEAET.

[Create LDAP Client] A= a—JHHIC X > THEBRINS DL, K/ — 27210 T
—3—0

a. 69 X— M ltxzonemgr RV U T hERTT 5] OFIEICKENET,
ZOFATOT Ry 7 ADE A FLiF [Labeled Zone Manager] T,

b. [CreateLDAPClient] ZZERL £,

¢« RDBETAVTHICEA TNENORZEDHET (TR 20V v o LE

ER

Enter Domain Name: Type the domain name
Enter Hostname of LDAP Server: Type the name of the server
Enter IP Address of LDAP Server servername: Type the IP address
Enter LDAP Proxy Password: Type the password to the server
Confirm LDAP Proxy Password: Retype the password to the server
Enter LDAP Profile Name: Type the profile name

d. RRSN/ZEZHEETSPRYBELET,
Proceed to create LDAP Client?

e L7235, txzonemgr A7) 7 MZEX > TLDAP 7 17 > RANBINE
£9, D%, A RHENNT ¢ > RUICFERINET,

= Trusted(DET —2 AX—XT. [(WDAPOSA T &R 70 avEBRRL
TERLET.

a. B2 CNIRNRY 3% 1)y 4 L TTrusted_Extensions 7 # L% ([CFBE L E
j—o
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Trusted Extensions TD X1 — > DERE

b. 7T—UAR=—RAAZa2—7T, [77UHs—>3>) 5 7705 —23> %
*—Tv¥] EERLET,

¢. Trusted_Extensions 7 A L DT A I &=F TV )y o LET,

DT FNFITE, A2 Tx—A, LDAP 7 9147 > h. BEORIRIfHE
=D BERETHEODT I a vINGENTVWET,

d TWDAPOSA T &R 7oavaEdTIVo Uy o LET,
KOTOTNIEZET,

Domain Name: Type the domain name
Hostname of LDAP Server: Type the name of the server

IP Address of LDAP Server: Type the IP address

LDAP Proxy Password: Type the password to the server
Profile Name: Type the profile name

e. TTHOKI 20V vI L&Y,
RDFET A=V IPERRINET

global zone will be LDAP client of LDAP-server
System successfully configured.

**x Select Close or Exit from the window menu to close this window ***
f. 702304 RUERUET,

IR 4 > R T, enableShadowUpdate /ST A—% [CTRUEZZRELE T,

# ldapclient -v mod -a enableShadowUpdate=TRUE \
> -a adminDN=cn=admin,ou=profile,dc=domain,dc=suffix
System successfully configured

[LDAP 7 54 7 > hZ2VERR] 773 3 > & txzonemgr A7V 7 M ldapclient init
a2 RDOHAZEEFTLUET, Trusted Extensions Tl >+ RUBEHZEHNCT 572
O, UL ENZLDAP V7 947 > NIEREZMAHDHESHH D ET,

H—N—ICETIERNPELN L EHALET,
a. AR 4 RU%ERE, IDAPHY—N—Z2B&LET,

# ldapclient list

HAWZRIIROKDITRD £T,

NS LDAP FILE VERSION= 2.0
NS LDAP BINDDN= cn=proxyagent,ou=profile,dc=domain-name

NS LDAP BIND TIME= number
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£l 4-2

b. I>—%#ELET,
II—NERINEZHEIT. DO —ELDAP V7 717 > h2{ERL. IELWEZ
FRELTLEI N, &2, ROTT—NERINDEE, LDAP H—/N—IZ
SATLADIY NN WAIREERH D £,

LDAP ERROR (91): Can’t connect to the LDAP server.
Failed to find defaultSearchBase for domain domain-name

ZOITT—Z2EIET ST, LDAP Y —N—Z2WRT20NERH D ET,

resolv.conf 7 7 A ) DFHAIAHZRICKRRA MR ZEERT S

ZOHITIE, EHEHEN, HOAEEDDNS Y —N—HEI AT ANSMHHAAEICL X
9, EHEIL. FIATY RXY MT—U EOY—)N—N5 resolv.conf 7 7 (I &
dE—LFT, DNSIZEET VT4 Ti/ao Tz, EHEIIT—/N—DIP
7 RLZAZMF>TH—N—2FELET,

# cd /etc

# cp /net/10.1.1.2/export/txsetup/resolv.conf resolv.conf

resolv.conf 7 7 1)V I E— 31, nsswitch.conf 7 7T )LD hosts T2 MU IZ dns
MEDHENDE, EHEFIRANEFE ST ATLEZREETESLIDICRDE
7,

FINIVFEY — 2 DOYERL

A\

txzonemgr AV U 7 M EMHTLHE, TAINAE -2 EHRT HROY AV 2R
THRIZEf T TEXT,

EE - txzonemgr DFNEZMH T 5121, Trusted Extensions @ Solaris 10 8/07 J 1) — A
DB ZFITL TWARBENH D £, £72id, Solaris1011/06 V) ) —ADFTRTD
N FaA AR —ILLTLZIWN,

Solaris 10 11/06 U ) — A ZHHED /Ny F 2@ H LW THEITL TW A A,
#% B [Trusted Extensions TOCDE Y 7 > a > &AL —>DA1 A=)l @
FIEZFEHL TIRNIAFE = 2R L £,

COHDOFEET, RK2DODIPT7 RLARKED LK TENTNWE I AT A EITTINRIL
fPE) =2 EBRERLET, TOMOREIZONVTIL, 35 R—20D [MEET Y T
Trusted Extensions D¥Efii E ML O A T a 28R LTE3I N,

1 B SRk

1. txzonemgr A2 VU 7 K% | txzonemgr AZ U T KN T, V=2 DORERIFICHELZY |69 X—2 D [ltxzonemgr A7V 7
EITLET, A7 wEfERT S GULEERL £7, HFITT 5
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INIfFEY =2 DIER

B

L]

2. K —>Txy b
=042 T =A%
EHLET,

K —> T2 T2 —AEHRLET, DF
0. WAy Tz —AZERLT. ZNH501 >
G =T 21— AR — 2 THIRLET,

70 X—3® [Trusted Extensions T
2y NI =0 A 25T — A=Kk
KRN

3. — ViRl E AT T

=T FED TR DIN— g > B THRTZ AT

75 R—TD = ERHTIBL DT

FR)NEMTET, JT, IRINICEID Y TET, NIVET S |
4. )= A A= (N —=D&) = A=V LET, ¥—E |[77R=2D [TIRN)AHE)—2 %A
LCEHLET, A% = THRLUET, V—WmRI Y —IUZ | > A S—=ILT 5]

EoT. V=TI T4ET 4 E2ERTEET,

78R—TD [FR)fFEY — > &
9%

5 /—2DAT—H A%
MERLET.

TR EY = NFEFEINTHBO, DY — i
K — > EBETED LR ET.

O R—TD [ —=2DAT—H A%
ALY

6. —2ENAIIAX
LET,

REY—ERE — 2N SHIRL £,

V= EERLTEDMD ) — > 2 ERT 2 5E
1. 2OV —2ICOMBESNDEHRZHIFRL £
ERS

81 R—TD [FRIAfFE =2 %N
AZIA AT 5]

7. ZDMMD Y — > E R
LE9.

BINL=HEEFERALT, 2200 — 2 &2ERL &
T, V= OIERFIEICDNWTIE, 26 R—2

@ [Trusted Extensions TN/ — &l | ZHML T
<&,

83 X— D ITrusted Extensions T
V=2 DaAE—FEra0— 2 &7
9]

8. (BIETTRE) /— > B
ESANVEV RS
T r—AZBMLET,

v bU—0 QMR EIT ST, 1D LDy b
T=0A425 T2 —AETN)UFE — BN
$9, —MIT, TORDIBHRRIZT U EHT
Ty bEYIOBET 2DICHEAL X7

BNR—TD xRy NT—UA 2%
T =A% TRN)AFE — B
L. V—T4 2073 %]

v txzonemgr R T hERITT S

DAY T KT, INAE = Z2RUITHER,. 1> A =)L, #ik. Bk
NEETHY A ZIEICETLET, ZOAZ U T RTIE. & — 4TI Z2 AT
TEZD£FIE TNV EBENT, NuiFr—2%2 1 2 A M=)V U TIREER 0S Z1ERK

L.
=S

V=2 ERBLTZEDY — > T —EXERIIBLET. ZOAXAZ YT RC
V=2OaAE—BLRNY =207 O—MERDY AT INGENTNET, £

=, J—=20DEIE, = DIREDETE, - EAEDR Y NT—T A F
Tr—ZADEMHTEET,
CDAZY T RCE> THMICIRESND A 2 —2ERI N, BEDRMICHR)
IRBIROAMMEREINET, 72E2E, V=2 DAT—HFAEZRETDIHEIC

=

AU A MZERENER A

RO BHIC

A—=)N\—1—T =D F7,
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70

= a— R ERTAEEIL. Voo 0—ERDOEHERZE T L TR E
F9, MEOF AT —FT > T L —bE2HEHTIHET. FOT>TL— %
ERRLTBEXT,

WmAD 4 ROEKEEY - THEEXT.
txzonemgr A2 U 7T hERFTLET,

# /usr/sbin/txzonemgr

ZDAZY T T, [Labeled Zone Manager] ¥ -1 7 O 7R 77\7J\‘Faﬂéci'§_ Z
D lzenity] ¥4 707Ky 7 AT, A > A M—ILOBIEDRREIZIEC T, @byl
H A EFITTHEIRDENET,

HAY EFTTHITNE, AZa—HEZERL TH 5, Returnf'\— I NER
I 22092 L0%Ed. TFARDANEZROSNIZHEE, TFAREA
AU THS Return F—2 I NEKT TTH 200w bi@‘o

By b= — 2% T OHEDIRIEE ERT SITIE. Labeled Zone Manager @ [Return to
MainMenu] 27 Uvw 27 L%,

Trusted Extensions Crry h ) —0 A 77 1—2X
=HERT 5

E-DHCP 2T 2K DT AT LAZHKT 255G, OpenSolaris Community:
Security Web “X\— 27 (http://hub.opensolaris.org/bin/view/
Community+Group+security/)® Trusted Extensions DEilZdH 5 / — F/XV O BT 5
fRRZEZIRL T Z3 W,

Solaris 10 10/08 U U —ZAM 5, &I NIFE =N MEOY 732y MZH DT AT
LEBRT 25618, COFEZEEL T, 75X—20 V= ICA4RIBLUITAX
NWEfIT5] ICHEDZENTEET, V=2 DA AM—IVENATIA REKZ
725, 8 R—J0 MEFEDITN)IAEY — 2R EETET 5201y hU—21
SH T —AEBNT S| TEITNIWMNES =Dy NT—0A 2 T2—A%
BMLET,
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RO BHIIC

ZDHAYT, v hT—F 7K — > THIKL £79. all-zones 1 > %

T — A% 1 DEFERTDHENH D ET, all-zones { ¥ 7 = — A, TN)V
P& —2ERBY—>THEINET, ZOHEA YT —RF, TN E
‘j“\/&ﬁfﬁi‘/\‘—“\/@ﬁﬁ@]\‘374 v 7 OGN HFERSINET, To1 2%
Tz —AERERT HITE. ROWTNNEETLET,

» WA T ANSWmEEA Y T = A B LR WA 2 T 2 —
EHAELET,

O, BREICEST, o EBEHETT, Y ATAN2DOIPT RLA
ZHOLETOHNTWDHAEIC, ZOMKREERLEXT, ZOFETIE, w1 >
&7z —AFKRE - OEAETY RLAERD, WA 28 T x— ATRE
V=2 ETRNIFEY = CRITHRESINET,

w WA T - AEHELET
SATLIMIDDOIP Y RLAZEDETENTNSHAIT, COMMREERL X
T ZOMKETIE, K —>ETXUFE = HTYEA > 72— AhHk
AEINET,

s REFXY RNT—=UA2FT2—Avnio ZHELEXT
DHCP ZHk T 2550, T T %y hU—=U DI NIRRT DHEE
I, TR EZERL £9. FIEFIZ DN TIEZ. OpenSolaris Community: Security

Web X—37 (http://hub.opensolaris.org/bin/view/Community+Group+security/)®
Trusted Extensions £ilZ &5 / — 8NV O BT 2 RZ2SH L T7ZE N,
Solaris 10 10/08 U U — A 5. Trusted Extensions DJ)V— T )N 71 > % 7 = — A1

all-zones 1 > 7 7 —AE L TIERENET, D7D, vniodtHF 1%
T —AEERT HHEITH 0 FH A,

= EHDORY NI =0 A4 T —AEBMT AT, A 2F T —AZBN
T BHENT, J— /@WW%ﬁ?LT%;Liﬁ FEIZDNWTIE. 85 X—2 D TEE
FEOTR)INE) — 2 BRBIEET 27201 %y NTU—0 A4 2 T —AZBINT
5] 2R TL7EI N,

K — > TA—/N—2—HF—IZh D X7,

Labeled Zone Manager W& /RSN TWET, TDGUIZHAITIE, 69 R—
@ Ttxzonemgr A7 U7 N &2ETT 2] 2R T EI N,

lLabeled Zone Manager] T. [Manage NetworkInterfaces| Z:#RL T, [Tl &
o2y UET,
A2 T2—ADY A MERINET,

F-ZOFITIE, WA Y T —AIWTHRAMLEIP Y RLUANA > A —)VBRIC
BDYTE5ENTVET,
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72

YIBA YT —REREIRLET,
A TT—AMLIDHDT AT LI, ROED B AZa—INERINET, &
EDDITERLREBMLTWET,

vnio Down Virtual Network Interface
eri® global 10.10.9.9 cipso Up Physical Interface

a. erio A/ ¥ 71 —REZERLET,
b. IT#l #0UvyoLET,

DRy NT—=0A T T—RICBLIEI RV EZEIRLET,
KD, 3DOF T aMERINEd,

View Template Assign a label to the interface
Share Enable the global zone and labeled zones to use this interface
Create Logical Interface Create an interface to use for sharing

n DRTABIDDIPT RLREHDBEIE. FlIE4ICEALET,
s DRTAM2DDIPT RLUREFHDESL. FIESICEAET,

1DDIPT7 RUVREHF DV ATATIZ. MBA VY71 —REHBLET,
ZOBRTIE, SARDIPY RLAMIRTOY —c@ianEd, Lz

Mo T, FARDY RL Aldall-zones 7 RV AT, TOFRARZETILFL )
B—N—ELTHHTDZEIITEZ A, 2L - =3O AT AN
50T 7 AINEHRETLZEEFTEETEA, TOT AT A, LDAP JOF
HY—/N—, NESTR—ALT A4 L7 bUP—=N—, TY Y= N=LF 5 LEIITE
FH A,

a. IShare] #FIRLTC T 20Uy o LET,

b. #EA VI T 1 —ADPRRENLIATAIRYIRT, [THI €0y oL
i—g—o

eri@ all-zones 10.10.9.8 cipso Up
WA > Tz —ADall-zones f >4 7 = —AIZ72> TWIUX, FIEIZIEFIC
SETLTWET, 75R—=20 = IZA4HIBLO TN EMIT S ICHEAE
‘?_0
2DDIPT7 FLRZEF DV ATATIE. WEBA V71— REERLET,
D%, WML I T —AEHAFLET,

ZHUEH o &EH 2 T )VIR Trusted Extensions v N — 7K T, ZDRERT
3. AT DIPTY RLAREND AT LN DY AT A LEOEZEDY — 2 HE
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151 4-3

TEHEDIHERAL, @Ml >y 72— AR —ICEBEET LI EMTEE
o R/ =BV F LN —N—ELTHATEELT,

a. [CreatelogicalInterface] Z:#EIRL T [T#El 20U v o LET,
HLWEREEA > % 72— ADERERKR T 251 707 Ry 7 Z&HUET,

b. T[SetlPaddress] Z#iRLC TR #2)v o LET,

¢ 7OVTITHREBAVITI—ADKRRAMREREL. [THI 20Uy o LE
j—o

72EZI B YT —ADKRA ML EL Tmachinel-services ZFEE L £
T, ZO4HENE. ZORANNIINF LN Y —ERZBHET L LEEZRL TN
i—g—o

d 7OV MNCHEBA VYT —ADIPT RUREIREEL. T8I #2)v oL
£,
F2EZE B AT —ADIPTY RLAELT10.10.9.2 2fFEL T,

e. WMBEAIYTI—REHLD—EBERLT. [TH 20U v LET,

f. [BringUpl ZZIRL T ITH 20 v I LET,
A Tz—AMWUp ELTERINET,

eri0 global 10.10.9.1 cipso Up
eri@:1 global 10.10.9.2 cipso Up

g MBA YT —REHBLET,
i. WEBA YT —REFERLTCITH 20y o LET,

ii. [Share] ZZERL T ITHEI 20Uy o LET,

erio all-zones 10.10.9.1 cipso Up
eri0:1 global 10.10.9.2 cipso Up

Pl EH1DODA 2 Tz —AMall-zones 1 > ¥ 72— A7 > TWiuE, FE
BEFICETLTWET,

HEREBA YT T —ADBDHBHRTALATD Jetc/hosts 77 A ILDER
7~

K —N—BDA T2 —AMBD, IR ET—=2NFD1 >4
T — AR — 2 EHET D AT LTI, /ete/hosts 7 7 T IVIZRD K DI
T0ET,
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# cat /etc/hosts

127.0.0.1 localhost
192.168.0.11 machinel loghost
192.168.0.12 machinel-services

T 7 )V MERTIE. tnrhdb 7 7 T IVERD L D172 0 £9,

# cat /etc/security/tsol/tnrhdb

ié%.@.@.l:cipso

192.168.0.11:cipso

192.168.0.12:cipso

0.0.0.0:admin_low

all-zones T > 7 = —AMtnrhdb 7 7 1 IVNIZIR WG, 1 2% 72— AdT
T IV ED cipso il D ET,

tla-a IPT7 KL XD 1DdH A Trusted Extensions > AT ATDOHEFA %
TJ1—XADXRNR

ZOHITIE, EHENS AT LEZIINF L)Y —=N—E LU THHAT2EEIIHD
FHA, IPTY RLAZHKT S0, IRXRTOINIIfTE)—2EPTY RL A%
BT DHEDITKRE — NI NET,

BEBHFEIL, ATLDhmed 1 > 72— AELT [lShare] ZEIRLET, 2DV T
72X, TRTOYV—VIZHENICOADHDEIHIBEEINET, INS5DH
HNICIZ., K —>T1 OB NICEIELET,

EMHFIL ifconfig-a ANV RZFETL T, XY M= 25T —A
192.168.0.11 ICH DYWL > T — A meo NILFIND T E2MERL F
F, all-zones DIENEREINET,

100: flags=2001000849<UP,LOOPBACK,RUNNING,MULTICAST,IPv4,VIRTUAL> mtu 8232 index 1
inet 127.0.0.1 netmask ff000000

hme@: flags=1000843<BROADCAST,RUNNING,MULTICAST,IPv4> mtu 1500 index 2
all-zones
inet 192.168.0.11 netmask fffffe@® broadcast 192.168.0.255

Solaris 1010/08 ) ) — A1 5, Trusted Extensions DJ)L—"7)\Nw 71 >4 7 = — A&
all-zones 1 > 71— A E LU THERRESNET,

100: flags=2001000849<UP,LOOPBACK,RUNNING,MULTICAST,IPv4,VIRTUAL> mtu 8232 index 1
all-zones
inet 127.0.0.1 netmask ff000000
hme0d: flags=1000843<BROADCAST,RUNNING,MULTICAST,IPv4> mtu 1500 index 2
all-zones
inet 192.168.0.11 netmask fffffe@® broadcast 192.168.0.255

EHEIL Jetc/hostname.hmed 7 7 T IV ONE HFANET,

192.168.0.11 all-zones
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v V—=2ICRRBLUOINIVERITS

RO BHIIC

label encodings 7 7 f VDTN T LI — 2 #ERT 20 EIZH D FHAL
M, MERTHZEDHTEXET, HHGUIICED, ZTOI AT ATGUIHIZERESN
=B DIEDTELITINIDNFEINET,

K — > TA—=/N—2—H—IZ/x D £7, [Labeled Zone Manager] ¥ 7 1172
Ry IANFRINET, ZOGUIZHLIZIE, 69 X—TD [ltxzonemgr A7 U 7
FEFTT2) Z2ZRLTEZEN, Xy bT—=UA 25 T2 —AZ KB/ — 1T
MR L TWET,

WERYFaUT =TT L —rEERLTVWET, EFaUT =727 L—h
T, BHEOHRTHIC, 2 NT—I A2 72— AZEDYTHIENTESL IR
NWEIHZERLET., 774 hOEFa2UT 0 —F > 7L — N THLEMEITZ
INBHIEIFHDET,

s tFaUT =TT L — FOBEIZDWTIE,  TOracle Solaris Trusted

Extensions & HEDFIEI D [Trusted Extensions D%y hT—2tF 2 U T 1 —JF
] 2L T3 N,

s Solaris B Y —IIVEFERALTEFaT s —T > 7L —b2ERT I
1%, TOracle Solaris Trusted Extensions H¥E D FNE] O [T AT v RF*w b
T—=0 7= RXR—=ZADOKKRAF¥E< Y 7)) Z2Z2RLTIEZIN,

lLabeled Zone Manager] T. [Createanewzonel =& Uw o LT, [TH#| %75
Dy o LET,
TO> T FTHADANERDSNET,

a. V—rDREMEANLET.

By k- =2 DT EY — T E T, EAR. TN
CONFIDENTIAL: RESTRICTED T&H 5 — I, restricted &W D &2 E
‘a—o

=& ZIE. T 7 4 )V ED label_encodings 7 7 1 IVITIZRD T ROV E FN TN
ES

PUBLIC

CONFIDENTIAL: INTERNAL USE ONLY
CONFIDENTIAL: NEED TO KNOW
CONFIDENTIAL: RESTRICTED
SANDBOX: PLAYGROUND

MAX LABEL
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TN ZERZY =2 I DIERTEXTA, ROV — 2 2Ekd 5 L &emmatl
TLEEWn,

B I RTOILI—Y—DI AT ALTIE, PUBLIC TN)LIZ1I DD —2, BXN
CONFIDENTIAL T N)LIZ3 DD — 2 BERL 7,

. BFEEHD S AT A TIE. SANDBOX: PLAYGROUND T N)LIZY — % 1 DIERRLL
F 9, SANDBOX: PLAYGROUND IIBHFHEHZH O RERHE 7 NI & L TEHE SN, BT
FENMFEHT DI AT LIDH, ZDITR)IY — O DHETT,

m MAX LABEL T JLITIEY — D BERLBNWTL7ZE W, ZAUIR T ERELT
EFRINET,

b. TT#OKI 22U v LET,
A T7OTHRY 7 ATl A7 DY A RD_EIZ zone-name : configured MNFER S
NEd,

2 U=VIEINNLVEMTBICE ROWITNDERRLET,

» HRHZTA X L7 1abel encodings 7 7 A I ZEFERALTWSEE. S XT Y R
Ty ND—=0 == )VEFERALTY =NV ERFITET,

aa FSRTYRRYMND—=OY—=2Y—)L%ESolarisBEEIY —)LTHZEET,

i. SolarisEEIOY —JLZEKEILET.
# /usr/sbin/smc &

ii. O—hJL> AT AD Trusted Extensions Y — LRy 7 R &#F&EF T,
a>y—ibl - =LKy o R%#A<] ZFERLET,

(23 Ea—% (this-host: Scope=Files, Policy=TSOL)] & UL\NDZREID
V—IliRy O REFEIRLET.

A< 22U v o LET,
ii. TXRTADHERK] (CHD TAVEa—vExyNT—21 (ICBEILE
ER
RKDODENTZENNAT—REATLET,

iv. N\SRTYRRY MDY=V )EGTINVO) v I LET,
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b. V=T &I, BNLESNIEY - ZEBEMITET,

i. [(7ooarv] > V= #8B0Em ##RLET,
HATOTHRy 7 A, FDBTSENTND TRILNZWNY — > D4R
FRINET,

i. V= REWERLTHS REI #0) vy I LET,

iii. 7N EIS—T, V=2RICERHTEINIINEIY I LET,
MES I\ LiegEa, TDOIN)EdH5—E 7)o LT
BIREZMBEL, FLWIR)LZZUw 7 LET,

iv. B|UHTERELET,
(RS ATy KRRy NT—2)—>2070aNT 4 —] 1470718y 7 A
TITH 2209w L%ET,
BTN — M T RTONRIVICEREINZ 6K T T, HHWE, T —
OB AZa—HHZZ w7 T5E, = EADEN WY A7 0T
Ry 7 AWM NET,

= T 74 )L bD1abel_encodings 7 7 A )L ZER L T\ 5155, Labeled Zone
Manager Z{ERA L £ 7,
[Select Label] A= —IHHZZ Uy 27 LT I 7#)] 27 Uw o L., HHATHR
FNINVDY AR ERRLET,

a. V—DOINIEZERLET,
public EWVWD ARTDY — > DFE. U A KD 5 puBLIC TRV EEIRL £77,

b. TEOKI 22Uy o L&D,
H AT DY A RNERINET,

v IN)WTEY—=2FA A M=IILT S
o AR K — > TA—/NN—2—HY—IZRD XTI, V20N THD, DY TH
HBDXYy NT =0 A28 T2—ANHDET,
[Labeled Zone Manager] % 7 27 Ry 7 AMEIRE 4. zone-name: configured &
WHOBTHA RIVIMFNTWET, ZOGUIZEBLIZIE, 69 X—TD [txzonemgr
AV T heFETT5] ZBRLTIEZI N,

1 Labeled Zone Manager 705 llnstall] Z#RL T IT#E] 20w o LET,
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INIFEY =2 DIER

78

A\

EEEIE

v
1RO B

FBE-ZOTOERANKTTHETCLESSKHADNDET., 2O AT QETH
3 ENDIT AT ZFTLIENTLEE N,

CATLT, R — NS IR — iy =N aE—-3NET, ZDY
AT ES T, IR EDIREARL —F 4 2T AT LD — 021 VA
c=VENET, ZOFIZEEITTHED. ZDOF AV Tpublic/— 201 > A
F—=banFEzd., GULIZRO XS et hhFRINET,

# Labeled Zone Manager: Installing zone-name zone

Preparing to install zone <zonename>

Creating list of files to copy from the global zone

Copying <total> files to the zone

Initializing zone product registry

Determining zone package initialization order.

Preparing to initialize <subtotal> packages on the zone.

Initializing package <number> of <subtotal>: percent complete: percent

Initialized <subtotal> packages on zone.

Zone <zonename> is initialized.

The file /zone/internal/root/var/sadm/system/logs/install_log
contains a log of the zone installation.

;¥ - cannot create ZFS dataset zone/zonename: dataset already exists D& D72

Avt—=F, ERAYvE—2TY, V-2RBBEOT -y hEFEALET,

AAR=IDETTEHE, RANDARIDANZ BRTH 70T IRNERIN
9., BHINFERINET,

TDRANDEFZEETDEEFEALET.

H AL 707Ny 7 ATIE, YA DU A KD LT zone-name:installed WHER S N E
7,

ROELDIREENERREINET, [Installation of these packages generated
errors: SUNW pkgname] MZRINIZH/E, A A =)0 T ZHH, N T —2D
AAR=INEERTLUET,

NI EY -2 ZREF}T D
K — > TA=N—=2—HP =D Ed, V=P A r—=)bEnTH0, Fl
DY THEBDRY KT—=D A2 T2—ANHD £,

[Labeled Zone Manager] % 7 0278w 27 AMNEI/RS L. zone-name:installed &\

SHTHA BMIVIMFTNTNET, 2D GUIZERE<IZTIE, 69 X—2D [txzonemgr A
JUTNEERTT S 2BRLTIEI N,
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1

lLabeled Zone Manager] T [ZoneConsole] Z:#EIRL T IT#l =2y I LET,
WEDITNIAFE =202, BlOoa2—IV T4 > RUNRFRINET,

lBoot!] ZZEIRL FT.
N —>mRI =)V 13, V= EFHOEBEBIRLET, V- ERINS
YERRT 25513, ROLD DB Ay E—Na ) —IVICERINET,

[Connected to zone ’'public’ consolel

[NOTICE: Zone booting up]

Hostname: zone-name

Loading smf(5) service descriptions: number/total
Creating new rsa public/private host key pair
Creating new dsa public/private host key pair

rebooting system due to change(s) in /etc/default/init

[NOTICE: Zone rebooting]

ER-ZDI AT OEFTHIL, ENDI AT ZFETLIRNTLZS N,

4DDT T AN DY — IR SN TEE T2 &, Labeled Zone Manager Tl X
DEIIY—2NERINET,

Labeled Zone Manager

Select items from the list below.

Zone Name IStatus ]Sensitivity Label

internal running CONFIDENTIAL : INTERNAL USE ONI
public running PUBLIC

needtoknow running CONFIDENTIAL : NEED TO KNOW
restricted running CONFIDENTIAL : RESTRICTED |

Manage Network Interfaces...
Create a new zone...

Configure per-zone name service
Create LDAP Client...

Exit 2
[k 8: i - |

nganceIH @ 0K ]

BEIEoTE, TI9—Avt—INERINTY—2NHEE LN ENHD
F9, V—WARI Y =)V TReturn F— 2L 9, HEHFHTEZDITyDAN
ERODTO2T MNRFERINZS, yEASILUTReturn F—Z2L X, V—>
NHEHINET,
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RDFIE

D=2 = A =3 NnE iy o— AER S N EE.
ONR—TD V=2 DAT—H AEMRT D] ITHEAET,

D —=2INBHIDO = THDHHEEIL. 81 R—TD [FR)AfFES -2 %A
RAXT 5] ITERAET,

V—2DAT—Y REMRT S

FE-XY—N—NKRE — > TETFINET, TNTNDTNIIAES—2INZDX
Y= N—2ZFHT DL, K —ICERTERITNERDERAL, 2D

O, =2y NT—=UERELRTNL, V- E2ERTAIEIETEEE

o HROBHIZDOWTIE, 28R—T0 IRIVFL )T 7 ADEHHE ] 25 L
TLESWn,

V—UDBRECEHINTNDLEHALET.

a. zone-name:J — VAR =)L T, rootE L TATA 2 LET,

hostname console login: root
Password: Type root password

b. V—2UARIAVY =T, 2UT 4 AN —EXDBRITENTNS I LEHERL
ij_o

# svcs -xv
svc:/application/print/server:default (LP print server)
State: disabled since Tue Oct 10 10:10:10 2006
Reason: Disabled by an administrator.
See: http://sun.com/msg/SMF-8000-05
See: 1lpsched(1M)

sendmail BEWprint U—ERIE, Z7U T4 WP —EATIED D £E A,

¢ V—VICBHEBIPTRULADBHDLEHERELET,

# ifconfig -a

L ZE RO NITIEmeo 1 > T2 —ADIP T RLAMFERINET,

# ...
hme0: flags=1000843<BROADCAST,RUNNING,MULTICAST,IPv4> mtu 1500 index 2
all-zones
inet 192.168.0.11 netmask fffffe00 broadcast 192.168.0.255
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INIfFEY =2 DIER

RDFIE

ADBHIIC

d. (BRER[EE)V — DK — > LBETEA LR LET,
i. DISPLAYZEHMMX Y —N—%RA > TEHLOIBELET,

# DISPLAY=global-zone-hostname:n.n
# export DISPLAY

i. MR YOS GUIZRRLET,
mEZE vy ERRLUET,
# /usr/openwin/bin/xclock
V=2 DIR)Tr Oy IINERINBNERIL. V—0F%y hT—F >
TINELSHERINTOWERA, TN\ 7 ICBETREFHEIL, 111 X—2
D IIRMFES =2 MX Y —=N—IZT7 IV EATERWN] Z2BRBLTIES
[/)o

ii. GUIZBEAL CTifTLET,

RE—oho. SNIFEY—VDRAT—5 A =HRLET,

# zoneadm list -v

ID NAME STATUS PATH BRAND  IP

0 global running / native shared
3 internal running /zone/internal native shared
4 needtoknow running /zone/needtoknow native shared
5 restricted running /zone/restricted native shared

INTIRIfTE) = ORI T TT, V—BEHEDFRY NT—0A 4
Tz —AE =BT 50, TN E =2 ZECT IV NI —T 4 2T
NI BITIE, 85 R—2D [y NI =0 A 2 T2 — A% TN)VfE— 1T
BMU., =T+ 20T 2] ITEAET, £ TRVWEEIT, 93 X—2D [Trusted
Extensions CO&E| & L —F—DERR) 1ITHEAET,

INIGFE =2 HAIRA TS

=D O0—2EERT S, FR3V -2 —9 5848, ZOFEIC
EoT, V=NEFID =2 DT T L — NI EDITHEREINET, &5
2, ZOFIEIZES> T, FHTET> T L — MO SEREIN TN — 2 ZHERR
LET,

K — > TA=NN=2—HF =720 £T, 80X—TD [V —=2DAT—F A %1
Wwd B ZETLTHBEERT,

V=R AVY —IVT, SNIMFEY -V TRERY —EXZBHICLET,
LYV —=aE—FR 70— 22 ERT 556, Bl —EARH LY
V= THENIEINET., PATLTEHIA > THE2Y—ERE, £DV—2D
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H—EAYZ T AMIE>TERD ET, netservices limited I > RZ2MHL
T, TN E =2 TRHEELENWY—EZX 24 7ICL T,

a. ZHDORELGY-—EXEHKRLET.

# netservices limited

b. ZDENMDY—EXZ—EICLEXT,

# svcs
STATE STIME FMRI

online 13:05:00 svc:/application/graphical-login/cde-login:default

¢« UST74ANA5AEBHICLET.

# svcadm disable svc:/application/graphical-login/cde-login

# svcs cde-login

STATE STIME FMRI

disabled 13:06:22  svc:/application/graphical-login/cde-login:default
H—ERAEMRT L —LAT—7 DM, snf(G) DX Za TN R—VZ2ZWLTLES
W,

lLabeled Zone Manager] T [Halt] ZZRL TV —2ZEILELET,

BT BRI, V=B vyy MO ENTWS I EEZHRALET.

zone-name: ) — VIR A =)V Ty RDAvE—JICLo>T, V=N v v b
JEINTNBE I EDNRINET,

[ NOTICE: Zone halted]

IOV —2%dE—%kFZ0 70— 2 ZERT 5D TIERWES., ZORD
= BER LD ERIUAETEODDY — 2 Z2ER LT, TDENDOHE

. ROFIAICHEAE T,

D=2 EFPDJ DT TU—hELTERTS5E. RDEBYJICET
LETY,

a. auto_home zone-name 7 7 A ) ZEHIBRL £,
KIS — > DK T 4 > R T, zone-name ) —>MN56 DT v A IV &EHIBRL £
—g_o

# cd /zone/zone-name/root/etc
# 1s auto_home*

auto home auto home zone-name
# rm auto _home zone-name
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INIfFEY =2 DIER

1RO BHIIC

7ZE A, public V=2 WNEhD —> D7 a—AERtT > 7L — R Th s
. auto home public 7 7 1 IV ZERD XD ITHIBRL £7°,

# cd /zone/public/root/etc
# rm auto_home_public

b. 2DV—2rDoO—2EERT B5E. ROFIETZIFSRA v 7 ay bEERK
LTHhHE, 83XR—M [TrustedExtensions TV — D IAE—F /=3 0— %7
O] [TEAET,

¢ ZDY—2EOAE—T3HBE1F. FlEeEZTTLTHN583X—20D [Trusted
Extensions CV —>DOAE—F/=(30 025170 ITEAET,

ZTOMDY —> Do O— 2V EERT BN —2 T T L— MEERT BIC
(Z. TCreateSnapshot] ZZERL T ITHl 20U v o LET,

FE-AFw T ay by =203, ZFS 7 v IV AT ARNIZRT TR D £
Mo 59R—TD =207 O— 2 2ERT 572D ZFS T—IVZ21ERT 5] T
=T ZES T 7 AV AT ADMER S NE T,

NRIIRA XU =V INEEFERTES L &R T 51213, TLabeled Zone
Manager| 75 [Boot] ZZEIRLE T,

V=R ) —IVE, = VREBIOEBEZEBIFLET., ROLSI R AvE—
M) —)NIZERINET,

[Connected to zone ’'public’ console]
[NOTICE: Zone booting up]

Hostname: zonename

074 >7827 MU TReturn F—Z2#LET, root ELTOVA U TEE
7,

Trusted Extensions T/ —> DA E—F /(35
O—>%1712
SLN—TD (SR E S BN AT YA ZT D] BET LTBEET,

[Labeled Zone Manager] 5 7 Oy 7 ANFREINET., TOGUIZEHIT
1. 69 X— D [ltxzonemgr A7V T hEEITT D) 2BRL TSN,

V- EERLET.
FE, 75 R=2D [V=2ICARTB R ITNNZEMIT5] 2L T ZE N,
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2 RDAEDODNINDERRL T, V- ERA NS TOZ2HITLET.
HRDY) — > TEITROFIREHE VKL ET,

» SNEMTLEY - EIE-LET,

a.

e.

f.

lLabeled ZoneManager] 75 aAE—] ZZIRLT [Tl 20U v o LE
ER

V=T TU—baBERUT TR 20V v o LET,

T4 RIIZAE—D T O ANERINET, TOANETTS
E =IO A = ENET,

[Labeled Zone Manager] |2 [zone-name :configured] &ERRINLHE
W ROFIRISHEA LT, TNLIOHEIE, FlHe ITEAXT,

A= a1 —I8H [Selectanotherzone] ZEIRL T T 20y o LET,
HIBICA A M=ILENY—ERBIRLT, (T8 20) v o LET,
718R—=2D [SXN)ftEY - %288 T 2] #5287 LET,

80R—UD V=Y DRAF— 5 RERRT 5] £RTLET.

» SNEMTEY-DOoO—EEKRLET.

a.

b.

d.

lLabeled ZoneManager] T o O—>1 ZZERLT T8l 20U v o LE
g—o

JRAMDPSZFSRFy T ay hEZRLUT ITHE 200y LET.
EZIE publicMH ATy T ay NEEKRLESE

¥, zone/public@snapshot ZJ&IRN L F 7,

JO—MERO T O ANETTEHE, =N A=)V ENET, F
JIE clzitEAET,

J—=rarvy—=J)VERE. V- EEELET,
FIEICDOWTIE, 78R—2D TR E -2 2EHT S 28R T
7230y,

80R—UD V=2 DRAF— 5 RERRT 5] £RTLET.

84 Oracle Solaris Trusted Extensions # 5 H 1 K « 201059 A



FYRT—=0A0E T —RESNIVFEY =V (TEBML, =T 40T 5

RDFIE =

TRTDY/—ITHLT8OR=2D V=2 DAT—F A %R T 2] 2T L

TWT, &= 2FNTNHomE Ry hT—27ICEET 55813, 85
R=0D BFEOITNIAE — 2 2R EBET D0 ry NO—0 A4 24
Tr—AZEEBMT 5] IZEAET,
s FEEEAERL TWRWESIE. 93 X—2 @ [Trusted Extensions T D% E| &
I—HY—OEk] ITHEAET,

» JTIEEIZEREADL G,

T4 L7 N DOER) ICEARET,

105 X— @ [Trusted Extensions TDHR— L

XY RNT—0A 2T —REIN)fFTEY — 2 ITEM
L. V=T« >09%

RO, &Y —2NERIOWE Xy FT— 7 IC8EE SN TWDEREITHIS L £

ER

E%

A

la: %y NI—UA 2%
T —A&&ITR)fTE
J—AZEmL. K
= &R LTI
Zw hT—2I1CEEL X
ER

FHI R E — oy b — 2128
BELET. TN EY =203, K — 22t
Toxy FT=VI)—F1 2R LT,

85 XK= D HFED TNV E
V=D ERBEIRET 5720k y b
D=4 25T —A%BMT 5]

Fzid1b:ry hU—2
AT —A%, T

THIV b= &R L
THEINIfFET— 20T
EIMLET,

AR [ lIOL 7 S N A/ e S TADS
To TNATE = 2NF, V=T« 2T TR
V= EFERLEE A

88 RX—T D [HEFED TNV &E
V= D B RKIEE T B IR
J—EFHLEWERY hT—27 1
T —ABINT 5]

2. 32— LT —EX
Frvaz&I NIV
N —ITER L £,

&=L TR— AP —EATF—E 2 EMRL
ES P

2R=VD [FR)fFE/ =2 T &
xR =LY —ERAF v v 2 ik
ER:T

v BEDS NI E Y — A ERIEET B0
3y R D=5 405 7T REBMT S
ZOFET, V—CEREORY NT—=0A4 25 72— A& HED I NIIAFE) — >
WEMLUET, ZOMRKRIE. &I NIUEY — o nenengl oy ry kT —2

ICEBSNDIRFITHEL £9. TNUGEY =203, KLY — 20 #d 5
Fw b= ) —=F4 2T HHLEXT,
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86

R BRI

F-oKREY = TlEL JEREY > 7 RU AR SN &Y T %y ML TIP
7 KL AZRERT 20ENH D £T,

K ) — > TA—/N—I—HF— 2D FT,

TRTOY =L, 68 X—=2D [TN)UFE — 2 DIERL] OFEEZTETLE
ER

KiFV—>T, BMORY T =042 5T 1 —ADIPT RLREKRR ME%E
/etc/hosts 77 A IVICANILET,

RA N DR -zone-name ZBINT 572 L, EHENSMAHRANEZFHL T2
W,

## /etc/hosts in global zone

10.10.8.2  hostname-zone-namel

10.10.8.3  hostname-global-namel

10.10.9.2  hostname-zone-name2
10.10.9.3  hostname-global-name2

BAVITT—RADRY FT—L T, /etc/netmasks 77 AIJVICTZ MU EEBINLE
—g—o

## /etc/netmasks in global zone
10.10.8.0 255.255.255.0
10.10.9.0 255.255.255.0

FEHRIE. netmasks(@) DR Za T IR—T2BRLTLZE 0,
K —>T. V—EEDYEBA 5 71— X% plumb LET,

a. $TICplumbENTNWSMEBA 4 71— RERELET,

# ifconfig -a

b. 8A I T 1 —RDKEBY -7 RUREEELET,

# ifconfig interface-nameNI plumb
# ifconfig interface-nameNI 10.10.8.3 up
# ifconfig interface-nameN2 plumb
# ifconfig interface-nameN2 10.10.9.3 up

¢« BRFY—27 KL XIZX U T hostname. interface-nameN 7 7 A W EVERL L E T,

# /etc/hostname.interface-nameN1
10.10.8.3
# /etc/hostname.interface-nameN2
10.10.9.3

R =27 RLAR, PATLNEHT D EEBITHRENET., V— A
D7 RL A, V= DEHFFICHERINET,
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FYRT—=0A0E T —RESNIVFEY =V (TEBML, =T 40T 5

10

11

TNENDY—CEFEDRY NI—0A 571X, FaVTa—T 7
L—hZz8UHTET,

Iy NI =T ANDT = T AT NIRRTV EIE, adnin low T
FaT4—FT>7L—hrEEOYTET, XY NT—IADTF—FTAIZTN
IWHDMFNTWB AL, cipsotFaUT 4 —FT 27 L —r2EDYTET,

BEFy NT—=7 DIV ENRT S, RARYA TcipsoDFalsT4—F527
L—RZERTEET, 7> 7L — hOERBLTE D LY TOFIEITDNT

1¥. TOracle Solaris Trusted Extensions B HEDFNE] O R T ATy RFEy hT—2
F—H R—ZDORERL (TEE~< » 7)) ZBRLTLIESI W,

J=VEEDA VI T I —RICEBMTBEITRTOINIIfFE - & FBELET,

# zoneadm -z zone-name halt

Labeled Zone Manager & #2&) L £ 9.

# /usr/sbin/txzonemgr

V—VEBDA S 7 1 —REBMEIELZNEY =V ICDNTIE, ROBEEETT
LETY,

a. V—UEBERLET,

b. T[AddNetwork] Z:ZRL £,

¢« RYMI—0A2HT 1 —RICERIZEMITET,
d. 127 1—ADIPT RLRZANLET,

T LT RTDY—>2D lLabeledZoneManager] T. [ZoneConsole] %R L £
ER

[Boot] #ZERL .

[ZoneConsole] T. AV —T T AMERESNTWBZ EEHERELET,

# ifconfig -a

BIXy bDT =R ANDIL— DB —2ICHDLEBRALET,

# netstat -rn
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88

EBEIE

R BRI

V= UHRETINY T 512 RESZRL TS ZE N,

=  [System Administration Guide: Oracle Solaris Containers-Resource Management and
Oracle Solaris Zones] D530 % [Troubleshooting Miscellaneous Solaris Zones
Problems |

m 110 R—®D [Trusted Extensions DIERD =T T IV a—F 4 > 7]

. W'Orac‘le Solaris Trusted Extensions E¥EDFIE) @ RN T AT RRy hT—2U D
NI TNa—T4 207 (EES Y )

BEOINITEY — 2R BIEE T 570K
|y - & FERLEWRY N =04 %
J1—RZIEMNT S

ZOFETIE. BEOTNIAFES =T/ LT, V—EEDT 7 )V RL— K
ERELET, ZOMERTIE, SN E =203 V=T 4 2T TRE - %
FERLER .

TG E =213, V=2 EEET HENTARIEY — > plumb LET, 7272

L. IRNIUMGEY =2 2R — oG0S 2012,V — 2 OB > %
Tz — A% down REEICL TS 23\, #MlliZ.  System Administration Guide: Oracle
Solaris Containers-Resource Management and Oracle Solaris Zones] D% 17

% [Non-Global Zone Configuration (Overview) ] .

F-EENTATRTCOIERE ) — iz, BEDODT 7+ ML — 2R L7,

K )— > T A—/N—T—HF— 2D FT,

TRTOY =L, 68 X—=2D [TN)UFE — 2 DIER] OFEEZTETLE
o vni0 A 2F T2 =AM 1001 >F T2 —AZMHL TINIUFE — > % K
V= AT L TV E T

IRNTDFRY bT=0A4 25T =T L. EDIPT RLVR Ry hRRO T
AN —= R ERENET

IP7 RLAEFRY YAV ZNDITIL, ifconfig-a AN RZHHL T, T
THIVRIV—RNED LY TENTWENEIMNEHET BITIE. zonecfqg -z
zonename infonet AX > RZfHL 9,

BINIAFEY —VRIT. ZED /etc/hostname. interface 7 7 A IV EERR L E T,

# touch /etc/hostname.interface
# touch /etc/hostname.interface:n

FERNE. netmasks(4) DX Za T IIR—VEZSRL T ZE W,
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FYRT—=0A0E T —RESNIVFEY =V (TEBML, =T 40T 5

INIMFES =Dy NI =0 A7 T2 —R%Eplumb LE T,

# ifconfig zonel-network-interface plumb
# ifconfig zone2-network-interface plumb

INIFEY=2DA > E T 2 — AW down KEEICIE > TSI LR LET,

# ifconfig -a
zonel-network-interface zonel-IP-address down
zone2-network-interface zone2-IP-address down

V=YEREOY RLAZ, V=2 OEBRHICHR SN ET,

AT TIT—RADRy ET—U T, /etc/netmasks 77 AIJVICTZ MU EEBINLE
ERR

## /etc/netmasks in global zone
192.168.2.0 255.255.255.0
192.168.3.0 255.255.255.0

SRR, netmasks(4) DX Za TV IIR—=VESRLTSZEE N,

TNENOY—EEDRY NT—0A4 0571 —R 2, vFaVTa—FT07
L—hZ2BEUHTET,

BEFw NT—=TDIR)NERRT D, RARYA T cipsoDFar4—F527
L—hEERLET, 77— FOERBIOE D S TIZOWTIE, TOrade
Solaris Trusted Extensions BEFLDOFNE] © R T AT v RRy NT—=TF—=FX—ZD
AR (TE¥E~ Y 7)) 2L TLE3 N,

txzonemgr A2 U 7 hERTL. BIDWHEKRT 4 ROZEREET,
Labeled Zone Manager T. T N)UF&E =2 D%y KT =0 A 25T x—AZEML
£9, WikKU 4 > RUT, V= IZHETHEREZRL. T 74V ML— NERE
LE9,

V=CBEREDRY T4 5T —REN—F—FBMLEDELTNSTAN
TV =L, ROFIEZTTLET,

a. WAV RO TY—VEFLELET.

# zoneadm -z zone-name halt

b. Labeled Zone Manager T. RDFIEEZRITLE T,
i V- EBIRULET.
ii. [AddNetwork] ZZEIRL X7,
i. Ry NT—OA2HT T —RICEREMTET,
iv. 1271 —RDIPT RLREANLET,
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{51l 4-5

v. ARV RDT, V-l EERELET.

# zonecfg -z zone-name info net

net: address: IP-address
physical: zone-network-interface
defrouter not specified

« WAV VEIDT, SNIFEY=2DRY bT—=0DT T )V bIb— bEERK
LETY,

# zonecfg -z zone-name

zonecfg:zone-name > select net address=IP-address

zonecfg:zone-name:net> set defrouter=router-address

zonecfg:zone-name:net> end

zonecfqg:zone-name > verify

zonecfg:zone-name > commit

zonecfg:zone-name > exit

#

A DWW TIL, zonecfg(IM) DY =2 7 )V RXR— & [System Administration
Guide: Oracle Solaris Containers-Resource Management and Oracle Solaris

Zones] @ [How to Configure the Zone| ZZML T 72X,

d SINIfFEY - xEEHLET,

# zoneadm -z zone-name boot

e. KV —>T. INIMFEY—VITHTRY DT —FD A NDRBEDBH S
EEMHRELUET,
# netstat -rn
BEEIEE T — T IVIMNERINET, INIMNE =2 D51 > F T —X
i, K —>ox > M ERRBRDET,

T7HI ML= b ZBIRRTBICE. V—2DIPT FLRZEZIRL, BIBRLET,

# zonecfg -z zone-name

zonecfq:zone-name > select net address=zone-IP-address
zonecfg:zone-name:net> remove net defrouter=zone-default-route
zonecfg:zone-name:net> info net
net:

address: zone-IP-address

physical: zone-network-interface

defrouter not specified

INIMFEY=2DT 7 IV BIL—bERET S

ZOBITIE, EHED Secret V) — > Z MBI OWELY T 1y MTREEEHEE L £

T Secret V=2 EDMD T T 4w 7iE, R — R TREIEESNEE

Mo BT Labeled Zone Manager & zonecfg AN > RZMH L. IL—F ¢ > 7
AT DI EZMRL £,
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http://docs.sun.com/doc/816-5166/zonecfg-1m?a=view
http://docs.sun.com/doc/817-1592/z.conf.start-29?a=view
http://docs.sun.com/doc/817-1592/z.conf.start-29?a=view
http://docs.sun.com/doc/817-1592/z.conf.start-29?a=view

FYRT—=0A0E T —RESNIVFEY =V (TEBML, =T 40T 5

FBIMHZIL, gfel & qfel: 0 NIREFEHAFRTHRNWI E2HERLET, 0%, 2DDF
NIFES =2 Dy E T EERL ET, gfelld. Secret/) — 1Zx L THRE SN
7’:{ »\/§7I_—Z"c‘@_c

Interface IP Address Netmask Default Router
qfel 192.168.2.22 255.255.255.0 192.168.2.2
gqfel:0 192.168.3.33 255.255.255.0 192.168.3.3

£9. EHHHFIL /etc/hostname.qfel 7 7 1 IVEVERL L. /etc/netmasks 7 7 1 )L Z ##
KL ET,

# touch /etc/hostname.qfel

# cat /etc/netmasks
## /etc/netmasks in global zone
192.168.2.0 255.255.255.0

RKIZ, Xy hT—=0 428 T2 —A%Zplumb L., 1 >¥ 7 x— AN down REETH %
LR LET,

# ifconfig gqfel plumb
# ifconfig -a

KIZ, Solaris EH > —)LV T, 1 DD T N)V Secret 2ROt F 2574 —F> 7
L—hZ2ERL, 12 T2—ADIPTY RLAZT T L—MIEODYBTET,

=2 ZEIELERT,

# zoneadm -z secret halt

txzonemgr A7 V) 7 ZEfT L. Labeled Zone Manager % [ & £ 7,

# /usr/sbin/txzonemgr

Labeled Zone Manager C. Secret*/— > Z##R L. [Add Network] %ERL
T Xy hT—=0425 72— A%ZEIRL T, Labeled Zone Manager Z[ U £7,

OAXRITT, V—=2DIPTY RLAZBEIRL, 20T 74 IV MIL—FEREL F
T, AN REKRTIT DI, —h2HRL TCHEELET,

# zonecfg -z secret
zonecfg: secret > select net address=192.168.6.22
zonecfg: secret:net> set defrouter=192.168.6.2
zonecfg: secret:net> end
zonecfg: secret > verify
zonecfg: secret > commit
zonecfg: secret > info net
net:
address: 192.168.6.22
physical: qgfel
defrouter: 192.168.6.2
zonecfg: secret > exit
#
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FYbT—=0A 2T —RESNIMFEY—V(TEBIML, V=T 425

92

1RO B

V= EEHLERT,

# zoneadm -z secret boot

KB — > DOPDUHRT 4 > RIT, N7y hOREZEEHRLET,

# netstat -rn
Routing Table: IPv4

Destination Gateway Flags Ref Use Interface
default 192.168.5.15 UG 1 2664 qfed
192.168.6.2 192.168.6.22 UG 1 240 qgfel
192.168.3.3 192.168.3.33 u 1 183 gfel:0

1 380 100

127.0.0.1 127.0.0.1 UH

SNIFEY =2 T EICR—LY—ER

v axERT S

ZOFMETIE, FITNIAfFE) =2 T, F—LP—EZAT—F > (nscd) Z{ERIHE
RTEET., ZOBRNYR—FT2REDZ &/ 2020 —2D TNV TH)

BT 2972y NT—=ZICEFEINTBY, TOT Ty hT—21213FD X))
AOMBE DR — LT —N=—0NHDFET,

E- ZORRRIT. Ml S N OS2 L E . FHE S N2 T, nscd
T K — > TOARETFEINET., BTNIE— 2 HND door 1d. D
V=2 R D nsed T—E IZERL £ 9,

K — > TA—=/NN—2—F =272 0 F9, root lTFZHEEI/z-> TlIWiTrEH
lo 85 XR—TD TMEEFEDITR)IAFEY — D ZRBIRET DD Fy hT—T 1 >
AT —AEBMT 5] DIEFEIZETLTWET,

O T, BERRY NT—T AFINERSINET, LDAP Zr—LT—E R
ELTHEAT - —I12E, &TNIUES—2ANDLDAP V7 71 7 > hMNEki%
LT AEENHDET, nscd T—FE2I1d, F—LH—EXDOBERZF v v 2l
BBXAAFTITN, TDOI—T 4 > T3 fTnER A,

LDAP ZfERA L TWBIFE., INIFEY =2 DPSLDAP Y —/N—~AD)L— ~EHEZEL
E—g—o

BINIFE) =2 DRI 4 > RTIT, ROAX Y REETLET,

zone-name # netstat -rn

Kigh*/ — > T Labeled Zone Manager # 281 L £

# /usr/sbin/txzonemgr
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3 [Configure per-zonenameservice] Z2ERL. [Tl 20U v o LET,

ZOF T aid, WY AT LARERRFC—EZTHEH I NS LD ICEKINTY
ESCIN

4 BYJ—2Dnscd—EXRE#ERLET,

Z#ZE LT, nscd(IM) BELWnscd.conf@) DX Za T I R—=J2BBLTLZS
(/So

5 VATAEBEEFLET.
6 U= I&IT M= bhEF—LY—ERF-EVERRBLET.

a. V—>aA Y — )l Tnscd Y—ERERRLET,

zone-name # sVCs -X name-service-cache
svc:/system/name-service-cache:default (name service cache)
State: online since October 10, 2010 10:10:10 AM PDT
See: nscd(1M)
See: /etc/svc/volatile/system-name-service-cache:default.log
Impact: None.

b. ¥7xy T = DI— bEHERLET.

zone-name # netstat -rn

7 V—VEBDODR—ALAT—ERT—EVEHIRTSHICIE, KBV - TROFIEER
TLEY,

a. LabeledZone Manager ZH& £ 9,

b. TUnconfigure per-zonenameservice] #2iRL. [TH# 20U v o LET,
ZOERIZED, TXRTOINIAEY) =2 Tnscd T—E DHIRSNET,

« YRATLEBEFLET,

Trusted Extensions CTODEE & 1 —H —D1ER

TTICEMERHNZHEAL TWAEE, EFaU7 s —EHEREZEMTEE

T BEIZFLZREL TWRNYA MIBWT, &EZERT 5 FIEIT Solaris OS D
Ba BT, Trusted Extensions R A1 > ZEM T 5720121, Trusted Extensions
TtFaUra —EBREREZBMNML, Solaris BEMI YV — IV ZHEHTHHEND D
£,

YA bFa)Ts—T, I—F—EKET AT > F2ERT 5720122 ADAR
DEIRGEE. HAY LMERT O T 7 AV EER L. HENTEID S TT, HEH5 8
ZFEMLET,
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http://docs.sun.com/doc/816-5166/nscd-1m?a=view
http://docs.sun.com/doc/816-5174/nscd.conf-4?a=view
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(=S

L]

FIFINtoTaT A
IWEDBEL W3 DD
F7oO7y A IVEERL
ECIN

I—Y—Z2EHTL-DOMMNT O T 7 1)L &R
LEY., chso7oryy )i, 2—9—25H
TE5T 74N NTOT7 71L& BHEIRENE L <
o TWET,

94 NR—TD THFHMEE IS 5 HE
MTO7 7 AN ElERT 2]

tFa T —EHER
B ZER L £ T

TFa VT —BEEOEEEZR D CF )T —F
MFREE/ER L £,

97 X— D [Trusted Extensions Tz
Fa T —EHHEREZERT
% |

I—H—=/XAT— FZ&H
ETERNVWS AT LEH
BHRENEERL £

AT NEHERBEEERL, BRI NZS AT A
BHEWANTOT7 7y AIVICEID Y TET,

9NR—=20 RN X7 LE
MERE Z2IERT S

ERRENCE S
A=Y —ZfERL£T.

BENT /2% ZEMMTED 1 NKRBERD
A—HP—ZfEkL X7

100 X—® [Trusted Extensions T
BEN T2 D A —H— & ERT 5

BB B DIEREEET
TELHTLEHALE
kR

SEIFERIFUATREZTAILET,

103 X— D [Trusted Extensions @
BEIDBERET 5 Z L 2GR T 5 |

A—H—=INT )&
J—za g A > TES
FHICLET,

—f1—P—=Nnr 1> TELLIITY -2 —E
AzBIn L £9.

104 R=2 D [2—=H =T NJUf
/-2l A TELLDITT
=y

v ERNMERET SEN TOT 7 AIVEERT D

BHEDEENTA bFa U T —EZFITRWERE,
~ TEBR BN LIRS A

M7 07 7 A EEEZERL £,
ZOFIETIE, 2 —Y—2EHT 220D OMEEZFF DM T O 7 7 A )L &fE

RLET, oo 07 71V 2L OBRENCEID S THHA.

LDAP U —N—IZT—4% Z&ET DI,

COFEEEKLET, Y1
ZNH O

21— —ZERk

UHERR T B 72D 2 DDZRENNHETT, —HDORENIL—P—ZERTEET
MW, EFaUT4—BUEZEOLTEIENTEERA, B - HDERENTE
Fa)T 4 —BEEEHOYTHZENTEETN, - —2/ERTEEHAL, =
NHEOTOT 7 AILOWTNNNEND Y TENZEET Solaris I >V —)L i
TATBE, HENCELTEYTET 4 =)V RETNERINET,

BB HIIC

A== =P —=IT/2 %D, root KEIX/ZIIEEFHERENT /2 DMENH D X

. ZOFIEZHIGET 555121F,. Solaris EH I >V —)L ZH U £7,

1 A—Y—BRICHEEEZ2T 74 MOEF 7O 74O -2 L E

ERP

a. prof attr 7 7 A JL% prof _attr.orig 77 A J)VICOAE—LZFET,
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b. prof attr 77 A IVE NS RTYv RIT 4 ¥ THEET,
# /usr/dt/bin/trusted_edit /etc/security/prof_attr

¢ 3DDENNTOT774)EeIE—L. AE—DEZAIZEELET,

System Administrator:::Can perform most non-security...
Custom System Administrator:::Can perform most non-security...

User Security:::Manage passwords. ..
Custom User Security:::Manage passwords...

User Management:::Manage users, groups, home...
Custom User Management:::Manage users, groups, home...

d ZEZREFLET,
e. EENRZMHRLET.

# grep “Custom /etc/security/prof_attr

Custom System Administrator:::Can perform most non-security...
Custom User Management:::Manage users, groups, home...

Custom User Security:::Manage passwords...

MR 707 y AV EAERTTICIE—FT2Z LT, AT L%EH LW Solaris

=27y 7L —RLELEZCHAEHFNENREINET., TIN5 OHEF 70
T 7 AITE” 20, T 74080707 7 AIIOAE—ZLHLZIEFH5N, ¥
OMSHBEDE LW IO 7 7y A IVEERT L0, MONEZIC<<AEDET,

Solaris BV —JLEEELET.

# /usr/sbin/smc &

Z D3 E 2 —% (this-host: Scope=Files, Policy=TSOL) VY —JLRy U R&EFR L&
j—o

[ RTLADHERKR] 22y o LT IA—Y—1 20Uy I LET,
NAT—=RZANTDHEIROENET,

BN RT—READLET,
MERR] 2570 ) v o LET,

ARG LAY —FFa T4 —4EFTOT7 7 M IINEEELET,
dI—Y—ZERTERVWEdIczo7ya 7y IV ZEZHEL£9,

a. ThRSAA—Y—tFa2UT4—1 Z5TNOV VI LET,
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96

b. RA1 470Uy o L. ROFIEERTLET.

i g1 YA BRMS. TManage Users and Roles] ERRA]ZHIRLE T,
ROI—H—T 7 > MERNERD £,

Audit Controls

Label and Clearance Range

Change Password

View Users and Roles

Modify Extended Security Attributes

i. MEROEE] #ERZ 201 VX MIEMLET,
« [T 20Uy L TEENREREFLET.

HRIYAA—Y—EBO77 AN EETBELET,
NAT—REZRETCERVWEIICZO7O07 7 1IIVZEHIBLET,

a. ThRSLA-Y-—FE| 25TNIV v I LET,
b. IRA[1 470 UvoL. ROFIEERTTLET.

i, T84 URMDRZO—)IN—% [A—H—TFAHO U~ ICRSYELE
ER

i. &8 UXRMMS. [Modify Extended Security Attributes| ERA]ZHIf& L
i—g—‘o
ROIL—H—7 7 > MHERNED £,

Manage Users and Roles
View Users and Roles

« EEEZREFLET,

WAL AT LAEBEBEN O 7 MV EZBELET,
I—H—FMETO7yIUE. 2070771707y 14V T, VA
T LERENNZAT— RERETERVEIICLET,

a. HRILADRTLEEZE] 25TIN0 Vv I LET,
b. T#BENMERI 7% vo L. ROFIEZERTLET,
. 1I—Y—EEENTO7 7 AILEHIRLET,
i. MR LDA—Y—EBEFNTOT77MILEBMLET,
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RDFIE

1R DI

iii. 1A ALADA—Y—BEBEFTOT7 74L&, TRXTOEN 7O 74)LD LT
BEHLET.

« BEEEREFELET.

FIFINOTOT 7 AR EINEZNWEDICTDITE. hAYLATOT 7 1)L
WL TEBDEENEIND 2R LZHE, 103 X—T D [Trusted
Extensions DX EINHERET 5 Z L 2R T 5 OFNE7 #SRLTLEI N,

Trusted Extensions Ttz 21 U7 1« —EEARE %
ERR T %

Trusted Extensions TD&ENVERKIL. Solaris OS TOXKENER LU TY ., 7272

L. Trusted Extensions Tl&, ¥ U T ¢ —EHEFRENIHATT, O—HILot
FaUT o —EHHERBEERT ST, fla6eDXDIca~x > RMr1 2%
Tr—AZFHTHIEHTEET,

A—=/N—=L =P —IT/2 %, root EEIK/IZEEMEREN/RLZ2MBENH D XY,

o =2 BB ZERT 21213, 132 X—2 D [LDAP D729 D Solaris B i 1
)=V DRRE EES Y 7)) BT L TBBERDDFET,

Solaris BV —)LEREELET.

# /usr/sbin/smc &
WEEY—IVRy O REEIRLET,

= O—A)IZERBNZ1ERT DG, 20O E a1—7% (this-host:Scope=Files,
Policy=TsoL)] ZEAL T,

= LDAP Y —EXRICEEIZERKT D56, 2032 E1—% (Idap-server:
Scope=LDAP, Policy=TSOL)] Z{FEBRLFT.

[P RTLDER] 20Uy o LT A—Y—] 20Uy I LET,
NAT—=RZANTHEIRDENET,

BUENRT—REANDLET,

MR 25 7)oy o LET,

(70232 A*Za—bhb EEFRENEZEM ZRIRLUET,
tFaUT 1 —EBERINEERLET,
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ROGHEBZZBITLTLIZEI N,

n  [1&E4 ] - secadmin

n REDIERX 4] - security Administrator

s EEW] -1 beFaUr e —HYSE (2 I3 EBRE AT L),

w [REIOIDEFS] -2100

s (RES o)) -EHEDBourne (707 v 1)L x)l)

. (BEA—Y T ZNEER] -Fov 7Ry 7 AZRIREINZFFICLTH
SN

m  [Passwordand confirm| -6 XFL DT FD/S AT — RE2E DB TET,
tFa) T —EHERINONZAT—RZ2ECHETEZITNTO/NAT — RidHE
HEnc< ks iclzididz o 8. NAT—RNHERISN T, EE0H
5, KBINTWRWT V- ZANTONSEHEEZMS LET,

F-ITNRTOEHRKRECHLT, 7hHY > hE®EITEDICL, NAT— RE3IH
RZBELENWTLIEE N,

MR - Bt Fa VT — 2P —tFa2UT7 10—

» YA hEFaUT 0 —TEBDHENAERGAIL, ERtFaY 70 —HRT
O77AINVET TN MOI—F—Fa T —MHHNTOT7 7L ERIRL
i?c

s YA hEFa VT —TEEDEENLERIGEE., Bl T 0 —HR T
O77AIVENAY LAI—Y—tFa )T —ENTOT7 7 ILVERINL X
7,

»  [R—LF 4 L 2”7 MUY —)N—] —home-directory-server

» [R—LFT 4L 2”7 NUIA] -/mount-path

w [ ZOFENCI—T—2EDYTEd | -HHE21—TF—ICHDHETEHE, 20O

74 =)V RIZHEINIC AT NET,

REEER LIS, RENELWZ EEZHFRELET,
HENZBEIRL Y7 7 LET,

KDT 4 =)V RNOEZHERLET,

s (BRI =T BRI —TEEmLET,
»  [Trusted Extensions J&| - 7 7 4 )L RDNIELWTT,

HB—IRNINDIATALATINNEERLTERSBWESIE. T9)L: ZaR/FE
For) T JEFR) ZBIRL TL<7Z3 W,

w BRANEE Y S AMGERE Y T A ) -HBOEE T T J /N audit_control 7 7 A
WD AT LABREIIHT BN THLEEDH, BEET IV EZRELET,
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1RO BHIIZ

ZTDMDFRENZEFERTDICIE. EFa )T —BEEERENZSECLET,

#ill%. TSystem Administration Guide: Security Services] @ [How to Create and Assign a
Roleby Usingthe GUI) ZZHL T2 W, FEENC-EDID ZfHEL. TO%E
ICIELWHER 707 7 1V Z2EIDETEY ., ATRREENL, ROLBDTT,

= admin & & - System Administrator D 5HEF

=  primaryadmin ZE| — Primary Administrator OfFSHER]
= oper % - operator D} GHEF]

A—AIDOtFa) T4 —EBERINZEZERTH/=HD roleadd AT
> RDOER

ZOHITIE, root I—H —7roleadd AN RZFHL T, tF 570 —EMHE
FBEZO—H)IV T AT LZEIMLUET, FFMIE. roleadd(IM) DY Za VI R—T %
SRLTLZI 0, HEOERDHNIZ, root T—HY—3E 12 2R LET. 2D
B4 T, =Y —ZERTD=DICEHBHEIIAETT,

# roleadd -c "Local Security Administrator" -d /export/homel \

-u 110 -P "Information Security,User Security" -K lock_after_retries=no \
-K idletime=5 -K idlecmd=lock -K labelview=showsl \

-K min_label=ADMIN_LOW -K clearance=ADMIN_HIGH secadmin

root T—H—Id, REQOHPNAT—R2HHELXT.

# passwd -r files secadmin

New Password: <Type password>

Re-enter new Password: <Retype password>
passwd: password successfully changed for secadmin
#

BEZO—H)V - —ICEDHTSITE, #la-7 2B R T LES N,

FIRENIZ AT LAERBERINZERT S
EHHMNT A M2 ) T —EETRVEAR, COFIEE AL ET.
COFMETIE, &0 HBOHLWHERT 07 71 L% S A5 NERELEIZHE D X
TE .

A/ ZTR BN root RIS EEEREIC 75 B REN B 0 £

U= BB ERT2HEMTO7 7 AV ElERT %) 28T L THE
T HRZ7 0T 7 A IVEIERT 2720 ER LD ERICY =Ry 7 A &R L
x£9,
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http://docs.sun.com/doc/816-4557/rbactask-32?a=view
http://docs.sun.com/doc/816-4557/rbactask-32?a=view
http://docs.sun.com/doc/816-5166/roleadd-1m?a=view
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B BRI

100

Solaris B Y =)L T, PATALAEEERIEZFERLET.

R, 97 XR—2 D [Trusted Extensions CF 2 7 ¢ —EHEXRE|Z1ERT
5] #ZRLTLZIN,

WA LA RTAEBREEN 7O7 7 A ERBNCBUHTET,
EEEZFRELET,

Solaris B Y —J)LEHLCE T,

gr_usted Extensions C1&E|([C/aNd1—H —Z1ER
%)

O—H) A=Y —2ERT 5121d. ROFIEDORDOIZ, fla-7DLSicav R
A T —ABERT R EHTEFET, YT hOEF2UFT 4 —RYS—T
FaEnsias. 1 NTEROEHEE NS IO RI—TF—2IERTZIEDHT
=¥£7,

¥ T —RESNZI—T—AERZIT DT, AT LZEHEREIN
A=Y —2ERL., Fa VT —EHERENNNAT—RelotFal
T4 —BEOEEZE D ETET,

A== =P —IZ/2%7, root &, ¥V T —EHEEE, XLFEER
BRENTRDMBEN DD XY, tFa U7 —EFHEEENITE, T—F—1ERIC®
LI EARRDMERR D D £

Solaris HHE O >V —)VINEIRENFE T, M. 97 R—2 D [Trusted Extensions T
tFa) T —EHEREEERT D) 2BRBLTIEIN,

Solaris EE Y —J)L T, TA—Y—TFhoo bl 25TV oUv o LET,

(Toar) Ama—po IA—Y—ZEBM] > (DY —FEER] £:2R0L
ij—o

FE-HEBIOI—TF—-0A4RTEIDIE. R T—=ILTIZEn £9., BINT 3
I——ICHEOARIPID ZEHLZNWTL 23N,

FUSAUNIVTITRVET,
ISystem Administration Guide: Basic Administration] @ [How to Add a User With the
Solaris Management Console’s Users Tool] DFNEIZHED TEHTEEXT,
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http://docs.sun.com/doc/817-1985/usersetup-21?a=view
http://docs.sun.com/doc/817-1985/usersetup-21?a=view
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I-P—EERLED. ERLELI—Y—E5 TN Uy LTRELEELE
7.

F-HENC NS LY -1 =T 7 2 MIFEITECL., INAT— RE%h
FRZ2E LW TLZE 1,

KROT 4 —IVERNELLSBRESNTNWBE I E2HERLET,
= TEHA) - 2 ZICIIEEmREA I LEE A
[Password and confirm] -6 XFLL EOFEEFD/INAT — RZ2E DY TET,

FE-UIEE T — AR S U< WA T — REZBIRLUARTHTARD £
o NMAT =PRI ENT, BEEOHD, KRINTWRERWT 7 AN TTHON
LIEBRIEZRS LET,

(7 HD > SOERIES) ] - EITENTY .

[Trusted Extensions J&1] -7 7 # )V RINIELWTT,
H—IN)DIATLTININERRLTUIRSBWERIT. )L FoR/FE
For) T MEFRIR) ZBIRL T ZI 0,

;77‘37‘/ NOER L] -7 A RIVEFEBIOXTA RV TV a o EBRELE
;Yﬁﬁthﬂvﬁj—&%Kﬁﬂél~ﬁ—tﬂbfmeij%%ﬁbi

Solaris B OV —I)LEHLCET,
A—YHY-—DIREBEEZHAIIAALET,

a. BISFRADEIUHT
A hOEFaFT =R —2MHERL TG, BSRAHENTOT7 v 1L %
BHOIL—T = 5TEEXT, 207077 IZE> T, I—HF—EFNA
ADEND YT, PostScript 7 7 A IVOHI, Z~)L7s L OHEI, ERENS o817 A
BRIV ATLADY vy YU EITAET, 07 7 A IIVEERT BT
1%, [Oracle Solaris Trusted Extensions B FEDFNEI] O [EF] /2 EKZRD 7= DHER]
TOT7 7 AINEERT S 2BRLTIZI N,

b. A—Y—HERE T 7 AN EHRITAXLET,

FOracle Solaris Trusted Extensions & ¥ D FJE] D557 F [Trusted Extensions T®D
I—H—, R, HEOEHE (FIE)) 22RBLTIZI N,
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http://docs.sun.com/doc/819-7611
http://docs.sun.com/doc/819-7611
http://docs.sun.com/doc/819-7611
http://docs.sun.com/doc/819-7611
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5 4-7

FOracle Solaris Trusted Extensions & LD FJE] D [Solaris EFE > — )L TD
I—Y—EHEROEE EE~Yy 7)) BBRLTIZI N,

¢ RIFINNDIAE—BLIUY 0774 IVDIERK
JINWNFIRNTATLT, EPOI)VCaE—%7/13Y > 7§25 2—5—4iH]
774NV EVZRTDT 7ML T, I—PF—BIOEEEZRETEE
9, #FMX. TOracle Solaris Trusted Extensions B EEDFNEI D [.copy_files 7 7 1
JV & link_files 7 7 1)V | 2L T ZI W0,

A—ANA—Y =% T 57D useradd A< > ROEMR

ZOHITIE, root T—H—IN, tFa U7 —EFHERECENHO0—-H)
I—Y—2ERLET ., ML, useradd(1M) B L W atohexlabel(IM) DY =27 )b
R=VZHZRL TN,

BANC, root I—H—id, I—H—0&K FLI7N)VBRIOGEA LR T )LD 16 E X
X ZMHRL £

# atohexlabel public

0x0002-08-08

# atohexlabel -c "confidential restricted"
0x0004-08-78

RIZ, root I—H—iFX 12 2R L THh5, I—F—Z/ERL X,

# useradd -c "Local user for Security Admin" -d /export/homel \
-K idletime=10 -K idlecmd=logout -K lock_after_retries=no
-K min_label=0x0002-08-08 -K clearance=0x0004-08-78 -K labelview=showsl jandoe

root T—HY—I3WH/X AT —R&2fEELFT,

# passwd -r files jandoe
New Password: <Type password>

Re-enter new Password: <Retype password>
passwd: password successfully changed for jandoe
#

BRZIZ, root I—H—I%, Fa U7 —EHEREZI-S—OERITEML £
9, ENL, 97 XR— @D [Trusted Extensions TF 2 U 7 4 —EHEZRE Z/ERT
%] THERESNELE,

# usermod -R secadmin jandoe
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Trusted Extensions TOD&E| & 1 —H —DIERK

1RO BHIIZ

Trusted Extensions DX 2 /)SHEgE T 5 Z & 2SR T
%

BRENZHERT DI, TORENTZDET, TORENDBNETTELI AV &
FITLET,

DNS F/- 13RI EZHR L Th2HEEIE, BEZERLZSHEHL, T0HE
TEZFDHENNEEET D Z L 2R L T 7ZE W,

‘®E LI, FORECANDI-Y =L LTATALET,

RSRTY RNXRAAZ2—%#HEFT,

= Trusted(DE TV — U AXR—X XA v FllgEs ) v I LET,
Trusted Path Menu
Assume root Role
Assume admin Role
Change Password
Allocate Device
Query Window Label
Suspend System...
Help

AZa—NH5&RENTIED X,

= Trusted)DST. FSRATY RRAMNSATADI—Y—-2E0 v LET,
ROMTATY RARNTA THNTIE, I—PF—%413 tester TT,

[ Trusted 1> tester
B T e e S e e e
B[O ST 5N BEO— S, EEERRLET,

BEIDT—H AR—AT, Solaris BBV —JLEEEFHLET,
$ /usr/sbin/smc &

TANTBREDEVGEEZERLE T,

[ RTLDERI 20y o LT, A—Y—] CBEFLET.
AT —REANTHLIRDENET,

a. REDNRAT—KREANDLET,
b. IA—Y—7hO bl Z25TN0) v LET,
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6

7

A-Y—%&0Uvy I LET,

AT LNEMEEETIE, THEA . TR"—LT4L2ZKJ) ., B TY
W—T) OFTOE T4 —I)VREEETEET,

BB E R 5720 D% EERLIZGE. AT LAEHEERENT
I—Y—DHHINAT—REHRETETER A,

tFxaUTF o —EHEREITIE., ITRTCODYTOET =)V RELEETEEXT,

HHE DR 5720 DREN 2R LIZHEEG, tFa) 7 —EHERENL
A—Y—ZERTEEE A,

FEHERETIE, ITRTOYTOE T4 — IV RELEETEET,

(BEEATRE) BN B2 RIET D158, T 74/ NOERTO 7 7 A IILDMEDLNZ L
SICLET,

F-SATABRHLWN—3 2D SolarisOSIZ T v L — KR35 &, P ATLAE
HE, I—Y—FH, 1Y —tFaUT4—DF7H)IV 70T 71 IVINESZH
AHNET,

FIAFY RIT 4 F T ROWTNADOFNEZFETLET,

3DDIEFTOT 7 A% prof attr 7 7 A ILISHEIBRLE T,

HiFRICK D, HHENINSOTOT v A IV ESRELITE 0L TTERLRD
£, £z, prof attr.orig 7 7 TV HHIPRL £,

prof attr 77 A I)LD3DDIEFTOT7 7 A ILEAA T O MLET,

MR 707y AIIVEIXARTURNTBHIECED, 20707 v IUN
Solaris E¥E I > — )l TERINABL AR, I—Y—2EFHIT a7 RTHEH
TEh<R0FET, 7077 1IVEZONRIZ. 5IEHE prof attr 7 7 1 IV T
ZRTEET,

prof attr 7 7 A JL T, 3DDEF TOT7 7 A IVICBIDEREBBEA N LET,

prof attr 7 7 1 IVEMREL. INSOHMTOT 7 A I)VOFHHT 1 —)L REE
BLEI, =2&x13, FiZ Do not use this profile] CEEMAET, D
AHEICKD, BEHEFICZOTO Ty EFHALENIOZBELETN, o
Ty A IINOFERFREIEESNET A,

A—Y=DDBINIfFEY—=2ICOI7A4 2 TEDL
295

KA MPNEESIINDSE, TN AEEBOARN L —J L OBEMITOHERESN
2T D £H8 A,
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1RO BHIIZ

Pz EB1DDINIAFE =2 PERENTWET., TV —dro—2 %
TERRH Tl H D £H A

DARTLAEBEFHLET,
root I—HY—&LTCAZALET,
V- Y —EXREBEHFHLET.

# svcs zones
STATE STIME FMRI
offline - svc:/system/zones:default

# svcadm restart svc:/system/zones:default

A7 RLET,
INT, —~M1—v—rnrs4>TEETd, 2Oy a rEINEY—-2T
ER

Trusted Extensions CTOR— AT 4 Lo MU DYERK

1B BRI

1

Trusted Extensions Tld, T—H—id, IT—F—IMEETEHTXRTOIXRN)LTHE—LA
TALYZ NI T VAT EHENHDET, TRXTOF—LTA L7 )%
I—H—IZHEHTEEICT 2I2E, IV FLRXIVDE—LT 4 L7 U —/)N—%{E
L. ZOHY—N—ETA—=r"IYT 5 EFETL, "—LT4 LV NIEII A
R—=RhTBDHENHODET, V77147 > A RTIE, - —-TLITTXRTOD
=2 DR—=LTA VLT N ERBTDHAIY T RNEETLED, "—LT4 LY
M) —N=ll2—Y—Or 1> LD TEET,

Trusted Extensions C/k— AT 4 Lo KV
H—N—%1ERT 5
A SN P A B AN root (HEIE 7o 1R EE I E T 2 B T B D £

Trusted Extensions V 7 b D = 7 &ERAL T, m"—LT 4 LI I —N—%24 X

F—=JLLUTHRLET,

w =D O0—2EERTBEE, BOKR—LT 4 L 27 NUMNB D Solaris ZFS A
Fy T ay hELTHHALTIEI N,

n IO 2 TELZIXNTOINIINDE—LT 4 L7 NUNKBERD
T, A—Y—Nar A > TEHIXRTO—22ERLET, 2213 T
7 %)l N D label encodings 7 7 1 V&M T 5858, PUBLIC TNILDY — > &
L £9°,
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SolarisZFS T3/ < UFSZ{EHA T D154, NFSH—N—D"BEBO#EEZR/~-T LS (C
LET.

a. K/ —>T. nsswitch.conf 7 7 A )LD automount T FUZZELET,

NS AT RITT 4 ¥ %> T /etc/nsswitch.conf 7 7 T IV EREL T, FlE
IZDWTIE. [Oracle Solaris Trusted Extensions & ¥ D F/lE] @ [Trusted Extensions
DEH T 7 MV EHRET D] 2ZBLTLIZEI N,

automount: files
b. KiZY —>Tautomount AV RERITLET.
IN)fFEY =T &IZ.  [Oracle Solaris Trusted Extensions EE D FIE] D TS X)L
FE—2TT77M4IVENSTY D R T D] ODBEIYD Y bFIBICEWET., TOD
Hh&E COFIBEICRYET,
R—=LT A LI MUDPERENTNS ZLEMRALET.
a. "R—AT 4L MIYG—N=—D5605T7TRLET,
b. —f1—4H¥—-&ULTHR—ALTA LI MY —N—ICAOTA 2 LET,
¢« A4 —2ThHREREET,

d RV 4 2RO T, A—HY—DIR—ALAT A LI MNIDBFEEST D LERELE
ER

e A—YP—PHEETEDIRTDY—V LTI AR—REHEHLET.

f. FY—VTHRD 4 RDZERE - —DR—LTA LI NIDEESTSZ
LEHRLET.

R—ALT 4L MUY —N=Dp60O070LET,

Trusted Extensions C1—H —MR—AT 4 L&
JICT7OEBATEDLEDICTS

BT Z R — AT 4 L2 ) H—N—le 071 > LT, 20D 25 A
EHETELZR—LT AL FPUBERLET., IXRTOIRIVTEHR—LTA LY

N ZERT BICE. 12— =3I XRTOIRINTHR—LT 4 L7 MU
Y= N\N—l2OV A1 > FTHDHERDHDET,
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Trusted Extensions TDR— AT 1 L& b U DIERK

HHNT, BEEZL. 1Y -Byicas 1 o35, F1—TF—DK—A>
AT NI —AT A4 LT UDR T hiRA > b E2ERTDAZ Y T R2ERL T

B

EBTEET, ZOAZUT NI, =T —IMEETEZELTXRTOINILT

R ERA D FEERLET,

1A BH1IZ  Trusted Extensions R A1 > DHR—AT 4 L7 BB —N—0WlRaEnE L=,

& Y—N—ADEEOTAVEHATEIN RVUTMERTIENEHERLET.

s A—HY—DPR—AT A LI MUY —N—[CEEOSA > TEEHLOICLET,

a.

EA—Y—Z. k=—LT4 LI MNIY—N—-ICOTAFTBELDITIERLE
ERS
EEcOrZ A > TER1I——3, a7 L TLEE,

Z£1—H—(C, BUOSA LT, SERERDZO74 IR ERRT DL
SCHERLET,

I—HF—d, FRIVENY—2HHLTRRZO7( 2TV EBRL
T, ERicOVA > TEREI—Y -3, oV 7T LT3N,

FERATEDIRTOINNLICHLTATA > TOEREHFEURT LD, &
aA—H—([HERLET,

BEDID—ORT—arpb0d4 09585, A—H—ITERLET,
A—F—=DF T I F TNV DKR—=LT 4 L7 MU DMEHAJEET

T, I—F =Dty aOIN)NELETIN, BT )TI—T A
R—ZEBINTBE, FOTRI)NDI—F—DHR—ALT 4 L7 NIRRT K~
ENET,

» IRTDA—Y—=DR—LT A LI MDY bRA D MEFRT DI2DDRY
U7 bEERL. TORIVT RERTLET,

#1/bin/sh

#

for zoneroot in ‘/usr/sbin/zoneadm list -p | cut -d ":" -f4° ; do
if [ $zoneroot !'= / ]; then

prefix=$zoneroot/root/export

for j in ‘getent passwd|tr ' ' ‘; do
uid=‘echo $j|cut -d ":" -f3f
if [ $uid -ge 100 1; then
gid=‘echo $j|cut -d ":" -f4
homedir=‘echo $j|cut -d ":" -f6
mkdir -m 711 -p $prefix$homedir
chown $uid:$gid $prefix$homedir
fi
done

« Trusted Extensions D&%, (FIE) 107



BEDRSZATY By b= ADI—H—EARR SDEM

fi
done

a. KV -6 NFSH—N—TRIUTERFTLET,

b. RIZ, A—HY—DPATA VT EIRTDOYIFULURIVTFRI by TTROUT
FERITTLUET.

BEOLZRATY Ry bT—=0ADI—Y—LRX b

D

108

1B 710

v
RO BHIIC

1

NISYY T TEHERINTNAI—HF—BNAEEE, FO1—HF—%%vy NT—7I78
ncE£E7,
FARBIRTRZERA MGEMT 21213, ROFEESIRL T Z3 0,

s RABNZBINTSIZIE, Solaris B>V —I)lD TA>Ea—%&E%vy b
TJ—21 =)ty hZEM@EHALET., 7ML,  [Oracle Solaris Trusted Extensions
EMOFIE) © T2 AT LOBAIDOF Yy NT—JIZKRA NEEBINT S 2581
TLEE W,

KA BZLDAP H—N—IZEMNTSEEITIE,. TORANMIEETSINTOIP
7 RLVAZBIMLET, FTNIAMNES—2DT7 RLAZEDTXRTOS—2DT
R L A% LDAP H—/NN—iZEmLadidan £8 A.

n RABMITININEMTBI21E. TOracle Solaris Trusted Extensions & ¥E D F
iEy & T2Fa2U74—FT>T L= E2RANERITIFA NI —TITEID Y
T3] Z2RLTLEEIN,

LDAP H—/N—[ZNIS1—H—%#E8MT 3
A—)N—A—H =250, root BENF/IZEEHEREN D20 ENH D FT,
NIST—FR—ANE, HERERENELET.,

a. aliases T—IR—XDIA—HY—DI >V rUDST7AILEERLET,

% ypcat -k aliases | grep login-name > aliases.name

b. passwd T —FZN—RDA—HY—DI U MUDPST7AIVEERLET,

% ypcat -k passwd | grep "Full Name" > passwd.name

¢. auto home T—HNR—ADIA—HYF—DI  IDPST7AILEERLET.

% ypcat -k auto_home | grep login-name > auto_home_label
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BEOD RS RATYy bRy b7 =0 ADI—H—LKRX bDIEM

5] 4-8

LDAP & U Trusted Extensions DIFHRDE X BERELE T,

a. sed AV REMFEAL Taliases T M DOEREZBHRELET,

°

% sed 's/ /:/g9’ aliases.login-name > aliases

b. nawk AX > RZFER L Tpasswd T P DEREZBHRELET,

% nawk -F: "{print $1":x:"$3":"$4":"$5":"$6":"$7}’ passwd.name > passwd

¢ nawk AX Y RAEERAL TshadowT > MU ZEERLET,

% nawk -F: "{print $1":"$2":6445::::::"}’ passwd.name > shadow
d. nawk Y RZFEBL Tuser attr T MU ZEERLET.
% nawk -F: '{print $1"::::lock after_ retries=yes-or-no;profiles=user-profile, ...;

labelview=int-or-ext,show-or-hide;min_label=min-label;
clearance=max-label; type=normal; roles=role-name,...;
auths=auth-name,..."}’ passwd.name > user attr

TELIET7AINEIDAP Y —N—D /tmpT 4 Lo MYICOE—-LET,

# cp aliases auto home internal passwd shadow user attr /tmp/name

FIE3IDT77AIDIT MY ZELDAP Y —N—DFT—FX—X(ZEBMLET.,

# /usr/sbin/ldapaddent -D "cn=directory manager" -w DM-password \
-a simple -f /tmp/name/aliases aliases

# /usr/sbin/ldapaddent -D "cn=directory manager" -w DM-password \
-a simple -f /tmp/name/auto _home internal auto home internal

# /usr/sbin/ldapaddent -D "cn=directory manager" -w DM-password \
-a simple -f /tmp/name/passwd passwd

# /usr/sbin/ldapaddent -D "cn=directory manager" -w DM-password \
-a simple -f /tmp/name/shadow shadow

# /usr/sbin/ldapaddent -D "cn=directory manager" -w DM-password \
-a simple -f /tmp/name/user_attr user attr

NIST—4& RX—R/M5 LDAP H—/N\—AD1—H — DB

ROBFITIE, EHEHENH L WIL—F -2 T 2Ty Ry NT—=ZITEMLU £

T, I—F—DFEMIL. Hfl. NIST—F X—ZUTHEM TN TWET, LDAP
H—N—=NAT— RE2{ZETH=0,. FHEITY—/N— LT ldapaddent A< > R %
EITLET,

Trusted Extensions C. H L WIL—HF—IZFNA A Z2E DY THENTE, AR
L= &ZENENET, 201 —3&ENTZNSDT, TOI—F—=ThT >
MIow 7o hEInERL, =P =D ML T N)VIEPUBLIC TY, I—H—N
EZET % T ~N)VIT INTERNAL 72D T, jan N auto _home internal 7—4 N— ZIZ3E
INET, auto home internal T—% N— A3, jan DFAID /EZIART U7t AHE
DHBE—LT ALY MR > MLET,

m LDAP Y —/NN—T, HFHFIINIS T —FIXR—=ZANS5I—F—IEREWMOHL F
@_‘0
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# ypcat -k aliases | grep jan.doe > aliases.jan
# ypcat passwd | grep "Jan Doe" > passwd.jan
# ypcat -k auto_home | grep jan.doe > auto_home_internal

s RIZ. BHEEZIZIDAPOTL N OERZHEELXEI,

# sed ’'s/ /:/g’ aliases.jan > aliases
# nawk -F: '{print $1":x:"$3":"$4":"$5":"$6":"$7}’ passwd.jan > passwd

# nawk -F: '{print $1":"$2":6445::::::"}’ passwd.jan > shadow
= CRIZ, BT Trusted Extensions D user attr T MU Z/ERR L £77,
# nawk -F: '{print $1"::::lock_after_retries=no;profiles=Media User;

labelview=internal, showsl;min_label=0x0002-08-08;
clearance=0x0004-08-78; type=normal; roles=oper;
auths=solaris.device.allocate"}’ passwd.jan > user_attr

» RIS, BEEFLT 7 AIVE /top/jan T4 L7 BUICOE—L £,

# cp aliases auto_home_internal passwd shadow user_attr /tmp/jan

s B, BHEHEZEIL /tap/jan T A LT FUDT 7 A IV ES—N—ICHDAAET,

# /usr/sbin/ldapaddent -D "cn=directory manager" -w a2b3c4d5e6 \
-a simple -f /tmp/jan/aliases aliases

# /usr/sbin/ldapaddent -D "cn=directory manager" -w a2b3c4d5e6 \
-a simple -f /tmp/jan/auto_home_internal auto_home_internal

# /usr/sbin/ldapaddent -D "cn=directory manager" -w a2b3c4d5e6 \
-a simple -f /tmp/jan/passwd passwd

# /usr/sbin/ldapaddent -D "cn=directory manager" -w a2b3c4d5e6 \
-a simple -f /tmp/jan/shadow shadow

# /usr/sbin/ldapaddent -D “cn=directory manager" -w a2b3c4d5e6 \
-a simple -f /tmp/jan/user_attr user_attr

Trusted Extensions DERXKD > 7)o a—FT4 4

Trusted Extensions Tl T X)UFE ) — 20V KEY — 2 &2 > TX Y —/N—LEE
LET, LERST, IS — E R — > ~OF T EE/R )L — K 2N
WTd, F/=. Solaris D1 > A M—)LHIZEIR L /=4 7> 3 2k > TIE, Trusted
Extensions XK — > ADA > 72— A A TERL D ]REERH D 7,

Trusted Extensions DB 31L& [Z netservices
limited WEITI N/

At B
I —H—{3. Trusted Extensions DA LRI netservices limited X > R Z&fT
TREELIAZ, AMERICZOOT S REREY —>THEITLE L. TDK&
B, TN E = IR — > NOX = N—ICHEHRTE £ A,

[E]38E 5 ik
KDY > R%EFFL T, Trusted Extensions 7N/ — > I TlE T 2 7= DI E/R
HY—EXEFREET,
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# svccfg -s x1l-server setprop options/tcp_listen = true
# svcadm enable svc:/network/rpc/rstat:default

SN)IftEY—Tcaryy =)o RODED
A A

BILGE
TR E =2 TaAI)=I T4 RIEHISETSHE, ROEDET
T—=MMEY AT AT IRy 7 ACERINET,

Action:DttermConsole,*,*,*,0 [Error]
Action not authorized.

[F 0 7 1
KD 21FI8, Jetc/security/exec attr 7 7 ANV DE —> LT NIICERET ST
MR LET,
ALl Actions:solaris:act:::*;*;*;*x; *;
All:solaris:act::*;*;*;*;*;
INEDITINEELBWEEIE, INHsDI > MU BN L 7z Trusted Extensions
N T —=PIMT NI E =N VA R—IhanTWERL, ZOHEFIE. T
NIFE =220 —EERL T EZIWN, FEIIDODWTIE, 68 X—2D [
NIVFEY — 2 DOER 22 T3 N,

FNIWFE = PXY—N—=([CT IV ERTEL
(A
A B:
TR ET =N X T —=N=IZT7 7 ATERWEEIE, ROLSH7%
A= NERINET,
m  Action failed. Reconnect to Solaris Zone?

= No route available
®  Cannot reach globalzone-hostname:0

JRA:
TN E = IMX Y= N=IZT VEATERVWHEHEL TRODDNEZS

NEd,
=PI N TWARWED, sysidcfg TOEADTE T ZFFHEL T

%)0
n IR ES =2 DIRA NN, K — 2 TERITH O R — LY —E I8
IS AVANAN
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112

[

all-zones EL TIHRESINTWSBA ¥ 7 2 — AW,
TN ES =2 Dy KT =D A 2F T2 =AM T2 LTS,
LDAP % DR NKRLT %,

NFS ¥ > b3 BRE L 720,

(1A T DFE:

ROFIMEZETLTIZE N,

1.

J—icarZA4 > LET,
zlogin AX > REZF IV —2mAka>V—)b) 77 a ezl TEEd,

# zlogin -z zone-name

A—/)N—2—HY =L Tar A > TERWEEIL. zlogin -5 I~¥ > RZ{HH
L'Cuhuﬁ%?éﬂlﬁb'(< f;é(/)

V= MMETHRTH D EEERLET,

# zoneadm list

V= 2 DIREEN running THIUL, Dl Lb1DO07 Ot AN — 2 TET
INTVET,

SR ET = WX —N—IT VAT LDEGEL TVWHTXNTORE
R L ET,

m sysidefg 7O RAZRETTHIEICK>TY—220HLL £7,

sysidcfg 7OV T L ERMEEXTEITLET, V—mRa V=), £z
13 zlogin AX 2 REETLEWMAY 4 > RUTTOC T MIEZAET,

sysidcfg 7 O A 2 JEREEICETT HIT1E. ROWTNNDHIEND D

£9,

= /usr/sbin/txzonemgr A%~ VU 7 NMIH LU THIHILIEH Z25E L £7,
AIHAEIERICE D, sysidcfg DEMICT 74 )V MEZ AN TESD LD
2D ET,

s HOsysidefg A7 U T hEREABRLET,

AN, sysidcfg(4) DY Za T INR—=IVZZRL T LI N,
s IS XP N T VA TED LR ET,

FAE =z 74 2 LET, DISPLAY ZRUN X H—/N—Z& R A1 > b
THEIITHREL, Ua P RUZRHEEXT,
# DISPLAY=global-zone-hostname:n.n

# export DISPLAY
# /usr/openwin/bin/xclock
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Trusted Extensions DD NS TI)vra—FT 4 4

TN ET 4 2 RUMERSNBVWEEIL, ZOTR)UAFE — 1Tk
LTV =%y b= NEYNTHER SN TWEE A

¥ - Solaris 10 5/09 LABED U V) — A D Trusted CDE 2 FEfT L TW A AL, 167
R—=T® [Trusted CDE TO— )L — 2 &K — 2 I)V—F 1 > 71T fRHk
T %] ZBRLTIEZEIN,

» R—LAY—ERZMS>TY—2DHRAMEMKRLET,

VJ—>DO—7)l jetcshosts 7 7 AIVIEMERA L R A, RODIZ, FAZD
A KIE — > £-IE LDAP H— N— I EETALENH D ET, ZD
IBEERICIL, V= CEHD Y TOENZHRARNGDIP Y RLAZEDDNEMN
H0FET,

" all-zones ELTHREINTWVWDSA Y T 2 — AN,

FTRTOY =R =2 LY T2y b EDIPTY RL ANHD5E
ZFRE. all-zones FEB) 1 2 T2 —AEMRTHVEOH HL5E5MNH D
F9, ZOLIITHERTHZEITES T, INIE =203 K — >
DX =N—IZEHRTELHLOITRDET, R/ —>DXHT—/N—~D
UE— MERZHIBET 51213, vnio Z all-zones 7 RL A E L THEAL F
R

all-zones T %7 7 = — A2 L2 WAL, TIENDY — 12K,
V=2DXYP—=N=AD)— N EHETHLENHDET, ZNH5D
JV— MEIRIY — N TR L 72 13 Ni372 0 £8 A

n TN ES DR NI =T A T2 =AM T L TW5D,
# ifconfig -a
ifconfig AN RZfHL T, TN ES -2 DRy NT—0A 24
7 T — ADVUP & RUNNING Dl f DIREETH D T E 2R L £,

= LDAP 4 DMERINEINT 5,
ldaplist AX > RZMHAL T, &/ — M LDAP Y —/N—F/=IZ LDAP V'O
FIH—N—ELHEETEDLEE2MHALET, LDAPY—N—LET, V—2
Mtnrhdb T—F RN— AT INTWDE T E 2R FT,

= NESY D> ROVEREL 72\,
A—=/)N\—1—HY—L LT, V—2>Tautomount ZHEEHL F9, F/-

1%, crontab T MU ZBML T, automount AN > RZ 50T EIZETL
i—g—-o
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B BRI

RKD2DODH AT, Bk 7 7 1IIVDEfEZIE—%2Y A1 DT XTOD Trusted
Extensions 2 AT MMZHEIET D I ENTEET, mEDHY A Tl Trusted
Extensions D} A% XA X% Solaris > AT LMGHIBRTEE T,

Trusted Extensions T~ 7 1 JLZR—% 7 )L *
T4 7ICaAF—93H%F

R TNAT 4 TIZAE—TF2EE, HFRMERUEBET ) E AT 4 TITHTE
¥,

¥ — Trusted Extensions DREFRIFIC, A—/N—1—HF—F£ /13RS OBRENEHE T 7 1
NWER—F TNAT 4 TICAE=LEZD, R—=F TN AT T7MS5IE—-LZDL
F9, TOAT 4 7IZIE Trusted Path D TNV 2T ET,

BT 74N 2 —95I120%. A—/S\—1—F =T/ 5)Hh, K — > TERENZ
D ET,

BT NARAZEEIUHTET,

TNARAEDB TR =y —ZHHAL, AHELEINTVRNAT ¢ T ZIFAL
F9, FMMIZ. TOracle Solaris Trusted Extensions L—H— 21 K1 @ [Trusted
Extensions TT/N\A AZE DY T3] 2R TLIZI N,

= Solaris Trusted Extensions (CDE) Tld, 770N XF—T % —] ITR—F TV A
T4 T DNEINFRINET,

= Solaris Trusted Extensions (JDS) Tld. 7 7ML T IUH | ICAENERINE
@_‘0

LIFOFEIETIZ. TOGUIZEZIETDIZ 7747508 LRl £7,
BMOT77AINT SO EREET,

JE—935774IWDH5T7HITICBEHLET,
72EZIX. 77 AIV% Jexport/clientfiles 7 # I A ICIE—LTHDELFT,

774 L TROBEERITLET,
a. 727 A4INDT7A I EEARTLET,

b. R=FTIATATDIT7AINT SO T7AINERS YT LET,
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TNARDEV L TZRBRLET,

éﬂfﬂ] 1%, TOracle Solaris Trusted Extensions L—H— X1 K] @ [Trusted Extensions
TINA ADEND B TEMGERT 5] 2ZRLTZI N,

IR=GTIWATATDIT7ANTSOY T, [T774)b] AZa—m5 TIRUH
Ll #2#RLET.

FE-OE—LET 7 AV OBE T NIV &R LI T NV &, AT 4 7 I3
DAMIFTLEE 0,

BT 7AINETRXTDIRATATE—ICTS

AT LNEHEZ, FURETIRTOYI D Z2HEICHERL IS EHESTHE
T, ZDEDITIE. BYICHRT S~ 2T HEENCK> THIBREN/ WS 1 L
7R EERLET, TOT 4 L7 MU, EHFIZITXRTOI AT ATH—D
TryANERBIEFEAERC 7 7 ANV EREL T,

7= & 213, LDAP A 23— 7T Solaris BHE O >/ — )L HME F 95 Trusted Extensions
W —)VARw 7 A /var/sadm/smc/toolboxes/tsol ldap/tsol ldap.tbx 21 E—L &
T, tnrhtp 77 TIVDEBHA T > T L — a2 WAL XL THD. DNS
H—=N—DU A NBLUOEERHER T 7 1IN H O ET, Y1 MajlFiZ policy. conf
Tr7AINVBETELE L, INSDOT7 v A IV EKEETA4 L7 FJICaAE—LET,

# mkdir /export/commonfiles

# cp /etc/security/policy.conf \
/etc/security/audit_control \
/etc/security/audit_startup \
/etc/security/tsol/tnrhtp \
/etc/resolv.conf \
/etc/nsswitch.conf \
/export/commonfiles

TNAZAEDYTYF =Yy — &AL TR —>TravyE—F 4 A7 &ED
BT, IyAINET7OyE—T 4 AV L L £, ADMIN HIGH D T NJL & 1T 7=
MOT7OyE—F 4 A21Z. 1 FH®D label encodings 7 7 1)L Z¥5E L 97,

VATARL Ty AN EIE—T BEE. AT LD Jetc/security/audit control
T7 AN Ddir: DL M) EEELET,

Trusted Extensions C’R— 4% JIL AT 4 T7H 5
J7A4I)EIE—F BHE

Ty AV EEZHZ DT, JLD Trusted Extensions 7 7 T )V DARTEEE L TH<
ERETT, VAT LERERT DB, root HEN)NWEH 7 7 1 IV DARTOEEB L
QCIE—Z{TVWET,
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BT 7 )N 22 —95I120%. A—/N\—1—T =25, K/ — > THEENZ
D ET,
BT NA REBNYHTET,

FEHME.  TOracle Solaris Trusted Extensions L—H— 2 /71 K1 @ [Trusted Extensions
TTINAAZEDY TS 2L TLIZI N,

= Solaris Trusted Extensions (CDE) Tld, 770N XF—T % —] ITR—F TV A
T4 T DNEINFRINET,

= Solaris Trusted Extensions (JDS) Tld. 771V T I0H | ICAENERINE
‘6_0

DLFOFMETIE. ZOGUIZIETDIZ 1774V T Iy itk £7,
BRI 7ANESUAT A TERBALET,

DRATAICBLEFID 7 7AIUNDHIHE. TDT77AIINEHLWARITIE—-L
F7.
EZE DT 7 A INDEAFTDEAIT .orig ZBIL £T,

# cp /etc/security/tsol/tnrhtp /etc/security/tsol/tnrhtp.orig

774NV T SO EREELT,
Jetc/security/tsol 7R EDIE—ET A Lo MU ICBEELET,
JE—F23FZNETNDT7AILICRHL T, ROEEERTLET.

a. NUURENTEATATDT77ANT SO T, 774IWD7 A 3 ERBRT
LET.

b. BIDT77AINTSOFDIAE-ET A LI MIICT7ANERSYILET.

TNARDENV L TZRBRLE T,

FEHME.  TOracle Solaris Trusted Extensions ZL—H— X /-1 K1 @ [Trusted Extensions
TTNA ZDEND Y TEMRT 2 2B T3 N,

TAYVT IPIRRENES, AT 4 TERYRLET,

Trusted Extensions CEEEABRL 7 7 1 )L & H A IA L

ZOBITIE, AT LCEREFREDPER SN THOER s root T—H—13, Hk
Ty AINER—F TINAT A TIZAE—THZ2HERHVET, AT 4T ONE
3. ZOMDI AT AICAE—SNET, TNS5DT 71L&, Trusted Extensions
VIR T 7 THRRESNAEATLAIIE—SNSHZEITRDET,
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root T—H—{X, FN\A ZAEID LTI R— % —"T floppy 0 7 /N1 AZE|D YT
T RO T —IZHR LU Tyes EBFEZET ., KIT. root T—H—Ii&, ik
Ty ANV EENLTOvE—T A AV EFAL. T4 APICAE—LET, T0D
TJOw E—TF 4 AZ1ZI&. Trusted Path &EW D TN HTF SN TNWET,

AT A4 T MEEHAADITIE, root T—HF—INZERANDTNA ZZEH D 4T
T, NEZEY U >o—RLET,

HERR 7 7 A IVINT—T EICH 56, root T—H —{dmag 0 7 /N1 A&E DY TE
9, Wk~ 7 1 VIR CD-ROM EIZH 555, root T —H —I3 cdrom 0 7 /N1 A Z &
DY TET,

Trusted Extensions = > X T~ AN G HIRT S

Trusted Extensions % Solaris & AT AN HHIRT 51213, FHEOFNEEETL
T. Solaris > AT AIZX9 5 Trusted Extensions D A7 <A X &HIFRL £,

Solaris0S DIF A L FAERIC, INIfFEY -2 DT —ITEHRLTHESHDEREFELE
ER

DRATLADPSINIGEY - EHIRLET.
FFAlX.  [System Administration Guide: Oracle Solaris Containers-Resource Management

and Oracle Solaris Zones] @ [How to Remove a Non-Global Zone] ZZHRL T2
Uy,

Trusted Extensions Y — E R EME L F 7,
# svcadm disable labeld

bsmunconv AX¥ > RERTLET,

DAY ROFERIZDWTIE, bsmunconv(IM) DX Za 7 INR—=I 2SR TL7Z
Iy,

(EREFTHE) Y R T AZBIEFLET,

AT LEBRLETY,

IEIEAY—E A% Solaris ¥ AT LMRITKER T 2HENH D ET, ZOBEMEL
T, BE, EAWNERy hU—F2 0, F—LP—EA, BRXET 71N AT A
DT> S RHDET,

S5 4F . Trusted Extensions DIEAX (FIIE) "


http://docs.sun.com/doc/817-1592/z.inst.task-44?a=view
http://docs.sun.com/doc/817-1592/z.inst.task-44?a=view
http://docs.sun.com/doc/816-5166/bsmunconv-1m?a=view

118



¢ o0 % 5

=z
=

Trusted Extensions D 7= & @D LDAP DFERK,
(FE)

ZDETIE, Trusted Extensions T 9 % 728 IZ Sun Java System Directory Server 35 &
U Solaris HHE O > — )L Z MRS 2 HIEICDWTHEBA L £97, Directory Server I
LDAP U —EAZ#EH# L £9 . LDAP L. Trusted Extensions DX I — AP —E AT
9, Solaris HHE I > —)Uid, O—HIIVBIULDAP 7 —F XR— X DEE GUI T

ER

Directory Server DAERITIZ, 2 DDERELAYH U £, Trusted Extensions > AT LI
LDAP B —/N—Z MK 9 %7, Trusted Extensions 7 O F 2B —/N—%&H L TEHFD
= N—IZEHELET. ROEEY TONWTNNOFIIHE S TS ZI W,

m 119 X— @D [Trusted Extensions 718 A ' TD LDAP B —/N— DL (TEE£~ v 7))
= 120 X—®D [Trusted Extensions 78 A ks T®D LDAP 7 O F 2t —/)N— DR (1EZ#
<y 7))

Trusted Extensions 78 X N C® LDAP Y —/\— D& (1

< v )

=S

FiEA

SHa%

Trusted Extensions LDAP
H—N—ZFEL LT,

BEFE D Sun Java System Directory Server 7372 V5
&, 1M D Trusted Extensions > A T L&
Directory Server ICL £ 9, DI AT ALITTN
INFE =231 A= ENTWEE .

Z DO ®D Trusted Extensions ¥ A T A&, T D
Y—=N—=DUIFA47 > NIV ET,

121 R—® TLDAP HIT Directory Server
DIEFHRZNET S

122 X—2® [Sun Java System Directory
Server #-1 > A b—)LT %]

127 X—2® [Sun Java System Directory
Server D117 R T 5 |

Trusted Extensions 7 — %
N—Z &Y —/)N—IZE N
LET,

Trusted Extensions > AT L7 7 A IV DT —4 %
LDAP H—NN—IZ AN L £T.,

129 X—® [Sun Java System Directory
Server ICT—% & AT 5
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Trusted Extensions 7k A T LDAP 7 H F Y —/N—DEL (EE < v )

(=S A

Solaris & HL1 > — LN
Directory Server CHERET
DEDITHEAL £,

Solaris B HE 1 > — )LD LDAP Y — ViR v 7 X
P THRELET. ZOV—ILRy 7 A%
LT, Xy NU—=rA T2 7 NMIBET 3
Trusted Extensions JE{E 2 A H TEX £7,

132 X—® [LDAP D72 @ Solaris &
a2 —)VDFRE F¥ES v 7))

ZDOMDTRTD
Trusted Extensions > A 7
L%, ZOY—)N—DY
FA47 > hELUTHER L
£,

BID T A T I Trusted Extensions Z #9535
G, TDYATLEZDLDAP Y —N—DY F
47 > RMZLET,

65 X—3 D [Trusted Extensions T A3
V—2%&LDAP YV AT > NIT 5]

Trusted Extensions /KR X N COLDAP 7O+ H—/N—D
B EE< Y D)

Solaris > A T L THEIT ST S EEEE D Sun Java System Directory Server 73 d % 35
B, ZOfEETy TREMLET.

(S

A

SRSk

2

Trusted Extensions 7 — %
N—AZY—/N\—IEML X
ED

Trusted Extensions % 7 —27 F—%
AN—Z D tnrhdb BEL N tnrhtp I&. LDAP
H—=N—IGEMT 2HENHDET,

129 X—® [Sun Java System Directory
Server IZT —4% &A1 T 5

LDAP 7O F > H—/)\—% %
ELET,

1 D ® Trusted Extensions > A T I %% DAl
@ Trusted Extensions & A7 A D 7 O F
H—N—ICLET, TDMD Trusted
Extensions > AT AlL, Zo7OF
HY—N—Z@H L TLDAP Y —N\—IZT ¥
ALY,

132 X—2® [LDAP 7O F P —/)\—%
ERkd %)

JOF 8 —/)N—IZ LDAP H
DIVF L N)ViR— b 2K
LET,

Trusted Extensions 7' 10 F 2 — )N— )V
TRV TLDAP H—N—EBETESLLD
IZLET,

128 X—® [Sun Java System Directory
Server DX IVF LNV R— h &BAET S )

Solaris & 1 >/ — )L 7Y LDAP
TOF I —N—THHET S
KOITHERLL £9°

Solaris EH 1 > —)L D LDAP YV —)I
Ry A EFETHRELET, 2D

V=) 7 AEFHLT, *v b

J—0F T2 7 NIZBIT S Trusted
Extensions B EZAH TEET,

132 X—® [LDAP D 7= D Solaris & £
a2V —I)VDRRE EES v 7))

Z DD R T Trusted
Extensions > A 7 /% LDAP 7
OFsHd—N—DOr7 5147 >
FELUTHERRL £97,

BID T AT T Trusted Extensions %2 £ %
THEHE, TOI AT LELDAP 7 OF
HY—=N—DUF147 > MILUET,

65 X— D [Trusted Extensions T A3
V—2%LDAP YV AT > NIT 5]
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Trusted Extensions < 2 7~ /A T Sun Java System Directory Server DX

Trusted Extensions > X 7~ /A"C( Sun Java System Directory
Server D&KL

LDAP *— LY —E AIL, Trusted Extensions DX xR — L P —EATY, Y1 KT
LDAP r— LY —EAMEZFHITIN TR WS, Trusted Extensions 23K S $1TC
W% A7 /5T Sun Java System Directory Server (Directory Server) Z 5k L £9

B4 kT TIT Directory Server N FEIT STV S E, Trusted Extensions 7 — %
N—=AZP—/N—ITEMT 5LENH D X9, DirectoryServer IZ7 7 AT %72
IZ. Trusted Extensions > A7 A CTLDAP 7 OF 2 ZHEL £,

E- ZODOLDAP Y —/N—ZNFS Y —/N—%/zid SunRay 7 717 > FHOH—/N—&
LTHALBZWEEIE, ZOT—N—ZINFE)—2 &A1 > A=)V T 205
ddH 0 EH A,

v LDAP F (C Directory Server D5 = NE T 5

® RDIEEDEZRELET,

#IHHEE. SunJavaEnterprise System D > A b =)L B — RICERINBJEF T
R INTNET,

AVAM=ID4¥—RDTO T
~ S E 7= (T 1ER

Sun Java System Directory Server version

ME#FE 1 —Y—ID) 7 7 4 )b MiEild Tadmin) T,
MEHHEL—H—/S A ladmin123] DX I7R/NAT—REERLET.
77— K]
(FoL 7 U=y 57 # )l MEld Ten=Directory Manager] T3
DNJ
4L 27 b F—2 %)% [dirmgreo) OXI/NAT— REERL ET,
AT — R
[Directory Server JL— | 57 % )b MElZ [/var/opt/mps/serverroot] T9, 7JOF V7
Iz 7 A AT E8E. ZONRARHETHHEHAIN
£7,
[ — )N —#5 1) T 74 ) MEIZO— NIV X T LTT,

% 5Z . Trusted Extensions (D 7= D LDAP DK (FIIE) 121



Trusted Extensions > 2 7 /2 T Sun Java System Directory Server DA&RL

122

AVAN=ID 4 —RDTOVS
~ WIS E 7= T 1ER

[—/)N—R— 1| Directory Server % f§i fl L THEHERY/2 LDAP % — LY —EZX &7 J
AT N ATLITRETDEEIE. T 74V ME [380) ZfFH
L%,

Directory Server Z i1 L T 7 0F > H—/N—D5HDA > A
F=L &S R— T AHEE, Ne380) 72 EEELSOR— K%

ANLET,

Y7497 ldc=example-domain,dc=com] DX DT, RAA JHEREZRE2EZD
ES I

MEHRAA ) lexample-domain.com)] DL DT, Y7 4 v 7 A B TE
LU ET,

[P ZAF Ahd—H—] 57 #) MElE Troot] TY.

[ AT LT IN—"T] T 7 4 )V MéIE Troot] T,

(57— % DR T4 MEL TZOT—N—ICRET—YEREFELET, | T
ER

(77— DIRGEST F 7 ) MEE T2 DY —N—IC 2= —/ V) —TF— % 245
LEd. | TY.

I Administration Port | F 7 4 MEIEY—=N—=R—=rT9, TIHIVELETH/-0H

ICHER I N B EFNZ. VT hU 7 N—2 3 2121000 Z T 72 5
BT, VIRNTZTN—=2 3 52086, ZOEFTIER—K
5200 1272 D 7,

v SunJava System DirectoryServer =1 > X b—JL 9

BB HIIC

%

Directory Server /N 77 —313, Sun Software Gateway web site (http://www.oracle.com/
solaris) NS5 AFTEET,

K — 201 DT A > A =)V S 37z Trusted Extensions & AT L TEE L TW
H5ELET, YATLTTNIAE—=21EHD FHE A,

Trusted Extensions LDAP ¥ —/N—|Z. pam unix 2 L TLDAP YR MUIZHT 5
RALZITO 7 47 > hDOIOITHERINTWET, pan unix ZEHT 5545, /N
AT —RFEEE, TORERELTONRZT—RRYZ—IE, 753147 > MZE->T
WEINET, T72bbE, LDAPH—N—ICXo> THESINZRY >—I3 SN E
Bhe V74T R TRETEDNAT—RNTA=FIZDONTIL, [Solaris D
2T LMER (F 2T o= @ INXZAT—REROER) 2R LT
IV, pam_unix DFEMIZ DWW TIX, pam.conf(4) DX Za T INR—=T 2SR T2
I,
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Trusted Extensions < 2 7~ /A T Sun Java System Directory Server DX

F-LDAP 2 147 > b T pam ldap Z {9 2 Hkkid. Trusted Extensions TIaFli =
NTHWEH A,

Directory Server /Xy T — 2% A VA =)L T BHEIC. P ATADKRIAMEZI MU
FQADNZEML £7,

FQDN &1 158245 E D B A1 244 (Fully Qualified Domain Name )| O Z & T9, &
DAL, ROKXIICHRA MG EER R AL D OMAEGDOEITRD XY,

## /etc/hosts

192.168.5.5 myhost myhost.example-domain.com

Solaris 108/07 U U — A X DD I ) —AZFETL TVWLHI AT LT
1. /etc/inet/ipnodes 7 7 1 JVICIPv4a & IPv6e DL RYUZBIMLET, KROLED
W2 1DV ATLDOILY FUIE#EEBELTED T 1 IIVICTATLET,

EITLTWB DN Solaris OS DEHT Y U — A TIEBWIEE, LFD/Nw FINA > X
=L ENTWEIHERH D FT, RIDEFILSPARC D/Ny FTT, KOFZBFIT
X86 D) F T,

= 138874-05. 138875-05: % 7 7 LDAP. PAM. name-service-switch /N F
®  119313-35, 119314-36: WBEM /N F

m  121308-21, 121308-21:Solaris &F 1> — I/ F

= 119315-20. 119316-20:Solaris ¥ Y 7'V r— 3 > /\w F

Oracle SunWeb H - | C Sun Java System Directory Server /X 7 — & BREL £ 7.

a. SunSoftware Gateway (http://www.oracle.com/solaris) DX— T, [Getlt] 7
0w o LEY,

b. [SunJavaldentity ManagementSuite] DRIDF v IRy I REI ) v o LE
ER

¢ [Tsubmit) K& &LV VI LET,

d. BEFLTWIWMEEIE. BERLET,

ee OJALTIDVYT7 bz 7%#850A—FLEY,
f. BEZ_LED DownloadCenter] =4 J v o LET,

g. lldentityManagement] $E1T. AL TWA 75y b7+ — AICEULRHFD
V7 hDxT7ESDO-RLET,
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124

Directory Server /Ny T —2 %A VA M—)LLE T,

121 X— @D [LDAP HIT Directory Server DIFH ZINET % | 7S DfERZEM > TH
MICEZAET. B, T72)V Mi, #RSINSEEOFMR—EITDONT

13, TSolaris D AT LEH (F—3I> 7 T4 L7 MU —EX:

DNS. NIS. LDAP##)] D11 % [LDAP 7 Z- 7 > & Sun Java System Directory
Server DR (FJE)] & [Solaris D AT LAEH (F—I VT4 LT MUY —E
Z :DNS, NIS. LDAP##)] D% 12% [LDAP 7 51 7 > b OFE (FlH)] =S
TLES W,

(HBRATAE) B & (/XX (Z Directory Server DIRIBEZEEHZEBM L £ T

# $PATH
/usr/sbin:.../opt/SUNWdsee/dsee6/bin:/opt/SUNWdsee/dscc6/bin:/opt/SUNWdsee/ds6/bin:
/opt/SUNWdsee/dps6/bin

(& B& BT BE) MANPATH [ Directory Server DX — 2 7 )L R—#BMLE T,
/opt/SUNWdsee/dsee6/man

cacacadn VAT S AZBICL T, JOATSADENCHE /=2 LR LET,

# /usr/sbin/cacaoadm enable
# /usr/sbin/cacaoadm start
start: server (pid n) already running

tCE) 9 % 7= TN IC Directory Server HRZEISN DL DICLET,

Directory Server FHD SMF ' —E A DT > 7L — K73, Sun Java System Directory Server
N = NIZEERNTVWET,

= Trusted Extensions Directory Server T, Y —EXZEHF/MICLET.

# dsadm stop /export/home/ds/instances/your-instance
# dsadm enable-service -T SMF /export/home/ds/instances/your-instance
# dsadm start /export/home/ds/instances/your-instance

dsadm X > RIZDWTIE, dsadm(IM) DX a7 I R—=TJZ2ZBLTLZ3 W,

» 70O DirectoryServer T, Y—ERXREHMICLET.

# dpadm stop /export/home/ds/instances/your-instance
# dpadm enable-service -T SMF /export/home/ds/instances/your-instance
# dpadm start /export/home/ds/instances/your-instance

dpadm 1< > RIZDWTIZL, dpadm(IM) DX Za VI R—=T 2SR TL7ZE N,

AVA M=V EHRELET.

# dsadm info /export/home/ds/instances/your-instance

Instance Path: /export/home/ds/instances/your-instance
Owner: root(root)

Non-secure port: 389

Secure port: 636

Bit format: 32-bit

State: Running
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Server PID: 298

DSCC url: -

SMF application name: ds--export-home-ds-instances-your-instance
Instance version: D-A00

LDAP H R D RBEMIR D A b T 712D T, System Administration Guide:
Naming and Directory Services (DNS, NIS, and LDAP)J D% 13 & [LDAP Troubleshooting
(Reference) | ZZHL T Z XY,

Directory Server FH(D LDAP 2 = A 7 > N DYERL

ZDUI47 > &AL T, LDAP H® Directory Server iICT —% & AJILET, Z
DX A%, Directory Server IZT —4 Z AN HEICEITT 2LENH D £,

—MFH1Z Trusted Extensions Directory Server 11227 7147 > b Z{ERL Th 5
P—N—LDU AT EBETLHIED, ML I4T 2 baERT 52
EHTEET,

2 AT I |Z Trusted Extensions &1 > X b—JLLE T,

Trusted Extensions Directory Server ZffifH1 9% Z &b, HIfE D A F AT Trusted
Extensions Z{ > A b —) 3§52 LB TEXT,

F-FEIT L TWB DN Solaris OS DIHT U U — A TIEIRWEE, LTD/Xy FN1 >
AR=ILENTNBHENDDET, RHDEFILSPARC D/N Y FTT, ROFBH
13 X86 DXy FTI,

13887405, 138875-05: -1 74 7 LDAP. PAM. name-service-switch /¥ F
119313-35. 119314-36: WBEM /% F

121308-21, 121308-21:Solaris B > — )L /N F

119315-20. 119316-20: Solaris ¥ Y U r—< 3 > /)N F

AT KT, T74IVBD setc/nsswitch.ldap 7 7 A IVEEELE T,
KFOLYMJIE, BEHEDZRLTHWET, 77 MILEROXDITRDET,
/etc/nsswitch.ldap

An example file that could be copied over to /etc/nsswitch.conf; it

uses LDAP in conjunction with files.

and "services:" in this file are used only if the
"_" for nametoaddr libs of "inet" transports.

"hosts:
/etc/netconfig file has a

H o oH R HHH

LDAP service requires that svc:/network/ldap/client:default be enabled
and online.

H* H

# the following two lines obviate the "+ entry in /etc/passwd and /etc/group.
passwd: files ldap
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group: files ldap

# consult /etc "files" only if ldap is down.
hosts: files ldap dns [NOTFOUND=return] files

# Note that IPv4 addresses are searched for in all of the ipnodes databases
# before searching the hosts databases.
ipnodes: files ldap [NOTFOUND=return] files

networks: files ldap [NOTFOUND=return] files
protocols: files ldap [NOTFOUND=return] files
rpc: files ldap [NOTFOUND=return] files
ethers: files ldap [NOTFOUND=return] files
netmasks: files ldap [NOTFOUND=return] files
bootparams: files ldap [NOTFOUND=return] files
publickey: files ldap [NOTFOUND=return] files

netgroup: ldap

automount: files ldap
aliases: files ldap

# for efficient getservbyname() avoid ldap
services: files ldap

printers: user files ldap

auth attr: files ldap
prof attr: files ldap

project: files ldap
tnrhtp: files ldap
tnrhdb: files ldap

Kigfy/ — > T ldapclient init AV REETLET,
ZDaX 2RI, nsswitch.ldap 7 7 1 JV%Z nsswitch.conf 7 v T JVICOE—L X
‘a—o

ZOHITIE, LDAP 7 17 > Mid example-domain.com R A HNIZH D F
T, Y—N—0DIP7 KL Z13192.168.5.5 TT

# ldapclient init -a domainName=example-domain.com -a profileNmae=default \

> -a proxyDN=cn=proxyagent,ou=profile, dc=example-domain,dc=com \

> -a proxyDN=cn=proxyPassword={NS1l}ecc423aad0 192.168.5.5

System successfully configured

B —/\N—@ enableShadowlpdate /N T A — & [CTRUEZEREL F T,

# ldapclient -v mod -a enableShadowUpdate=TRUE \

> -a adminDN=cn=admin,ou=profile,dc=example-domain,dc=com

System successfully configured

enableShadowUpdate /8T A—HIZDWTIX, [Solaris D AT LEH (F—I 7 &
T4 L2 FUHY—EX:DNS, NIS. LDAP#®)] @ [enableShadowUpdate A

1 wF] &, ldapclient(IM) DX Za T IR—=TEBRL T ZS N,
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Sun Java System Directory Server D 0 & =9 %

COFETITROIFEEOO TR LET, Y7 A0Y, BEOY, BXUT

Z—07TY., ROT 7 )V MREZELEEINE T,

s TRTOOTVEMEBLONY 77 2 TINET,

s ZOJI3MRT S /export/home/ds/instances/ your-instance/logs/LOG_TYPE
T4 L7 MUNICEBEINET,

s AR MEOFLR)V2s6 TOF T INET,

s O2ide00 7 7 1IVTY VL AMETIRESNE T,

s YA IdBHO—T—2aaInEd,

s To—OJidERHO0—5—2 3 > 3INET,

CDOFIEDRE TR DEM:Zii7z L £ T,

s EBEHEOVI3mBHO—T—3 a3 aNnET,

= 3MALDHEEHENOY T 7 AIVFHIBRYINICARD £,

s IRTOOY T 71V THRKA20,000M/N1 SDOF 4 A7 KBEFHLET,
s BT 7 AIVERAKS00MNA RO, \mAK100DOT 7 7 A IIVDMREE SN E T,
n T ATBEBOZEZEIN00M/NA hERES EHWOZNSHIBRENET,
s L0V TIEMEHRNNESNET,

TORAOTEBRLET.

77 AD LOG_TYPE L ACCESS TY ., OV ZHERT BH7-DDHEIT. KDOEBDT
—a_c

dsconf set-log-prop LOG_TYPE property:value

# dsconf set-log-prop ACCESS max-age:3M

# dsconf set-log-prop ACCESS max-disk-space-size:20000M
# dsconf set-log-prop ACCESS max-file-count:100

# dsconf set-log-prop ACCESS max-size:500M

# dsconf set-log-prop ACCESS min-free-disk-space:500M

BEEAJZEZBRLES,

# dsconf set-log-prop AUDIT max-age:3M

# dsconf set-log-prop AUDIT max-disk-space-size:20000M
# dsconf set-log-prop AUDIT max-file-count:100

# dsconf set-log-prop AUDIT max-size:500M

# dsconf set-log-prop AUDIT min-free-disk-space:500M
# dsconf set-log-prop AUDIT rotation-interval:1ld

Exnrsono—5—3a M. 772V M T1EBTY,

IZ>—AJZBRLET,
COMKRTIE, T7—0JTEMT—INRESNLSEDIIHEELET,

# dsconf set-log-prop ERROR max-age:3M
# dsconf set-log-prop ERROR max-disk-space-size:20000M
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# dsconf set-log-prop ERROR max-file-count:30

# dsconf set-log-prop ERROR max-size:500M

# dsconf set-log-prop ERROR min-free-disk-space:500M
# dsconf set-log-prop ERROR verbose-enabled:on

(BREATEE) S 5 (O & BRLET.

O ZEICROBREZEITD ZEBAEETT,

# dsconf set-log-prop LOG_TYPE rotation-min-file-size:undefined
# dsconf set-log-prop LOG_TYPE rotation-time:undefined

dsconf I > RIZDWTIL, dsconf(IM) DX a7 I R—I BB T ZE 0,

Sun Java System Directory Server D < )L F L N )L
R—bZBRET S

Trusted Extensions TYE3J %1213, Directory Server Ot —/N—HR— k& K/ — > D
RIWVFLAN)VIR— b (MLP) & L TRET DM ENH D X7,

Solaris EE YV —)LZEREILE T,
# /usr/sbin/smc &

Z M3 E a1 —% (this-host: Scope=Files, Policy=TSOL) YV —JL7Rw o R&EIR L £
j—o

[P RTLADERK] 20Uy o LTHo TAYEa—4ERxy NI—0] &0
JyoLET,
NAT—RZANTHEIRDENET,
BYENRAT—REAHDLET,

[FSRTYyRRy b= =21 5 TINoY o LET,
K-> &2 TNy LET,
TCP 7O RINDRILVFLUANLNAR—ZEEBIMLET.
a. [V=2DIP7 RLRICHIBZTILFLARILR—bDEM 221y o ULET,
b. R—hESELT38EANL., [THI 20Uy LET,
UDP 7O R DTILFLRILAR— b EEMLET.

a. V=207 RLRICHTZTIFLANILR—bDEM 22U v o LET,
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10

RO BHIIC

b. R—hrESELLT38EANLET.

¢ udp 7OMIJLERIRLT, TR 20U v o LET,
TRl 20V v I LTREZRELET,
N—FINEBHFLETS,

# tnctl -fz /etc/security/tsol/tnzonecfg

Sun Java System Directory Server (LT — % Z ANT
=)

T NIVHERR, 1—H—, BROERT AT LICBT 5 Trusted Extensions 7 — 4 Z
9272010, BREODLDAP T — Y R—AMMERBIOLEEINTVET, ZOF
JIETIX. Directory Server 7-—% X\ — A Trusted Extensions & & B D JAA LT,

T RUBEHNAENIR>TWDSLDAP Y F14 7 > MINGT—IR—AICT—F &
ANTBHHEND D XTI, AHESRFITDNTIE, 125 X—2 D [Directory Server D
LDAP V7 47 > FDIERL) ZZL TS 7230,

YA heFa T —TEBDHENLERBSIE. T4 L7 MUY —N—IZT—%
ZRRET DN, ROFNEZFEITLET,
w UR—TO [EHEDBEEFERT MR 70T 7 AIVEERT )

n 97 R—T D [Trusted Extensions TF o) 7 —EHEEE Z21ERKT 5
n 9R—TOD RSNz AT LEHEREZ1ERT 5]

F—AY—ERT—IR=—R[CT—FEANTHOIERTET77AILDR
TV UEBEERLET,
# mkdir -p /setup/files

YoTWND jetc 77 AN ERT =V JHEEICOE—-LE T,

# cd /etc
# cp aliases group networks netmasks protocols /setup/files
# cp rpc services auto_master /setup/files

# cd /etc/security
cp auth_attr prof_attr exec_attr /setup/files/

#

#

# cd /etc/security/tsol

# cp tnrhdb tnrhtp /setup/files
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Solaris 1011/06 U U — A &)\ FZ2@EH L/IRWTEIT L TWSHE. ipnodes 7 7 1
NEIE—-LET,

# cd /etc/inet
# cp ipnodes /setup/files

3 /setup/files/auto master 7 7 A JLIN5 +auto master T M ZHIBR L E 9,

5 /setup/files/prof attr 7 7 4I5S :::: T MU ZHIBRLET,

6 RT—UUUHEBICY - BEEBYY TEERLET.
ROBEY Y TOU AT, EXTOBAIOITIET 7 AV DA4FTIZRLUET, 2179
X7 7 1IVORNRERLET, J—>%4Id, Trusted Extensions V) 7 b = 7V IC& &
NTWST 74 )L D label _encodings 7 7 T ILINED TRV ERELET,
w ZZIOREINIZATD =2 HAEFEBEOY — CAITESHWA T EI N,
»  myNFSserver CHR—LT 4 L2 BUDNES Y —N—ZkEL X7,

/setup/files/auto _home public
* myNFSserver_FQDN:/zone/public/root/export/home/&

/setup/files/auto_home internal
* nndVPSsmn@rfFODN:/zone/internal/root/export/home/&

/setup/files/auto_home needtoknow
* nndVPSsemwrﬁFQDN:/zone/needtoknow/root/export/home/&

/setup/files/auto_home restricted
* nndVPSsemwrﬁFQDN:/zone/restricted/root/export/home/&

7 F*YRNIT—=OLEDITRTDIRT L% /setup/files/tnrhdb 7 7 A ILITEBIML E T,
ZZTIEHIAINERA—RIIEHTEERA, BEZTOITRTOIATALADIPY R
L2, RN ES—=2DIPT7 RLABEDTIDT 7 1 IVNITEET BN
HOET,

a. NOIRTYRITAHYZEHE. /setup/files/tnrhdb ZHREL F T,

b. Trusted Extensions R X A > DIN)MFE AT LADITRXTDIPT RURZEEML
ij_o
TR ELATLDY A Tdcipso TY . iz, INIFES AT LD
FaUF 4 —FT 2T L —FDOAHTH cipso TS L5 T, T 7 4) MERT
i cipso T FUIZKRDLDIT/RD ET,

192.168.25.2:cipso
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E-COUAMIE. KR~ BEBTAMAE -2 O T RLABEEN
%7,

¢ RAAUDBETESESNIVELIRTAZITRTEMLET,
FRINIBELI AT LD A Tidunlabeled T TN L I AT LDOEF 2
T4 —TF 7 L—bO4RiEadnin low TY . L7222 T, 77 %) MERTIZ
FRNE LI ATLADOTY MUIXRODXEDITRDFET,

192.168.35.2:admin low

d 774NV EREFEL. TT4 98 TLET,
e. 77 AIDBXERELET,

# tnchkdb -h /setup/files/tnrhdb

f. TS—ZEBELTOOEEZHRITLET.

8 /setup/files/tnrhdb 7 7 A JL % /etc/security/tsol/tnrhdb 7 7 A JVICOE—L &
j-o

9 ldapaddent AV RZFERALT. AT =V IRBEDINRTOT 74 IIVZEFIALT
Directory Server [CT—4 Z AN L E T,

ZEZE, ROaAY 2 RTIE, AT—2 2 VB hosts 7 7 1 IV 6H—/)N—IZ
T—IMBANEINET,

# /usr/sbin/ldapaddent -D "cn=directory manager" \

-w dirmgrl23 -a simple -f /setup/files/hosts hosts

10 Trusted Extensions Directory Server T ldapclient AX > RZRTT BIHEIL. P AT A
tDOSAT U NEBEBMICLET,

KK/ — > T ldapclient uninit A > RZETLET, il hZ2#EHL T, D
SATLMMIDAP 7 IA T 2 N TIRBL B> TWS T LR LET.

# ldapclient -v uninit

FHIC DWW TIE, ldapclient(IM) DR Za 7 ILR—TZBRL T ZE 0,

BX ¥ Sun Java System Directory Server (D 7= 8 (D Trusted
Extensions ' 0 3 > DERL

AT, Solaris > A T L DBETF D Directory Server IZ Trusted Extensions 7 — 4 N — 2
ZBINT HENH D 9, RIT, Trusted Extensions > A T /A7) Directory Server 12
772 ATESEDIT, Trusted Extensions > AT AN LDAP 7 OF 28— /N—1272 5%
KOWRT HLENHD T,
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LDAP D 7=8H D Solaris B 1> — )L DB TF (¥~ v )

v LDAP 7 OF LY —N—Z1EKT 5
B MZLDAP H—/N—9 TICEFET G, Trusted Extensions > AT A7 O F
U= N—ZERL £7,

L DHIC  enableShadowUpdate /N T A—4 2 TRUE 2% E T HLDICEE L=V T4 7 > by
5. LDAPY—N—IZT7—% &2 AN LE L. BHIZOWTIE 125 X—2
@ [Directory Server HDO LDAP 7 517 > b DIERL) #ZHL T ZE W,

F 7=, enableShadowUpdate /N T A—HIZTRUE 3% E L7227 17 > RIS, Trusted
Extensions D1EM & Z T — 4 N— A% LDAP B —/N\N—ITBINL £ L7z, I,
129 X— D [Sun Java System Directory Server ICT —¥ Z A1 5] 2SR T
W,

1 Trusted Extensions SR E SN TSR T AT, 7AF oo —N—%ERLET,

F-2D0 ldapclient AX > RZ2FEFTTHHENDH D ET, ldapclient init I > R
#FRITL 75, ldapclient modify 1Y > RZFEITL T. enableShadowUpdate /N5
A—AXIZTRUE 3% T L E7,

ML, TSolaris DY AT LEH (F—I> 7T 4 L7 MUY —EX:
DNS. NIS. LDAP#i)] D% 123 [LDAPZ 71 7 > O E (FEH)) 22| T<L
=30y,

2 TrustedExtensions T —F N—RAMWTAF LY —N—TRRCEBHELEEHRALET,
# ldaplist -1 database

EEEE  LDAPHKORIBEMRD A KT 712DV TIL,  [System Administration Guide:

Naming and Directory Services (DNS, NIS, and LDAP)J D5 13 # [LDAP Troubleshooting
(Reference) ] ZZML T ZE XY,

LDAP D7/= D Solaris EIE IV — )L DHBTE (fE¥E~< v 7)

Solaris ¥ 1 >/ —JLIZ, Trusted Extensions ZFET L TWEH I AT LDy NT—

TEMTLHZHDGUITTY,
e A SR
Solaris ¥ > —)L % |Solaris ¥ > — )V ZEHIHELL £9. ZOFE 61 X—® [Trusted Extensions T
WL L £7°, 13, K —> D AT AT EIC1IRIETLUET ., | Solaris HHE O > —)LH—/)N— &)1
t5 %]
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=S EL: BRB%E

B ESER L £ LDAP B —/)N—IZ & > T Solaris 2 > — )L & | 133 X—T D [LDAP D& % Solaris &
ELET, By —)VITBERT 5]

AT LA TEBEERZE | T 74)V b T, Solaris EHa =)L 7547 > (134 R—T D [Solaris & > — )b

MCLET.

MIBIDS AF LT H D) — )V —/N—EJEE
TEFH . WRNICEBEBRZENCILTLES
VY,

TOFy NI =T HEROZ I E2E
T 5|

LDAP Y —)LiR vy 7 A %
ERL £9

Trusted Extensions Ji @ Solaris B 1 > — )L
LDAP Y — ViR 7 AZAERR L £9,

135 R— D [Solaris &#E 2 > — )b
D LDAP Y — ViR 7 X &fftkd %

s 2R LET,

Trusted Extensions 718 A R2NLDAP 7 51 7 > MZ7x
N5 EEMRLET,

136 X— D [Solaris HH I > — )l
IZ Trusted Extensions 1& N E 41T
52 EEMHERT D

v

1R B HIIC

Y—N—lZ7oF s b—N—THhFNEH A,

LDAP D&% Solaris EIB Y — )L ([CEHET S

Trusted Extensions 227 L T\ % LDAP ¥ —/N—"T root T—H =272 0 75, ZD

Sun Java System Directory Server DR S L TN DHLENH D £, ROWTNN D
RZEET L TNET,

119 XR— D [Trusted Extensions 78 A N TD LDAP B —/N— Dk (1EE~< v 7))
120 X— D [Trusted Extensions 18 A b TO LDAP 7' B F 2 H—/)N— DRk (1E¥

<))

1 LDAPEEERZEZEHRLET.

LDAP-Server # /usr/sadm/bin/dtsetup storeCred

Administrator DN:
Password:
Password (confirm):

Type the value for cn on your system
Type the Directory Manager password
Retype the password

LDAP-Server # /usr/sadm/bin/dtsetup scopes
Getting list of manageable scopes...

Scope 1 file:
Scope 2 ldap:

H—N—RE

Displays name of file scope
Displays name of ldap scope

T4V MY —N—LtDROA-TE2—EXRRLET,

L5 T, FBRENDIDAP A —T NP EESINET, LDAP Ad—

&, LDAP Y —)Lihy 7 A&ffmET HE T BERRINE L. V—IVRY T A

(=

P—N—2HHT2EXTMETS A

8 5F . Trusted Extensions (D 7= D LDAP D& RK (FIE)
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£l 5-1

1RO BHIIC

LDAP E1& D& £%

ZOHIT, LDAP Y —/N—D [ LDAPL TH O, cn DIEIZT 7 4 )L b D directory
Manager T,

# /usr/sadm/bin/dtsetup storeCred

Administrator DN:cn=Directory Manager
Password:abcdel;!

Password (confirm):abcdel;!

# /usr/sadm/bin/dtsetup scopes

Getting list of manageable scopes...

Scope 1 file:/LDAP1/LDAP1

Scope 2 ldap:/LDAP1/cd=LDAP1,dc=example-domain,dc=com

Solaris E12 1>/ — )L TOX v b U — 2 HEEDF
TR EBRIT S

T 7 )V T, Solaris > AT AldtF oV T4 — EOMEEND D HR— ~TIEAH

LBWEDICHRESINE T, T0kD, BB TEHTLIATALE. vy hT—2

WEZZTT DL ITHRICHER L 9., 72&21 . LDAP Y —N—ED* v K
T = F—FRN—=A%7 547 > NN EET 5I21E. LDAP H—/\— D Solaris &
MO ) =) ==y NT—JBEZZTMHTEIDICLET,

LDAP H—/N—MdH 25w 8T —27 D7z D Solaris HHL T > —)L DRERREMITD
WTIE.  TOracle Solaris Trusted Extensions & ¥ D FNE] @ [Solaris ¥ > —)L %
FRLZ7 947 > hr—N—E] Z22RLTIZI N,

Solaris ¥ >V — )L U—N—2 AT AL ETRE) — > DA —/N—21—F—T7/<
TR0 ERA, ZOFETIE. TOIATLAEZRER AT LERNET,

oo A=N—2—HP =L TV IAT >R ATLZAR Y RITNSE T VB ATE
H5ZEHMETY,

BB ATAT, BREGEZITMITEILDICOATLAZRELET,

smc 7T —E 2ldwbem B —E 2L > THIEH SN E T, wbemP—EAD
options/tcp listen 7H/NT 4 —M true ICRE SN TWBHE, Solaris HHEE O >
V=) = N\N—I3ERER 2 T T ET,

# /usr/sbin/svcprop -p options whem
options/tcp listen boolean false
# svccfg -s wbem setprop options/tcp_listen=true

whemB—EXDBRREBIEEEZITIVET,

# svcadm refresh wbem
# svcadm restart wbem
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EEEIR

RO BHIZ

wbem B —EXAMEBEHRER (TMITELIICRESNTNS I LEZHRELET.

# svcprop -p options wbem
options/tcp listen boolean true

RBRTALABLUSolaris BBV —ILICT IV ERTBIRTOI ATk
T. smcserver.config 7 7 4 L CIERBIEFR D ENC/Z o> TS EEHRLET,

a. smcserver.config 77 (I E NS RATYy RIT 44 TCHEETY.

# /usr/dt/bin/trusted_edit /etc/smc/smcserver.config

b. remote.connections /NT A —% [Ctrue #HELE T,

## remote.connections=false
remote.connections=true

¢« 774INVEREL. AT YRITAHEERTLET,

wbem ' —E A ZFHiEEN L /2 13HNTT 285, smeserver.config 7 71 )LD
remote.connections /N T A= MNtrue DEFETH D EZ2MHERLET,

Solaris B2 1> — )LD LDAP Y — LRy U X %
wRT D

LDAP B —/N— ED A —/\—1—H =T < TR D £H . LDAP &% Solaris &
M) —)NIEEFT HHENH D, /usr/sadm/bin/dtsetup scopes I > RDH )
IZDWTHID TWABRENHD X9, FMllL. 133 X—2 D [LDAP D& % Solaris
BHO )N T S 2B TEI N,

LDAPY —)LiRy U RERLET,

# cd /var/sadm/smc/toolboxes/tsol_ldap
# 1s *tbx
tsol ldap.tbx

LDAPH—N—%&E AHLET,
a. NIRTYRITHHYEREET,

b. tsol ldap.tbx V—ILRY I ADTIL/XRAEETIE—L T, 5lHELTIT 4%
[CR=RFLET,

T2 EAE ROINAINLDAP Y —I)ViRy 7 ADT 7 # )V b DALETY,
/var/sadm/smc/toolboxes/tsol ldap/tsol ldap.tbx
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51 5-2

1R BHIIC

¢« RAA—TEREBESHMZET,
<Scope> ¥ 7 & </Scope> ¥ 7 DT H B server ¥ 7 %, ldap:/...... fToHH
(/usr/sadm/bin/dtsetup scopes AN > RMNG) TEEMZET,

<Scope>ldap:/<ldap-server-name>/<dc=domain, dc=suffix></Scope>

d. <?server?> F£7=(d <?server > DI RTDA 2 RAY A% LDAP H—/N\— L BE=H
AET,
<Name>This Computer (ldap-server-name: Scope=ldap, Policy=TSOL)</Name>

services and configuration of Idap-server-name.</Description>
and configuring Idap-server-name.</Description>

e. 77 AINEREFEL. TT49ERTLET,
wbent—EXDBXRREBIREEEZITIVET,

# svcadm refresh wbem
# svcadm restart wbem

LDAPY —JLR Y & ADFKTE

ZOHITIE. LDAP H—/N—DARIE LDAPL TT ., W—ILRy 7 A ZRET DI
13, BEHEED <?server 7> D1 2 AY > A% LDAPL EBEEHZFT,

# cd /var/sadm/smc/toolboxes/tsol_ldap
# /usr/dt/bin/trusted_edit /tsol_ldap.tbx
<Scope>1ldap:/LDAP1/cd=LDAP1,dc=example-domain, dc=com</Scope

<Name>This Computer (LDAP1l: Scope=ldap, Policy=TSOL)</Name>
services and configuration of LDAP1l.</Description>
and configuring LDAPl.</Description>

Solaris & ¥ 1 > */ — )L [C Trusted Extensions |53
SFEFNTWNARILEZHERTS

LDAP H—N—M0NdH b %y NT—27 E LDAP Y —/N\—N2Wxry NT—T D=dHD
Solaris B HE 1 > — ) OREREMHIT DWW TIE.  TOracle Solaris Trusted Extensions &
DOFIE] O TSolaris E¥EA ) =)V ZHH L=V 547 > M —N\—ilfz5] =5
LTL7Z3,

EHRENC 2> T, £REFA—NN—2—HY—ELTLDAPZ A4 7 > hica A >
LET, ATLZLDAP YV 17 > MZTBEEIE. 65 X—2D [Trusted
Extensions CKIHY — > Z LDAP 7 74 7 > MZT 5] 28R T ZI N,
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O—HIVI AT LZERTHI2IE,. 61 R—D [Trusted Extensions T Solaris & ¥ 1
== N—2 LT 5] 2R T LTS ZSIN,

O—RIIV AT LMEERES AT A LD ) — IV —)N—IZEHT 5I121E. @\
DY AT IT61 R—T D [Trusted Extensions T Solaris & ¥ 1 > — )P —/)N— %1
b9 %) 2587 LTLEIW, £/ BRI ATLT, 134 RX—2D [Solaris & H
A2 =) TOFY NI =V EHOZFMITEZENTTS] 27T LTLEIN,

LDAP X — AP —EAHF DT —FR—ZAZEILDAP 7 517 > " SEHT ST
3. LDAPY—N—"7T. LOFIEIZIMATI135 =D [Solaris EH > —)L D
LDAPY — IV 7 A&fmET 5] E T LTI EI N,

Solaris BV —JLEREELET.

# /usr/sbin/smc &

Trusted Extensions Y —)L7K v U R EREE T,
Trusted Extensions Y — )L v 77 Z DI Policy=TSOL TY

" WDAPER—AY—ERXELTERTSMSRXTY Ry =4 TlE, XRDTX
FERITLUET,
a. O—HWINEBT—IXR—RIITFIVERATESLZLEHRTBHITIE. ®DY—IL
Ny O REREET,
DAY a—% (this-host: Scope=Files, Policy=TSOL)
b. LDAPY—N—DO—AIIEBT —FIRX—XICTIVERATEEHLEHERTS
([ZIE. mDY—=IbiRy o RERELE T,
IO Ea—% (ldap-server: Scope=Files, Policy=TSOL)
¢ WDAPY—N—LtDR—AY—ERT—IR—XICT OV CRATED I LZHER
FTHICIE RDY—IKRy I AEIEELET,
ZDA2Ea—% (ldap-server: Scope=LDAP, Policy=TSOL)
" WDAPER—AY—ERELTERLEWNSZATY KRRy FT =2 TlE, ROT
AMERFTLET,
a. A—HINEBT—IXR—RIITHOERTEBILEHERTAICIE. ®mOY—IL
Ry REREET,
DAY a—% (this-host: Scope=Files, Policy=TSOL)
b. ERATADO—HINEBT —IR—R TV EATELZ LEWERTBIC
3. RDY—=IRy O XE/ELET,
ZDA2E2—% (remote-system: Scope=Files, Policy=TSOL)
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138

3

EREIR

[ RTADHER] BT, TavBEa—%&xybD—21 ., T+
T4—TrTL—Fr] LBELET.

ELWTF T U= bBRUOIRNUDPERL AT AICEREN TN LEHERLE
ER

F-LDAP Y —N—TIZRB WL AT LNERY NT—=7 F—=FRXR—=2ZFERICT VA
LEHELTH, MWHICERKLET, a>V—IL2FHATEE, BREARNMIOY
AL TY=INVARy T A2 ZENTEET, 2L, HERICT IV ALEDE
WELEHELZDL LD ELEEA. LDAP U —/NN—TII72 W X T A F T Scope=LDAP
BERLEZZEZRT, ROLT—AvE—INERINET,

Management server cannot perform the operation requested.
Error extracting the value-from-tool.

The keys received from the client were machine, domain, Scope.
Problem with Scope.

LDAP#kZE T 7))V 2 —T 4 > 7§ 5I121d.  [System Administration Guide:
Naming and Directory Services (DNS, NIS, and LDAP)J D5 13 # [LDAP Troubleshooting
(Reference)] ZZML T EE W,
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£ 6 E

Trusted Extensions E N\ F L A AT A
DIERR (F A7)

Netra > U — X7 EDNY R A AT A E® Trusted Extensions ¥/ 7 b = 7 Z #EAk
B&U%E?éﬁm‘%@AyFVX&X?A@t#:U?4—$%%%EbT§

Wa7 7t AZ0REICT DB MDD £9 ., =@ Trusted Extensions > AT L ZE MY

LEAITORROBRENHEIRD T, HHGUIZETT 21T, 2070t A

BEMES AT A ETEITL, TOGUIETAY by T AT A ETERT HHEN

HHLEMHD ET,

HEHOFHIZ DWW TIE.  TOracle Solaris Trusted Extensions & FED FNE] D 8
# [Trusted Extensions TOZEMFEH (FIE)] 2R T ZE 0,

E-NY RLAT AT LVERY AT LA TREE SNSWHRTIE, G S 1172k
DOHIMEZG - L ER . L, 22X=20 A1 FOEFaUT 0 —RY>—IT
DNT) Z2ZRLTSES 0,

Trusted Extensions TDO Ny R L A AT ADWHER (fFE

< v )

ANy RLAT AT LTI, a2V =)V 7IIVERRICE > THMARLI 2 L —%
T4 2 RUICERHSNERT. ZORBIE, BH. tip AV Rk ThiEanx
I FIHFTREIRER S AT LDY A TITUEU T, ROFEOWITNAZMHL T
ANy RLVATATLZHBRTEET, ROEXTIE, BEENEGWHIENSIEITRL
X9, INSOFIHIERS AT LATHEHENET,
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(=S

A

root L—H—IZ X %=
Oy4 > a&HFMLET,

LDAP Z i L TWizWiGE, H&#JIZ root &L
TAY RLATATFAIZaSZ A > LET, LDAP
ZHEHALTWAHE, ZOFEITIEKTEE
ER

141 X—® [Trusted Extensions T®D
root IC K BbEO VA > 2GNTT
%]

EWD 71 2 EAEICLE
_a—

o

root R EIFE 7213 B OEBEEN NS
I—P—0REFEOTA1 > EHFMLET,

141 XR— @ [Trusted Extensions TD %
HicksrEBO VA > 2 HNTT 5]

FRI)W7s U AT NI S Trusted Extensions 37 A
TLADEHEENLET,

143 R—=2D TRV LI AT LMD
DEBOTA > EH/NNTT S|

ANy RLAT AT L EOKE — 21
A=Y N7 I EATEDLIITLET,

[ Oracle Solaris Trusted Extensions & ¥ 0
FlE] O % DL —H =2 Trusted
Extensions D KK/ — @bkgco 7+
CTEDHXDICT B

(B IE A EE) & B GUI DR
EHMMILET,

ANy RLATATF A ETETFENTHAER
GUIZT AV by T AT A LETERTED X
STLET,

145 X—2 0 [EH GUI ORI REA
T 5

(s FIfE) AR > b
J—=JaA Ea—T4 27
(virtual network

computing, vnc) ZH XN
LE7.

EBZEDI AT > NG, 3EWE Trusted
Extensions € Xvac U —N—Z2#HL T, 751
7RIV FLAN)tyarEaRRLE
ER

FOracle Solaris Trusted Extensions & 2 ™D
FIEL @ [Xync Z#H L T Trusted
Extensions > AT AIZEEY 7 A9
=

ANy RUVAT AT LERE
THODORER EEB DS
EEBNLUET,

BEWE AT LEERT S0
D, A—/)N\—A—F—FZ3IEE/2D £T,

145 X—2®D [rlogin £/21d ssh AT >
R Z{fiH L T Trusted Extensions ®
ANy RLATATAICOTA 2§ 5]

Ay RL AT AT L ET Solaris HHLO > —)b
ZfERALET,

144 X—2 @ [RWFD Solaris FHHL T >
V=)L BZFHLTT 7 AIVAaA—TT
EHT5S)

T4 O RUERY AT LANEWESE, U T
ay4>a2A—N—1—J—LLTHHATEX
T, ZOFEIILZLETEHD EH A,

RERRIIATETY

F-tFaU T4 =R —2WHRL T, U1 FTHEASNTWIERERD Hik%E
HIELET,

140
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v Trusted Extensions T root [CLARROT A > %

RDFIE

RO BHIIC

BT S

Solaris OS DA LR U L D12, CONSOLE T b U DN#ERN/2 &=, root I T NIVATE
SATAMGEETO A > TEET,

O—AIT7 7 AV EREL TERI AT LAZEETIEE, ROFMEITHENET,

NSRTv RIF 44T, /etc/default/login 7 7 A )LD CONSOLE={TZAZ A A ~ T
JhLET.

# /usr/dt/bin/trusted_edit /etc/default/login

WRELZITIZRDLD IR ET,
#CONSOLE=/dev/console

sshiEHI CD root A—HY—0OJ A4 VZFHFAILET,

/etc/ssh/sshd config 7 7 fIVEEAHLE T, 7 74 )V N TIE, sshid Solaris > AT
LTEHTY,

# /usr/dt/bin/trusted_edit /etc/ssh/sshd_config

e L7ZATIER DL D10 T,

PermitRootLogin yes

Fiz, TNIIBLIATAMS root I—F =& L TOTA > 511, 143 X—2
D ITIRNVEBELUATLANSDREBOTA > EFNTSH] ZETLTLEIWN,

HENCLDEREO T A 2683027 51213, 5l EHE 141 R—2 D [Trusted
Extensions CTOHENC X DERBO VA > 268 MIT 5] Z2EFTLTLEIN,

Trusted Extensions TDXRE|(C KB RROT A > %=
BT D

rlogin £/21 X ssh A REMHL TAY RL AT AT LAZERTLLEND 5
B0, Z DT> TS &,

T o —3ERTT Ny J TEET,

O—HIVT7 7 AIIEFERL TCERS AT LAZEHL TWAEE, 141 X—2
@ [Trusted Extensions TD root ICLDEBOYV A > ZHNIT 5] 2T LTHE
F9, KIZT, root T—HF—&E LT, ROV AV ZWM DI AT A ETEITLET,
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MADSRATALET, BOWDIRTAEIN)MFERTLAELTERHELET,
FTAT " T ATABLUOANY RLAV AT AR, ACtFa5s—5>7
L—hZ2EHLTEWCHFZRFETD2HENH D ET, FIEHITOWTIE. TOrade
Solaris Trusted Extensions DO FNE) O tFa2UF 4 —F> T L —hEHRANER
WFRARDZI—TICEONTS] 2BRLTLIZ3 N,

—RF IR EED B THITIE, Hle-1 2SR TS ZS 0,
WMADLATALET, A—DA—H—LEINEERLET,
WHDI AT AET, 4Ei&EIDZFRUCICLT, HEZ21I—Y—IZEDYTE

T, I—H—EBEEZERT SI2IE. 93 R— @D [Trusted Extensions TDE| &
I—H—DER] 2R T 7ZE 0,

RBDSolaris BBV =)L TV EBRTBICIE. MADSRTALTROFIEE
ETLET,

aa BOWDIRATADRABRREBEELULIPT KL X% /etc/hosts 7 7 A JVITEBEIML &
j_o

# /usr/dt/bin/trusted_edit /etc/hosts

127.0.0.1 localhost
192.168.66.66 local-system-name loghost
192.168.66.12 remote-system-name

b. RIRREIDG|IEZ(FTZHFAIT B(Z(L. pam.conf 77 A ILEZEL TPAMKRY
:/—@:’%ﬁl L/i—g—o

i. /etc/pam.conf 7 7 A JL% setc/pam.conf.orig [COE—LET,

# cp /etc/pam.conf /etc/pam.conf.orig

ii. N>ATYRIFTAH T, pan.conf 77 M IVERHEFET,

# /usr/dt/bin/trusted_edit /etc/pam.conf
ii. 774 NIT NIV ETAD L MOERBICOIE-LET,
iv. ELOVOaE—3N/=T > bU T, other % smcconsole [CEELE T,

v. dE—&EM7=pam roles.so.1 T [, allow remote ZEIMLE T,
TabF—ZFHLTTI 4 —IVREBHLET, 2OV a dROLIITR

DE9,

# Solaris Management Console definition for Account management
#

smcconsole account requisite pam_roles.so.l allow remote
smcconsole account required pam_unix account.so.l
smcconsole account required pam_tsol account.so.l
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1RO BHIIZ

# Default definition for Account management
# Used when service name is not explicitly mentioned for account management

#

other account requisite pam roles.so.1l

other account required pam_unix_ account.so.l
other account required pam_tsol_account.so.l

Vii 77 ANV EREFL. TT 4 ERTLET,

.(BHBRRTHE) 7 7 A JL%& /etc/pam.conf.site CAE—LFE T,

# cp /etc/pam.conf /etc/pam.conf.site
PATLEHLNWIY ATy T L — R854, BEENRZE
/etc/pam.conf.site N5 pam.conf 7 7 (VT I E—FT BRE/NE S )2 F A
LTLEEN,

Vi

Trusted Extensions 7R X k% 4 7D —BFB /R EZEDVERK

ZORITIE, BEHAIZL FANY A TOEENHKE S5 H1IZIENE Trusted
Extensions > AT LA DR ZRBL £9 ., EHEFIZZDEDIT, ROLDITERET A
TLHETtnctl AY Y REMHEHL T, TAY by T2 AT LDKRA Y A 7 %K)
ICEFRLET,

remote-TX# tnctl -h desktop-TX:cipso

T D, EHHZIL. Trusted Extensions W SN TV WT AT hw T AT LM
5 3% & Trusted Extensions ¥ AT LMY VAL 9., ZOHE, EEHEZFIIRDLD
WEMRS AT A ETtnetl A REFHALT, AV R T ATLDRANY A
7% ADMIN LOW T NIV TEMET 5T X)L AT L E L TRNICERL £

remote-TX# tnctl -h desktop-TX:admin_low

j?_/\“)lx?ﬁ;t L RTADSDRBAT A > /R
%

COFHFLZETIEH D XA,

141 R—2 @ [Trusted Extensions TOXRENC L BERO T A > #HINMZT 5] OFHHA
20> T, EREEIOFEZT 2] T5LD PAMMAY > —Z2EML TBEET,

FSRTY RRTFALET, @ENGEFaVT4o—TFT - 2SR ELIR
TAICERLUET,
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A\

1R BHIIC

FE-T 74N RORETIE,. MOITNIB LI AT LANERS ATACOTA 2L
TZOEMETADREENH D ET., LENST, 0.0.0.0 %y NT—JDF

7 4 )V N % ADMIN LOWNSHID T XIVICEBR L TLZE W, FEICDNWT

1%, TOracle Solaris Trusted Extensions ¥ D FJE] @ [T AT v K%y NT—7 E
THEHRTEZELHRANZHIRT 2] 22BLTIZI N,

FSRTY RIFT 4 YT, /etc/pam.conf 7 7 A IVEREET,
# /usr/dt/bin/trusted_edit /etc/pam.conf

smcconsole T MU ZRRLET,

allow_unlabeled % tsol account EZ 2 —JLIZEMUE T,
TabF—ZMHHLTT 4 — IV REBEL £,

smcconsole  account required pam tsol account.so.l allow_unlabeled

WERDODZOEZ >3 E. kROLDITEDET,

# Solaris Management Console definition for Account management

#

smcconsole account requisite pam_roles.so.1l allow remote
smcconsole account required pam_unix account.so.1l

smcconsole account required pam_tsol account.so.l allow unlabeled

=fRD Solaris EXE IV — )L #ERALTT 7 4
JJAROA—TTEET S

LDAP ZfiE 31, ERI AT A ETSolaris &>V —)L 2 EHT 586
., IV I A\DEEEREAINCLET, 2720, ROFIETIE. LDAP X
A—TDT7 7B AZENTHIEIFTEERA,

LDAP AA—7 D7 7 v A ZH[IMIT HITIE. 132 X—T D [LDAP D7~ D Solaris
BHIO) =) OFRE PEET Y 7)) OFEEZTRTETLTIEI N,
SATAIEFED TN ET AT ATT,

ROFMEZ7ZETLTBEET,

n 61 XR—TD [Trusted Extensions T Solaris & ¥ 1 > — )L — /)N—2#HLd %
141 X— D [Trusted Extensions TORENC L DmBO YA > ZHNTT 5]

134 RX—2D [Solaris BV =)L TDFRy T — O EBOZ(TRHFZHMCT
5] ZERTULET,
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TRONYTATAT, MADVRATALETRLUEDICEESINTNS
A-Y—-[CRVET.
TRONYTRATAT, BMADVRATALETRILED ICEERESNTNARE /A
LJ .i-g_o
TRONY T RATATSolaris B —)L #EEILET.
# /usr/sbin/smc &

[H—N—] 4700 KRYIRAT. Ny RUVRAVRATADEZRIEANLET,
KIZ. Scope=Files Y —J)Lihw 7 2z #RL £7,

IO Ea—% (remote-system: Scope=Files, Policy=TSOL)

v, s —_ L. —
EEGUINRRERTZEMICT S
FAZ by 7 ETORERBZEROFNEIL, Trusted Extensions VL S 31T V784 Solaris
VATALETOFEEFLCTY, ZOFMET, FEEZZEL Tl INTNE
-a‘o
TRINYTORATAT, Ny RORFAPSDTACANRREINDLSICLE
j—o
a NYRVRVRATADBTRI MY T RTFTALEDXY—N—=ICT O RATES L
SICLET,
desktop $ xhost + headless-host

b. 7RI by 7DDISPLAYZEHDEEIEELE T,

desktop $ echo $DISPLAY
n.n

ANy RUVRSRATALET, DISPLAYEHET AV by T RTAICEKELET,

headless $ DISPLAY=desktop:n.n
headless $ export DISPLAY=n:n

rlogin £7/z(d ssh A~ > KZ{EH L T Trusted
Extensions D\ RLU R RTFAICOTA T 5
ZOFIETIE., a7 RfFB LW txzonemgr GUI ZEH L TA—/N\—2—HY—F /=13
BEE LT Ay KL AS AT AEEHTE 2T,
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1B BHIIC

FE-rlogin AN RE[FHALAEBOY A L, sshAX > REFHALARERO VA
RO BREMEMNMESRD ET,

Solaris EHL O >V — )V 2 L TERI AT LZEHT 256, BROJ 1237
CREFEATAHEEZS D EFA, FIEIZTDWTIE,  TOracle Solaris Trusted
Extensions B D FNEI D [Trusted Extensions > A 7 LD 5 Solaris EHE I > — )L %
Fo TP AT LAZRBEHET S| 2L TIEIN,

141 X— @D [Trusted Extensions TORENC L BB OV A > ZHNIT S 25%7T
LEL,

Bz, BEERLCI—Y—HEI—F—IDTAY RLAT AT LICOTA T
L EEHFNEINZI—TF—ThHD, Ny RLAZATALALETHT AV by T
TALETRNEDEFUEENTRDZENTEET,

FROUMYTIVRFAT, Ny RORFAPSLDTAEADBRERENELDICLE
j_o

desktop $ xhost + headless-host
desktop $ echo $DISPLAY
n.n

MADSATATRIUEDIICERSNTNWALI—Y—[CHE>TWAHELHY F
—g’—o

WARD 4 Y ROMSERICANY RULRAL AT AICATA 2 LET,

n ROEDICsshAXR Y RAEFERALTCAALET,

desktop $ ssh -1 identical-username headless
Password: Type the user's password

headless $

= ROEDICrlogin AR REFALTCAIA 2 LET,

desktop # rlogin headless
Password: Type the user's password

headless $

WADYATATHERULD CERSNTNDREICAZVET,
FUMmAT 4 > RUZEHLET, ZEAE root DEEFNT/RD EFT,

headless $ su - root
Password: Type the root password

KR =0 ET, INT, ZomARZEALTIA Y MMTFhsNy RLAY
AT LEEMTELEDITRDEL,
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ANy RVRASRATALEDTACANTRI by T RATALICRRTENDLSICL
ij_o

E-F7z, ssh-XxAXRTOZA LT, BERGUIZERTDHIEHTEET, #f
L. ssh() DX Za T INR=TZSHRLUTZEI N, FlIcDODNWTIE. fle-2 25
LTL7ZE N,

headless $ DISPLAY desktop:n.n
headless $ export DISPLAY=n:n

Trusted Extensions D GUL Z i L TNy RL AT AT LAZEHTELLDITRDE
T, 72EZIE. KDL DIZL T txzonemgr GUI BN L 9,

headless $ /usr/sbin/txzonemgr

Labeled Zone Manager [3i#fE> A 7 A ETEITIN, TAY by TP AT A RITER
ENET.

(BBEATHE) Trusted (DE T 2 3 Y ICT U EALET,

7TV r—2a A= — DA =T 2 ERERI O—X%fTD12IE. [Oracle
Solaris Trusted Extensions B ¥ DFJEI] D [dtappsession T Trusted Extensions % & f@
I 22RLTIEIN,

Ny RUVRDVRATATDINIVGE = DHRTE

ZOFITIE, EHEED txzonemgr GUI ZFH L T, IXIMET AV by T AT A
MBE IR EANY RLATATAED TN E =2 2K EL FT . Solaris OS

EERIC, BHEZE S sshAXY 2RI xATaz2ERALT. TATZ MYy TV AT

LANDXY—=N—D7 7 AZFHFILET, T—F—installLIFH LD AT LT

FUCEXDICERSINTNDDT, %E remoterole 12725 ZEMMTEXT,

TXdeskl $ xhost + TXnohead4
TXdeskl $ whoami
installl

TXdeskl $ ssh -X -1 installl TXnohead4
Password: InslPwD1l
TXnohead4 $

K — ICRET H1213. ERFIIHE remoterole 12720 £ T, ZOKENI, 1
FHDI AT ATHUELIICERSNTVET,

TXnohead4 # su - remoterole
Password: abcdlEFG

Kz, EHEIT txzonemgr GUI Z LB L £,

TXnohead4 $ /usr/sbin/txzonemgr &
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Labeled Zone Manager {3\ RL A A5 A ETHEITSN, TAV by T AT L E
WKERESNET,
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YA bDEF2UT4—RUD—

ZOMEETIE, U1 hDOEF 2T —RY T —ITDODWTHHL, FEHICOVWTD
BEXEPCWeb Y1 FEHNTLET,

150 R—=2D [P+ bDOEF 2T 4 —RU > — & Trusted Extensions
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152 R—=2 D ENtEF ) 570 —ICBHT 2 HEREFEIE)

153 X—2D MAANDEF) 74 —ICEHT 2 HERFEIE)

153 RX—2D K< H2tFaUT 1 —EN

154 X—2 D [Z0fdtF 2V 5 ¢ —BHEEEH

a7 —RUS—DEREER
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T4 =R —ZERLET, EFa2UT 0 =R —2ERBIOERET G
3. RO A7 EFRTLTLIEIN,

w EF VT —F—LOFRE, TFaU T —F =4l by T LN ORE
H,OANBEM, O a5 T LAEMEEHE. BIUORKEERNS OREH
THERTDIHENH D £T ., F—AlL. Trusted Extensions BEEHEFEDRY > — & F
EZE L, TXRTOIATLAI—Y—ITEHAINS - tEFa) T —HD
U—@ETHLENDHDET,

. RREEHEYEICHTEITA beEF )T =R =DV TOHEF. Y1 b
ORFEERICHED LMY FIIZE, vFa2 VT4 —RNU P —ICHETHIHFEZEZIT
LZHENHDET, RUT—DERIZII D E2a—F I ATLDEF2 T4 —IC
EEEFRTLIOT, RI—Y—NtFaUTF s —RU—ITMNDENTE
BNEDITTHRHENHDET,

n I —H— 2% S Trusted Extensions / 7 bV =7 BLNEF 22U F 4 —HRY
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ICEHT %26, BELEEEZ D AT LERFHITRET H2HENH D F
T, tFaUT 4 —RESINZRETIZ. ROXDBEEICANTWES, 7272
LIV AT LEREICRETHAHLENH D XTI,

By ialOHDIRESNSEIEO DS R EAMES Twd

s Iy AT —YICEREREEND D

» ANMENHEMTEZLHAOEME 272 Lz0BENZD L

s I —BERENEITTERWN

tFa)F 0 —R) =0k, tFaU T —HR =D JEfTI N TN
Moz DESF I N TR WIS, Trusted Extensions 2 iR € & 3172 2 A T LITHEHN
INBHZT—HIIREINETE AL, BEZEERT 2 TFIE. BIOEEFERO DI
TloHEZRLET D FIEZRE LTI D £8 A,

tFaUT o —ARY > —0EMNLKE. EFa )T —F =413 EFaY
T4 =R =D&, BIRIORY > —FHliDd EICHELZTRTOTED
L Ol E E I DRITNIERDER A, ZHUCX>THRY D —2EIET S
ZEICEST, BF2U T —ZALIBELIENTEET,

A4 bDEF 2T 4 —7R1 I — & Trusted Extensions

tFa) T —EHEL Y1 hOEF2UT 0 —RY > —IZHE DT Trusted
Extensions %v N7 —27 &t Lzt z 0 Ft A, BFa2U T4 —RY =20k
DL D7k EDOPEDHAEIZ /R D £,

150

FTRTOLI—HT—IIDNT EDREOEENTONSN, £/, EDOAXR T
T AT DWTIFhbnsn

BEZRDI—F—IIDVWT EDREDBEENTONLD, £, EDI X2 b
75 AT DNTITHONS N

BET Y E2EOLDITEM, RE. BIUFHEY 27

SATLATED TN EMHTDHN, T2, — L1 —F—7H ADMIN Low TRI)LHB
K TVADMIN HIGH 7 X)L &2 FRKRTE D)

BT EDL— T —FRA] ERAE D ST 5N DM

FINAARDLEE, EO—F1—T—ICEoTEDTNA AZEDYTEHI L
NTE DN
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AYEa—9DEFa VT4 —(CHY HHERIE

AYEa—4%DtFallT« —(:Faﬁ‘d’é?&i‘%%lﬁ

YA bOEF2UT 4 —RY > —ZRHETLLEZTE. ROHIRIA DY A b
EREHLTSZEEIN,

Trusted Extensions WiX & S 11722 AT LA D EAL T N)ViE, Y1 M TEITEIN5
EEDEF 2T 4 —LANNDERZBABNIDITEH OB TTILEI N,

AT LDYT— b, #E, BROT vy MU FEITY A bOoJICRi
LET,

Ty AN AT LDOEEZLENL T, FEEZZTEZTXRTOT 7 AILIZDN
T, BENZEF2Y T 0 —RY > —E NN L ET,

BEY a7 IV EEHEY 2 T7IVE. ZTOBHMEZEHA T ELRBEHOH D A
BUANRFHD R NWEDICLET,

Trusted Extensions >/ 7 N .7 O EEBEIEE 2T P LU 2 WEIHEIRL, HEB X
OXEL T, BREREZIEDET,

Trusted Extensions WX E S N7 AT Ald, e THIUI2 ALLETEHL £

T, BFaU T —BAHEOREICET T ) T —EHMREZ, 1 ACED
VTET, SATLEMRY ZAVICEAT AU AT LEHEWERZ, T &30 AN
BODYBTET,

EHM 2N 77 TN —F > 28D ET,

AL, FNELHEEL, BUICHEHTSEEETELZ I —0RITED YT
32@‘0

T T NIEHEEEI DL TS013, (EEZTIOICEENLEREGE. £
7=, 7OV I LhEREEL TEHEOHERICOWTOREEENGEH S NZHEDAT
T, HLWTOT T LICEMHEEZRET DRI, TOREMEEL T, BAFED Trusted
Extensions 7 07 5 A DORHEEMERL E T,

B EHITE IR B IO 2T VWE T, BERA XD AW MREL
T, TOAXRYFOFERZHRIL XTI,

EHID OFIIR/NRICLE T,

setuid BE W setgid 707 T LD m/NRICU £, KGR, Kb, HEIZMHEHL
T, 7OV S5 AhZFEFL, BEHZERL ET,

BEHEFEZ RV —DRU0T A o ERoTWS I &%, EHINIC
TR bi@“

BHEL, I NI AT LAEEOID OETIZRL, ZY/a1—¥—1D
DIEZFF> TWSE Z EZEMICHERL TZI W,
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MENEF U T« —ICHT SHEEIR

MENEF21 T4 —ICHT HHREEIR

YA bOEFa2UT 4 —RY S —ZHETLLEEITE ROHTARFITA DU A B
EREHLTSZEE N,

152

Trusted Extensions WiX € SN2 AT ANDT 7 A ZHIBL T, o EH%?
G, B, 1D ORANTT,

Trusted Extensions Vi€ SN2 AT LNDT VL A ZBEHB I OCENLL £
—3—0

a2 Ea—FEER, BEEY<7TZOIT, T—TICHREDRERENHEIC
EE L 9. REHEICEET S5 @87 L — e TiREz LT E
—3—0

HZREDOEWERIZIZU A—NTINA L =P AT TOMMHZBRHL T, #
AL TWARWAT ¢ ZIL@EYIHRE L £,

SATLDINY T TBEIXART —HA T, AT A EIP DL TR TR
wELET,

N TT I TAT AL TBEIRTY —HA T AT 4 TNOWENT 7 A1, T &
TLNDT 7 AL U HETHIELET,

A Ea—FERICERY 7 —LA%RE L., RENRGE T O DRI
Bolbbnbd DI ET, HEREHIPHIZ 10 ~32°C TY,

J2Ea—FHERISKBAIZRZREL. K. FROKRORRE, RHOKFENZE
NHOMBEIITLET,

KREH 5B DIERAE, BROIKI AT LZEZRBELXT,

REY I—LEREL, MENGTESVETES/Z0TEDNLEDICLE
—3—0

O E a2 —4IZ TEMPEST > —) RN WAL, HZ#HS L £9 ., TEMPEST
=)V Rid, MiRORE, R, RHLEIHHATEET,

TEMPEST Z{#i [ L 7= & OBIILRE SN/ OAICHF L, B 2
ERICEH#EL £7,

A2 Ea—FRENENN TV iR PEERITRATE 2WHER A H 720
MR L £9. BITIR. MO KH, @A, JTTOBEEHBEREDRMI/R EZNET,
A2E2—FRRANRET L Ea—YREDOES TORBBIUBUEZ L
F9, AP —YERBEITHEEEZTITINS OIT RN AIRERRKIRZ 32T £

@_‘0

J2Ea—F i DakatZ2RiE&E L £7

A2 Ea—F ORI OGN, B0 K, EEZEOMHZHIRL X7,
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< BB EFaVT 1 —ER

BADEF2UT 1 —ICEAT DHERSEIA
YA hOEFU T4 —RY > —2MET 2L EITE, ROHA I DU A b
EREHILTSZE N,
» NuTr—2, X&FE, BEIOAM L= AT 7R, AFLEREABIOEF2 Y
T4 —RES NV A PP SIERANFF S T RTIICREL 7.
» FEESOIRTOANID H— REHRFITETLHLIITKDET,
o BESEENRERID - R2FEHLET,

o FEEOLEAD ZEEILT SHEEAERD, FRICE o THsNTONEKDITL
i@‘O

o HHEEFEIIEEICIENDDEEIRNET,

—_— Sy
< HhHHtFa)rT1—ER

A2 Ea—4%&5%ERICtFars—RiETHEEFTEETA, TJE2—Fi

ROtF YT —DORERI. TOMROMHEXRETT, tFa T4 —EKD

FEAEDT VT aid, AP —DEFEECEBEDOEBIMIX > THBEICHILTEE

T, KIT, FBAETHAEEEOHSMEOFIZRLET,

s 1T =0, PATLANDT VB AEZHFIINTHWEWAIL/ISAT—REHZ
60

n 1PN AT—REBEZED, TNEEILED, BETHRWEANICHEL
=079 %,

s I—H—, fREICHEIITE 2ECAHE/NAT— RICERET 5,

s NAT—RZANLTVWEZOZEFNOI—F—ICHR SN, NNAT—RZH51N
E)O

KA INTW VNI —F—NN\N—RI 7 ORI Lo AT 7
D, N—=RITICAREREEENMZ S,

s 1Y —AHEEHZOY Y LEWTY AT AZRET %,

= I—H-NT 7 VOT I AEEEEL, BAOLI—F—HREDT 7 A &
BENDESITT B,

s I—H—7 7,]»)1/@5/\)[/;&2(7%%[/‘ FNDOI—F =D 7 Y’I'JI/%T:EJ%?}HX
NasE51c9 %,

o BEOHRINEZS 2Ly —IZNFRWTUS L2, BETRWEFTITHE
L7079 %,

s RO R 7 IChEgEE Lz,
= BEHKT D,
n ULA=NTINARL = AT 4 7 2EYNTRE LI,
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ZTOMDEF2 YT —EEEH

» AEICHLZENS D Ea— YN RA S,

» Xy hU=U =TI NEEINS,

» BYWAREZICEST, A2Ea—YEENSHH S NS ESNHRENS,
» (FE, BER. AT TCESTT—INHIEINS,

o HEE, K, EE. BE. BERICK > TT—I0#EI NS,

» KEEOBFOEHGE, SBOBRBHOTF I >TT 7 1IVDMFEFHTE/5<
3%,

ZOMOEF2 YT« —BEEH
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KEEFRTFOERYTIE, A Ea—FtFa 5T —ICBT DESRE, K
T—, HiE, BLOHBENFEICHBEINTVWET, 512, UNIXTATLDT A
FTLAEBEMTIONA RHEZZITRINTVWET, UNIXOtEF 25T 10— EORME
EIRRR T TR T B DITRNL B £ T,

A2 =%y hEBULTHERZAFTTEET, KT, CERT (http://www.cert.org)
D Web T ML, BESCI—HF—RIFICV 7 Tz T7DEFaU T4 —FK—)LIZ
B 2 ENMEE I N TWET, SANSHE (http://www.sans.org/) Tld. FL—=
2T, M HREE, A2y DS OEREGEORETTU A MBI TN
£,

KE B H AR

KEBUFIZ, 2O % Web ETHRELL TWE T, KEE ST EER ML
(NIST) D A2 Ea—FtFa)F—1)J—ZAtE>¥—(CSRC) M, A>Fa—F+
FaUT 4 —ICHATLHEREFEL TVWET, NISTOYA K (http://
csrc.nist.gov/index.htm\)MH YT > O— R TESHMO 2 RITRLET,

= AnIntroduction to Computer Security: The NIST Handbook.SP 800-12, October 1995.
= Standard Security Label for Information Transfer. FIPS-188, September 1994.

= Swanson, Marianne and Barbara Guttman.Generally Accepted Principles and Practices for
Securing Information Technology Systems.SP 800-14, September 1996.

= Tracy, Miles, Wayne Jensen, and Scott Bisker.Guidelines on Electronic Mail Security.SP
800-45, September 2002. 777 > 3 > E.7 Tld, A—)LH D LDAP DZR7ZFHEITD
WL

= Wilson, Mark and Joan Hash.Building an Information Technology Security Awareness and
Training Program.SP 800-61, January 2004. {5 F| 73 FH 35 £ % I &¢

= Grace, Tim, Karen Kent, and Brian Kim.Computer Security Incident Handling
Guidelines.SP 800-50, September 2002. 77 > 3 > E.7 Tld, A—)LH D LDAP D&%
IRREENT DWW TR
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= Scarfone, Karen,Wayne Jansen, and Miles Tracy. Guide to General Server Security SP
800-123, July 2008.

= Souppaya, Murugiah, John Wack, and Karen Kent.Security Configuration Checklists
Program for IT Products. SP 800-70, May 2005.

UNIXDtF+ 2T 4 —ICB8T 5 EHIRY

Chirillo, John and Edgar Danielyan.Sun Certified Security Administration for Solaris 9 & 10
Study Guide.McGraw-Hill/Osborne, 2005.

Garfinkel, Simson, Gene Spafford, and Alan Schwartz.Practical UNIX and Internet Security,
3rd Edition.O'Reilly & Associates, Inc, Sebastopol, CA, 2006.

— I Ea—4%9tFa T4 —ICET B
W4

Brunette, Glenn M. and Christoph L. Toward Systemically Secure I'T Architectures. Sun
Microsystems, Inc, June 2005.

Kaufman, Charlie, Radia Perlman, and Mike Speciner.Network Security: Private
Communication in a Public World, 2nd Edition.Prentice-Hall, 2002.

Pfleeger, Charles P. and Shari Lawrence Pfleeger. Security in Computing.Prentice Hall PTR,
2006.

Privacy for Pragmatists: A Privacy Practitioner's Guide to Sustainable Compliance.Sun
Microsystems, Inc, August 2005.

Rhodes-Ousley, Mark, Roberta Bragg, and Keith Strassberg.Network Security: The Complete
Reference.McGraw-Hill/Osborne, 2004.

Stoll, Cliff. The Cuckoo's Egg.Doubleday, 1989. ( [ 77y A3 > Ea—# TN & ED
(k- F)1 . EEAFET. 1991)

UNIX €% ([CB8 9 5 T hr#)

Bach, Maurice J. The Design of the UNIX Operating System. Prentice Hall, Englewood Cliffs,
NJ,1986. ( TUNIX 1 =)V DakEtd  HEALHRETT. 1991)

Nemeth, Evi, Garth Snyder, and Scott Seebas.UNIX System Administration Handbook.Prentice
Hall, Englewood Cliffs, NJ, 1989. ( FTUNIX > 27 AEHAMY . V7 hNZ 77U TA
T4 T T 1992)
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Trusted Extensions T CDE ¥ & 2 3 > %
FRHLEY—2DA4A R M=)

Z DR TIX. Trusted CDE 7 77 > a > & i L T Trusted Extensions |2 7 NV} &
= D ERERRT B HIEICODWTEHBAL £9 7, Solaris 10 11/06 U ) — A %)X v F % it H
BPFICETLTWDD, F£REBINGDOT 7T a IHEBL TWAEEIE. Trusted
CDE7 7> a &ML ET., txzonengr A7 U 7 RZ2MEHT 51213, 68 X—

D [FGNE—2DERR] 22 TL<ESI N,

m 157 R—=T0 [CDETY Vv a &2 A LExYy NI AT —AET—>
DfEE TEE< v 7) |

= 160 RX—T®D [COET VT a &AL — AERO%EN EE~< v 7))

m 163X—TD [CDETY V7 v a ZHERLETNIGTEY — 2 DOER TEE~ v )

]

CDE7 Vv avzaERLEXRY N)—0A 2571 —R

E = DIEE WEET Y )

RDH A & NTNN1 DDA EFETLET, TNETNOFRERFITDONTIE,
28R—=2D [RIVFLN)IT 72 ADEHE] 22U T ZE 0N,

EE

A

SRE

B 25 T - AEIA
LET,

K —> & 1DODOIP 7 RLAICYY T
L. IRNIfFE) =220 IP 7 RL A
Xy 7 LET,

158 RX—2®D [CDET7 Vv a > zadHL T
AT LZ2DDIPT RLAZIEET 5|

WEA 25 T 2 —A%EA
LET.

TRTOJ—>2%1DDIPT RL AT
Xy ISLET,

159 =20 [CDET7 Vv a > a@HL T
ATFNZ1IDDIPT RLAZEIRET D)
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MET7OarEERLERY NT—0A4 25T —REJ -V DIEGHEET YD)

158

v

RO BHHEIIC

CDE7 0 aFERLTIRTAIC2DDIPT
KL RA%ZIEET D

ZOBKTIE, RARDOT RL A — S icoBs@ElanEd, IV
=203, BlOIP Y RLAZKE) — a0 £,

KN — > TA—=/\—2—HF =220 FT, PATALIZIETTIZ2DDIPT RL A
MEND BTSN TNET, TrustedCDET — T AR—AWZT VB ALET,

Trusted_Extensions 7 + )L [CEL £ 9.
a. BRENDVARY 3TOUYILET,

b. 7T—UAR=RAZa2—7T, 77U —>3>]1 5 77)5—3> %
I—=x ] EFERLET,

c. Trusted_Extensions 7 A L DT A A E=F TV )y o LET,

DT AL, A2 Tx—A, LDAP 7 9147 > h, BERIRIfHE
= BRETHEZDODOT I arNEENTWET,

SREBA VYT —ROEF) 702 arE57TIVo Uy o LT, 7BV T MG
ZELET,

F-JATAIETTIZ2DDIPY RLANE DY TN TWARITNIEARD £1
Poe ZDT702a>DEDIT, 2DDDT RLAEZDT RLADKRA N GEATL
F9, 20007 RLANHKEY RLATY,

Hostname: Type the name for your labeled zones interface
IP Address: Type the IP address for the interface

D77 a ic&koT, BEOPTY RLAZFEDRARDPERINET, K
J—=2DIPY RLAN, ZDHRARNDARITT, INIIMFE/—2DIPTY RL A
1. BIOFARETYT, 51T, INIAMNES—2DIPT R AWK — > L3t
HINET, ZOMRZFERTSE, INIUMNES =Ny NO—=2 7Y 2
TIOEATEET,

B2 b= TN E — RN AR Z AL T<EI W0, 2213 &
A N441Z -zones %ﬁmbi'ﬁ"

(BBEAIRE) ARV « RO TIDT O 3 DREREWZELET,

# ifconfig -a
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MET o arEFRLERY bI—0A4 08T —REV—VDIEE WEET VY

RO BHIC

ZEZE ROEHE, TRNAfES -2 D%y NT—=I A2 T —R
192.168.0.12 DA/ A > ¥ T2 — A hmed:3 2R L TWNWET, hmeo 1 > ¥
TJr—Ald, KEY—20—EDIPT7 RLATT,

100: flags=2001000849<UP,LOOPBACK,RUNNING,MULTICAST,IPv4,VIRTUAL> mtu 8232 index 1
inet 127.0.0.1 netmask ff000000
ether 0:0:00:00:00:0
hme®: flags=1000843<BROADCAST,RUNNING,MULTICAST,IPv4> mtu 1500 index 2
inet 192.168.0.11 netmask fffffe@0 broadcast 192.168.0.255
hme0:3 flags=1000843<BROADCAST,RUNNING,MULTICAST,IPv4> mtu 1500 index 2
all-zones
inet 192.168.0.12 netmask fffffe@0® broadcast 192.168.0.255

Solaris 1010/08 U U —AM 5, Jb—T N\ A 2 F T2 —AD 100 H all-zones 1 >~
7T —ATT,

100: flags=2001000849<UP,LOOPBACK,RUNNING,MULTICAST,IPv4,VIRTUAL> mtu 8232 index 1
all-zones
inet 127.0.0.1 netmask ff000000
ether 0:0:00:00:00:0

CDET V> 3V EFERL T AT AICTIDDIPY
FLRZIEET S

ZOMETIE, FARDTY RLAM, TUMTES =2 250TRTOY —ITiHE
HEnxd,

K — > TA—/N\—2—H =272 0 7, Trusted CDEJ—27 AXR—ZIZT7 7 A
bi‘é—o

Trusted_Extensions 7 + )L & [C#&EHL £ 7.
a. BEEVYIURKRYITOY YOI LET,

b. 7T—UAR—=RAZa—7T, 77U —->3>] 5770 5—23> %
Ir—Tv] EFERLET.

¢. Trusted_Extensions 7 A ILZ DT A A EHZTIVO Uy I LET,

DT FINHFITE. A2 Tx—A, LDAP 7 9147 > h. BERIR)fHE
= BRETDHEODT I arnNgEnNTnET,

MBAGT1—ADHRE) 7023 EFTINI Iy I LET,

DT TaicEoT, 1DODIPY RLAZFHDODRA MR INET, K
V=2l —FD7 RLAEH0FET AL, TOIATALE, XIFLTY 2
H—N—FZIEINFSH—N—&ELTHHTEEE A,
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ET7 U2 arEERLEY —AEBD%ER (EE~ v )

3 (BERIEE)RAR T 4 ROTIDT7 o a3 DIEREEZELET,

# ifconfig -a

(A > T —2ADHE) 773> T, IXRTOYV—IZHBNIC ZREE L
F9, INS5ORENICIE, K/ —>T1 OOYHEZNICEZ]EL T,

ez ROEDE, I RTOV—2DF%y NT—=I A2 T —R
192.168.0.11 DLW A > F T2 — A hmed 2R L TWET,

100: flags=2001000849<UP,LOOPBACK,RUNNING,MULTICAST,IPv4,VIRTUAL> mtu 8232 index 1
inet 127.0.0.1 netmask ff000000
ether 0:0:00:00:00:0
hme0d: flags=1000843<BROADCAST,RUNNING,MULTICAST,IPv4> mtu 1500 index 2
all-zones
inet 192.168.0.11 netmask fffffe@® broadcast 192.168.0.255

Solaris 1010/08 ) U —AM 5, =T N\ A 2 F T2 —ZAD 100 H all-zones 1 >~
§7I__ch:j—o

100: flags=2001000849<UP,LOOPBACK,RUNNING,MULTICAST,IPv4,VIRTUAL> mtu 8232 index 1
all-zones
inet 127.0.0.1 netmask ff000000
ether 0:0:00:00:00:0

COET7 o> a aERLEY — MERRD & (1EX
<)

ROEET Y T1E, AT LTDY — MNEREER{TEHY ATITONWTRLTNE
T, = DIERRTIEICDNTIE, 26 X— D [Trusted Extensions TD/ — > &

| ZZRLTEI N,

e FEA Sk
L&Y — 4R & BIRIFE =TIV DIN—T 3 >N 161 X—2® [CDE7 7 > a >z
. =% E =2 TR | Ao AT AT, Solaris BHIO Y =)L TS | LT —%E— 2 IRNIVERE
=Y L%Ed, i & TNV ZBEAA T E T, 95
2. — 2 EAERR T DRI TXRTORARNT, IN)NWERXYy NT—UA > [ Oracle Solaris Trusted Extensions & P
Iy NT—=VZEBRLET, [ T72—RACEIDE T, ISITHREITVE DOFME] © ThFATv RExwy b

KR =7 =5 X— A DI (1E3%

<))
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(DET U2 arE&ER LY — AR D%ESR (EE~ v 7)

YCET O arvEFERLTY—2REU—2IN

1

IWERET D

label encodings 7 7 T IVHD IRV T &I — 2 EERT 246 EIIH D EHA

MW AERT A ZEHTEET, tnzonecfg T —F RX—AZIE, TDI AT LT —>
BERRTE S I NIIDFIEINET,

Trusted_Extensions 7 #+ )L ¥ (T8 L £ 7,

a. BRENDVARKRYITOY VI LET,

b. 7T—UAR=RAZa2—7T, 77U —-3>]1 5 1 77)5—23> <%
x—Tv] EERULET,

¢. Trusted_Extensions 7 A LS DT A AL EFTIVO ) v I LETS,
V=2 ZEILV = DEmERMITET,

a. V=%l 7023 EYTINOV YO LET,

b. 7OY 7 MIMLTRATEANLET,

E k- =TV ERARTEY — T ET, mEAE TRLN
CONFIDENTIAL : INTERNAL USE ONLY TH B — 1T, internal &WD A2 AT E
—a_o

V=2 ZTEIL TV—2EER] 7023 & URLET,
722, T 74 )V N D label encodings 7 7 1 IVITIZRD T RIVMMEENTNE
KR

PUBLIC

CONFIDENTIAL: INTERNAL USE ONLY
CONFIDENTIAL: NEED TO KNOW
CONFIDENTIAL: RESTRICTED
SANDBOX: PLAYGROUND

MAX LABEL

= &Rk 773 a>wz6RETLTININ LI =221 DERKR LSS

TH, RO —ZEERT DI 2B LET,

s I RTOLI—Y—DI AT ATIE, PUBLIC TNILIZ1I DD —2, BLN
CONFIDENTIAL T ~\JLIZ3 DD — 2 ZER L £7,

s BARFEHD T AT A TIL, SANDBOX: PLAYGROUND T N)LIZY —> % 1 DIERLL £
9", SANDBOX: PLAYGROUND |IBAFEH FH DO AHGE T N)L & L TER S N, BAFEENME
AT ATAIDH, ZD TNV — NN TT,
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MAX LABEL T N)UIZIEY — D ZERLBNWTL a3 W, ZHAUIRT EREL TE
wINET,

FSRTY RRY ROV =2V —VEREET.

Solaris EHI 1 > — )L DY —)Uid, I—T—TI7—2f<LIITKEFENTNE
T, IN5DY—INF, XTI I—2MEL. HBWITIELWEFTIY Y R2%
TLTCT—R—AZHEHL L7,

a.

Solaris BV —I)LEEE LT,

# /usr/sbin/smc &

O—HhJL> AT AD Trusted Extensions Y — LR v 2 R #BE £ T,
i (32 V—Il] -5 TY—I)liRy o REM<] ZERLUET,

iil FC MDA E a1—% (this-host: Scope=Files, Policy=TSOL)] & W\DZEIDY —)L
Ry REZEIRUET,

ii. A<] ZoUvyoULET,

[ RTLADER] (CHD TAVEa—9Exy b= ITBEBLET,
ROESNTZENAT—REANTLET,

d FSRTYRXYND=O=0Y—=)ETTINOU YO LET,

V—rZ eI BURINIVEY B EEMITES,

a.

(702 av] - = EROEMN] Z2RUET.
FAT7OTRy 7 A2, ElDBTENTND TN — 2 OLARTINE RS
NETJ,

V- RzERELTHS RE) 20V v o LET,

INIVENY =T, J—=2RICEETHIINILEI )OI LET,
MiES o))y ULIESE. TOIXN)ebd—EI w7 L TERzZ
fREL, ELWS)L a7 w7 LET,

Y HTERELET,
(I ATy KRRy b T—=0) =D 70T 4 —] YA T7ATRy AT [T
fig) 27w LET,

WIS — 2 INT RTNRIICE RSN T T, HHNE, [V —HERD
B AZa—HEZIZ Yy 7§28, V= HADENBZNT AT OT Ry 7 AN
MM NET,
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MET O avEFERLEINIGEY - DERIEET Y )

EREIE

[TRS 25w Rxw hT—=2)—>2O 70T 4 —] A4 707Ky 7 AT, fERR

T2 = MERINBVWGE, =%y BT =R T 7 AOIVINEE L 780

R

TTIERENTVET,

=%y RO =R T 7y AIVINERELIRWT E 2R L ET . /NRIVTHET
ZRLET,

Ty AIWINEELBWES, =22k 77 az2EFL T/ —24%
fRELET, KiT, FIEs 2E0DRLTTZ 7 1IVEERLET,

COET7 0> 3 A2FERLESRNIVGEY — 2 OVER (X

< v )

NIATY REw NT—=0 ) =Mk T —FRX—ZADT > h)ZEiZ, J—2%1

DERTEET, 161 R—D [CDEY VY ayZ&2FEAL T —2HE)—2TIX))
ZHRET D] OFET =%k 77 a2 7352 &iIckD, T2k

UZEERLELE,

YT —2 3 X% — % —O Trusted_Extensions 7 # )V ZI121E, T R)VAF &
= BERTBROT I a N EENTWET,

=B - T RTO =AU T — T 7 IV EER L £ 9
=2 DA AR IV -TELWN T =2 ET 7 AN AT L% — B
ESCH

=R A ) =) = DA R NEERTBEDD T 4 > RITT
LDAP iV — > 2t -~ — > Z LDAP 7 514 7 > ML T, V—2DEEHD
WGz L ET

= EE - - EEEHL, Y—EXAEBR T L —LATU—27 (SMF) DT XRTD
HY—EXEEHLET

=D vy R )= DIREEE BN S IHICEAE L ET

HADZRDNEFTHE T LET,

=S

A S5

L1DDY—2%A A | RIIDTNIFE ) — B ERL £ 164 X—® [CDET7 7 > az{#HL TS

F—=ILLTEHL X
kR

T, W= A=)V, V=% | NIfFET =221 A M=)V, 8L, B
LDAP 7 A7 > RiCL, V—=2DFTXRTO | LOVEET S
Y—E2ZEHLET.

2= ENAIRA X | R —EAZHIBRLET., V—2%0 168 R—2 D [REL 2>/ — > % Trusted

LET,

E—F3V—>oro—2a2ERT 585 Extensions THAY X1 A9 5|
&, V- EROEREHIRL £,
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MET o a EFERLEINIGEY - DEBREET YD)

(=S

A

S5

3. Z DD — 2 AR
LET,

WET D) ZBRLTEI N,

RONWTINNDHEEHERHL TEDOMDY — > ZERL £, HEORRICOWTIZ,
47 R—2 D [Trusted Extensions DAIMERTIIC S AT LB LN F 2 574 — BT 2 HEHE

#F = BN SRR L £,

164 XR—2 D [CDEY /v a>aEHLTT
NI E =221 A2 =)L, Wik, B
KOEET S

167 X—® [Trusted CDE TH—H)LJ) — >
T K — =T 4 2T IRRT B

168 X—2 D [EH L 7=/ — > % Trusted
Extensions TH AY X1 X§ % |

BRD T NI E =2 2D )Lica
E—L&d. IRTOV—2THROERLE
kB

171 R—=2 0 [V —> D3 —1i%% Trusted
Extensions CfEA 9 % |

ZESAFw T avw hEFHL T, RIDT
NIFFET =2 MBEMDY =D a—>

R L ET,

171 =D =07 10— ANERFGiEZE
Trusted Extensions Cfif 4 % |

CDET U a2 ERLTINIMfTEY -2 %A

YA b=, FIEME. BRUEST D

= MERTIEA R =T 4 VAT A ERE IE—-LRITNERS0nD
7O 2B N0 £5, BERAMNSEWAEELT, 1D0
= EERL. ENEENDY DT T L —hMILT, TS —2F 2T
L —hZ2abE—F/37o0—22ERLET,

RO BRI

TLTWET,

161 X—2D ICDE7 V> a &HFHL T —2%E)—2INERET D] 25

LDAP Z % — ALY —EXAELTHHL TWABEAEIL. 65 X—0 [Trusted Extensions
TR —>%LDAP YV 9147 > hZ§ %] Z%TLTWET,

= O0—2EERTEEAIL 59— V=0 ra—2 w2ERT 572
WIZZES T —IVEERT 5] 2% T LTWET, ROFIET, ¥EFELEZY—2 %A1
CAR—=ILLET,
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E7 o> aryEFERLESNIIEY — DR (FE< v )

1

2

Trusted_Extensions 7 # )L Y T [V —"DA VA M=I)V] T3 &5 TIVY
Jwo L&D,

a.

AVAN=INTBEY—DEEIEANDNLET,

D773 ilEoT. TNIMNERBAXRL—F 4 > T AT ADMER SN
T3, COFEMETTHDETLRSLBEELEZSIWN, V=D > A M—)b
DETHIX. VATLATEDOMDY X7 2EFLBNTLZE N,

# zone-name: Install Zone

Preparing to install zone <zone-name>

Creating list of files to copy from the global zone

Copying <total> files to the zone

Initializing zone product registry

Determining zone package initialization order.

Preparing to initialize <subtotal> packages on the zone.

Initializing package <number> of <subtotal>: percent complete: percent

Initialized <subtotal> packages on zone.

Zone <zone-name> is initialized.

The file /zone/internal/root/var/sadm/system/logs/install log
contains a log of the zone installation.

*** Select Close or Exit from the window menu to close this window ***
aAVV—IERWT, A A=V ENEY—2DANY NEBERLET,
. V—=rmRIAVY—IV ToarEYTINVOY v LET,

i. 1A= LEEDPYDY—-2DREFIEANLET,

V= EEMELET,

LDAPZEA L CTNB155(E, TDAPRY —> &4tk 702 a> &5 710
Dy o LET,

Zone name: Type the name of the installed zone

Host name for the zone: Type the host name for this zone

FEAE ARSI T —ANH DT AT LTIE, BEIZROLDITRD E
—é‘o

Zone name: public
Host name for the zone: machinel-zones

DT aiiikoT, INIfFE =0, R — 2 TEET 5 U
LDAPY—/N—®DLDAP 7 T4 7 > MRV ET, ROIERNERINZHID
T a 3T T,

zone-name zone will be LDAP client of IP-address
zone-name 1is ready for booting
Zone label is LABEL
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166

3

**% Select Close or Exit from the window menu to close this window ***

» WDAPZEFERAL TOWEWMEEE. ROFIEOWTNNERITLTFHTY — %4
L,
Trusted Extensions TOFE DO FIEIL. Solaris OS @?JIIE EF—TT, AT LD
2<EBH1DDall-zones T oY T —AMBHSEEIL. TXRXTOY— x0T
HERARNAM, K — > DRA F%CZ*@Z@‘%AX\EVJ“%D&?} — i
2. = OWEHERICRAET HEROEIEIX. Kk — 2 IcHd 5EIZ ST
T95,
RONWTNMZEETLTHRAMERZANLET,

» FlE3TY—CEEFLEHE, V2RIV I T RTLFEICET
2EBEMICEZET,
ZOREEMFHL T — T sysidefg 7 7 TIVNER I NET,

FoTNRIUATES = IS K — 2 AD Trusted CDET A2 kv 7D)L— k

WEETDHEIICLTLEI N, FIEIZDWTIE, 167 X—T®D [Trusted CDE
TO—HIV =2 &K =2 I)v—F 4 VTR T 5] 2B LTLES

(Iso

" Step3 CY—VEREBTBHIC. ZDY—2D/etcT4 Lo MUICFIE3 A
RILT7AINEEEET,
V—>2%ikcE) 7oa a8 7N0) v o LET,
JOr 7 NMIEAET,

Zone name: Type the name of the zone that you are configuring

D77 avitko T NEHEINDE, FO - TEFEINLITRTO
Y—EANEE I NE T, —EZDFHMIL. snf(5) DX Za T INR—=IJE2FBRLT
<7mEW,

V=R —IVE. VI EBOEBEZBIFLE T, ROLDBAyE—
M) —)VIZERREINZET,

[Connected to zone 'public’ console]

[NOTICE: Zone booting up]

Hostname: zonename

Loading smf(5) service descriptions: number/total

Creating new rsa public/private host key pair

Creating new dsa public/private host key pair

rebooting system due to change(s) in /etc/default/init

[NOTICE: Zone rebooting]
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E7 o> aryEFERLESNIIEY — DR (FE< v )

EEEIR

RO BHIC

1

AV —IIVEHNZEERLET,

168 XR—2 @ [FEh L /=) — > % Trusted Extensions THAY XA X § 5] IZHEELH]
W2, = NHEEBI SN TWA I EE2ERLET., koo y—)larsA 7o
TR V= NHEH SN EERLTNET,

hostname console login:

J—2®DA A R—=)UT, 45 lInstallation of these packages generated errors:
SUNW pkgname] MFERSNZH/E, A A M=)O T ZFHH, N T —2DA > A
r—ILZ&TLET,

TrustedCDE CO—Hh LY — & KiEy —>
=T 4 TICERRT S

FTRTDY — 2N Trusted CDEICT 7T ATESLDITT SHI2IE. DISPLAY B4 2 iR
R LU TLZEZ W, Trusted CDE TZ DA ZE MR T 2121, TNIIUfFE—2 D
J— K%, REY—>20/—F4%4, BLDRall-zones 1 > T —AD ) — R4 ZEH
—DAFNTRR L FT,

Trusted CDE 2 L T, INIfFE =22 FHTHMLEL E£T,

RDOFFEONTNOZEFERAL T, Trusted(DEEZY — D IRNJIZRIRTEDLDIC
L/iﬂ—o

s AELEDDIRTLAEDXY—N—D ST 4 v EBMLET,
ZORETIE, TNUMFEY—21F, KIEY =2 DX —=N—ZfHE L TEND
AT LCEETEEXT,

a. /etc/nodename 7 7 A IV TR T ADLZRIZIEET DADVLENHUET,

## /etc/nodename
machinel

b. /etc/hosts 77 AT RTLADARIZIREST HDHLENHY FET,

## /etc/hosts
192.168.2.3 machinel loghost

ToolTalk ' —E A ZHEEZH 2 I1TI1L. > AT LDAHEIH loghost E[F UITITH
HEIICLTLES N,
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E7 O avEFERLESNIVIEY — DR (FE< Y )

168

2

C.

/etc/hostname.interface 7 7 A IV T AT ADEHIZIEET HHENH Y F
g—o
Z DOFETIE. machinel Id Trusted CDE @ all-zones { >4 7 = — AIZ7/2 0 F
j‘o

## /etc/hostname.bge0
machinel all-zones

HEZXY—N—Db>T74v0%20—-NIV AT AICHRUET,

-

ZOFRETIE, TNUMFEY —=2FO NN AT L EOXY—N—LHBETE

£9. ZRZL, =N DOXT—=N=n56%y hT—=2 EOEFNDI AT LD
N—RMIFHELEEAL. TOI—FTE, IO To—AZHHAL X,

a.

/etc/nodename 7 7 A IV T AT ADREIEIEET HDVENHYUET,

## /etc/nodename
machinel

/etc/hosts 77 A IV T RTLADZFIEIRET HDHLENHYET,

Solaris 10 10/08 J U — AN 5, 100 L all-zones T > % 7 —ATY, ZTDH;
B, 2077 MIVNERODEIITRDET,

## /etc/hosts
127.0.0.1 1localhost machinel loghost

F/=, o vnio 1 > Tz —AbHHATEET,

ToolTalk Y —E A ZHEREX B D121, > AT LA D4HIZ loghost & [F UITICTE
ELTLEE N,

FER = TEDREBA YT 1 —ATORBIEEARERT RLREE, BID
HIETDISPLAYEH ZfBARL £,
ZOFEIZONTIE, 85R—=2D Ry NT—=UA 25 T2 — A% TN)UFE
= IEIML, V=T 27T 5) 2BRLTLZIN,

- ER#FTDHICE. FIE3ID164XR—2D [DET V> 3 E2FERL TN
E—VEA R N=)L. WL, BLUEFHTSE] ICRVET,

#£F) L 7= — > % Trusted Extensions CH XY <A
X935
e D O BT BEE. COTIICL ST, e S END Y — S DF

STL—hRRAEDITHRLET, 512, ZOFIETY—2Z2EHATHEOH
AU E£7,
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E7 o> aryEFERLESNIIEY — DR (FE< v )

V—UDREICEBEINTND I LEZERLET,

a. zone-name:J —HEARIAY =)L T, rootE LTASTA 2 LET,

hostname console login: root
Password: Type root password

b. V—UBDBRITEINTNWS I EEHRLET.
STATUS 78 running DB EIE, V—2HNTARLEDH1 DD T O ZANETHTH
HZEERLET,

# zoneadm list -v
ID NAME STATUS PATH
2 public running /

¢« V—UDKEEY - EBETERILEHRLET.
XY —=N—INKIE)— > TETEINET, TNTNDITIRNIIAFE =N D
P—ERAZFEHT 2L, K — e cEhiTnEan 8. 07
O, =%y NU—UPNEEREL 2T UL, V- 2EHTA I EIdTESR
Moo EHIZ, 1M1 R—=DD [T E =N X T —N—IZT VA TER
W] 2ZRLTLZSI N,

= WARAY =L T, SRNIfFEY =V TREGY—EXREEMNCLET,
IO/ —>ZFIE—F137 00— 2 2ERT 256, BT —EAFH LW
= TENCEINET, SATLATE I THEIH—ERIL, T —2D
H—EAXYZ T AMIEL>TELDET, netservices limited I > RZ2MHL
Ty TNIE =2 TRHEELBNWT—EZX 2L 7ICLET,

a. ZHORELGY—EREHRLET.

# netservices limited

b. ZDIENDY—EXRZ—EICLEXT,

# svcs
STATE STIME FMRI
online 13:05:00 svc:/application/graphical-login/cde-login:default

« UST74ANATA L EBRPICLET,

# svcadm disable svc:/application/graphical-login/cde-login

# svcs cde-login

STATE STIME FMRI

disabled 13:06:22 svc:/application/graphical-login/cde-login:default
Y—ERAER T L —LAT—7 OFMIE. snf(5) DR Za TN R—VEZRLTLES
W,
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E7 O avEFERLESNIVIEY — DR (FE< Y )

3 UY—rEIVryy Y OLET,
KROFFEOWTNhERIRLFT,

» V=D vy bSO 7O aVERTLET.
V=2 DARTEATILET,

n KV —CDWmEKRT 4 RUT, zlogin AV REFEARALET.,
# zlogin zone-name init 0

RN, 2l0gin() DX Za 7 IIR—=VEZBRL T ZE W,

4 =Py MO UEINEEEERLET,
zone-name: ) — IR I =)V T, ROAYE—JICEKH>T, V=N v v b
T E3NTWEZENREINET,

[ NOTICE: Zone halted]

D=2 EIAE—FRI3Z0r0— 22 ERT 5D TIRRWESE, ZOHRID
= EBERLZOERIUHETERDDY — 2R L ET.

5 ZODV—2%EFID—2DTFrTL—bELULTERTSHE. ROELYITET
LETY,

a. auto_home zone-name 7 7 A ) ZEHIBRL £,
KIS — > DR T 4 > R T, zone-name ) — M6 DT 7 A IV EHIBRL £
j-o

cd /zone/zone-name/root/etc

# 1s auto _home*

auto home auto home zone-name
# rm auto_home_zone-name

mEZWEL publicV —2ZENDY — 2O O—AMERRItIC LG, £0
auto_home 7 7 {1 )V & RD KD ITHIFRL £7,

# cd /zone/public/root/etc
# rm auto_home_public

ROFIE = V—2ZIE—LTWBHAEIL. 171 X—20 V=20 E—J{E% Trusted
Extensions T T 5| ITHEAET,
n =D aO—2EERLTWBEEIL, 171 =20 =207 o— e
7515 % Trusted Extensions CEEAT 5 ICHEAET,
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E7 o> aryEFERLESNIIEY — DR (FE< v )

RO BHIC

R BRI

v — > (M1 E—H4i%E% Trusted Extensions CEA T
)

» 161R—TYD [CDET7 V7 > a ZzZHHALTY—28E) =2 TNV ERET
5] ZETLTWET,

m 163 X—2D [CDET V7> a  aHALEITNIUFE — 2 OFERR TEE~ v )
| Tra—=2EERTSHEODT T L —RERDT = ENAIIA AL TN
£7,

s JO—AERHADOT T L= ThsBY— 20N BHEETINTHER A,

= Trusted_Extensions 7 # V¥ MERINTNET,

B LIz =2 T8I, TY=2Z&2QAE—1 702ar&dTIo )y o LE
—g’—o

TOrT MIEAET,

New Zone Name: Type name of target zone

From Zone Name: Type name of source zone

EB-ZOY AT OFITHIE, EDNDI AT EZFTLIRNTLSIZE N,

J=UBERENES, TRTDY—VDRT—YREF v LET,
a. V—=rimEkRaryy—Il 73 ESTIVOY YO LET,
b. &YV —>lcOs4 > L%,

¢ 80XR—=2D [V—=2DRT—HREWRT D] 2T LET,

V) —> Mo O— > 1ER L % Trusted Extensions C
ﬁ% ERA)

161 X—2D ICDE7 V> a & FHL T —>%E)—2INVERET
5] BT LTWET,

n 59R—TJD V=D rO— 2 EERT D70 ZFS T—IVEER T 5] &5 T
LTWET,

n 59R—TJD =Dy 00— EERT D720 ZFS T—IVEERT 5] &5 T
LT, V=>F 7L —h2ERLTVET,

m 163 R—TD [CDET7 7> a &M LETNIUFE — > OFER B¢~ v )
| TOO=MERAOT > T L —hERDBT =2 BN AIIA AL TNET,
70— MERBAOT > T L —hEREB—21E, vy MY T INTHWET,
Trusted_Extensions 7 # LY MERSINTWVWET,
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V=TT —bRDSolarisZFS A F vy T 3w MEERLET.
# cd /
# zfs snapshot zone/zone-name@snapshot

ZDAFwTay hefHLT, 20EFEMID -0 O0—22ERL £
9, public EWVIZETDRERRFE A — > OBE, AFy T ay hax >y RiZRD
EOITRDET,

# zfs snapshot zone/public@snapshot

ERR L=\ =2 &Ic, TV—rooO—2%) 703> &5 TIV0
Uy o LET,

T T NMIEAET.
New Zone Name: Type name of source zone
ZFS Snapshot: Type name of snapshot

FATATKRY O ADERESRAET,

Zone label is <LABEL>
zone-name is ready for booting

*x* Select Close or Exit from the window menu to close this window ***

V=2 ZEIC -2 702 a ERTLET,
MDY=/ T 2702 a > aeFT7T 5. TNTNDY -2 HL£T,

V= BERENn=hE, ITRTOY—VDAT—YRE=F v LET,
a. [V—rwKRaAY—I]l 703> E25TINoU o LET,

b. 0 X—20D V—=2DRT—IREWRTH] #TLET,
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Trusted Extensions D& F v 2 U X

ZDOF w7 ANTIE, Trusted Extensions. D F/2fERY X7 O ZRL F

T, INSDOFERY AT, HIDWY AT OMIENEENTWET, ZOF vy
DZARETTIE, ZOXZa7 IR SN TWEETFIEEZETTHIEIITEE
NE YR

Trusted Extensions Z {89 H7/=6ODF v o 1) X b

KDY A ML, B BT Trusted Extensions 2 A 3MEB L ORER T 2 72D IC b i
HZERLET, ENOHEMICGEH SN TWE Y ZAVIE, HAESHRENET.,

1. REZMRLET.

»  [Oracle Solaris Trusted Extensions B ¥ O FJE] OHEHIID5 DDEEFHAET,
s A NOEFaU T —BEHEERLET,
m 150 R—=TD YA ~FDEF 254 —HR1 I — & Trusted Extensions | % i H
7,
2. RO%ERELET,
s root/NAT—RZRELET,
PROM F721EBIOSDtF 2 T4 —L RNV ERELET,
PROM 7213 BIOS D/N AT — RZHREL £,
B O i r T MM EREL LT,
w7 I NDTY 7 AT ENERELET,
FIRINWIB LAY NT—=I DT 7 A%EFT N ERELET,
= MERGEERELET,
3. Trusted Extensions Z BN L £,
a. SolarisOSZ&1{ > A M—JILLET,

s EEEHOBEG., AREIIN—Th, TNX0KERT)IV—T D Solaris
Nor—2%A4 A M—=I)LLET,

173
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Trusted Extensions 4T 27=DDF v o J X

n =D O—=MERAY Y ROBE, WAV LA A =)L ZER
L. /zone/N—TF 4 2 a > Zzi@EL £,
b. Trusted Extensions %"—E X svc:/system/labeld ZH T L £9,
4. Trusted Extensions @ IPv6 Z A %ML L £ (IPve 2T 2455).

5. 1AL @ DOI 2T 2551213, /etc/systemBL NN
/etc/security/tsol/tnrhtp 7 7 1 VNIZZ D DOl Z % E L £ 9,

6. (BE&RIRE) ) —> D O— AERHD ZFS T—IVEER L £7
7. TN ERELET,

a. Y1 h®d1label encodings 77 1IN &ET7 71+ IF714 X LET,
b. 77 ANV EFzy L TAARIVLET,
C. ﬁ@é}]bi—d—o

8. R/ —HBLYIRNNAE)—HOA 2 T2 — AR ELET,

9. Solaris EH > — )R EL £7,

10. *— LY —ERXAZHRELET,
» Ty AINF—LT—ERAEFEHLET, TIUTBERFEREILH D EH A,
= E/21d. LDAPZHEL X7,

a. Trusted Extensions 7 0 3 23— /\N— % /=14 Trusted Extensions LDAP
H—N—%EkL £9,

b. ;ol%_ris EMa =)= N—nxy NT—UEREEZITMTHEIICL
c. Solaris HH¥ > —)l % LDAP T8k L £9,
d. Solaris &> —)L D LDAP Y — )Lk w 7 ZA&fER L £7,
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nscd T—E 2, T RTOINAFE) =2 ADBE
fm, 92-93

P
Solaris 281 > A =)L &7z AT A, Trusted
Extensions D Ef:, 43-45
Solaris D1 > A b—IVA T 3 > Bifk, 42-43
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